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EDITORIAL INTRODUCTION 

 
 
     The rapid advancement of computer science and information technology has significantly transformed the way 
individuals, organizations, and societies function in the modern world. In this context, a strong understanding of 
fundamental computing concepts has become essential for students and professionals across disciplines. 

 
This volume, published under the International Multidisciplinary Book Series (IMBS), presents a structured 

and comprehensive introduction to the core areas of computer science and information technology. The book covers 
a wide range of topics, including number systems, computer hardware and software, operating systems, networking 
concepts, and practical applications such as word processing using Microsoft Word. 

 
The objective of this work is to provide learners with a clear conceptual foundation supported by practical insights. 

Each chapter has been carefully designed to maintain consistency in presentation, clarity in explanation, and relevance 
to academic curricula such as undergraduate and diploma programs. The content is suitable for students of computer 
science as well as learners from multidisciplinary backgrounds seeking to build essential digital competencies. 

 
As part of an international academic series, this volume aims to contribute to the dissemination of knowledge in 

the field of computing and support teaching, learning, and research activities globally. 
 
The editors sincerely hope that this book will serve as a valuable resource for students, educators, and researchers. 

Constructive feedback from readers is highly appreciated and will help in improving future editions. 
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CHAPTER 1: 

DECODING NUMBERS: FROM HUMAN COUNTING TO MACHINE LOGIC 
 

Dr. Sunita Chaudhary 
Professor, Mec,RU, India 

 
 

Abstract 
This chapter provides a comprehensive understanding of number systems used in computer science. It explains the 
binary, decimal, octal, and hexadecimal number systems, along with detailed methods for conversion between them. 
The chapter also covers binary arithmetic operations such as addition, subtraction (using One’s and Two’s 
complement), and multiplication with step-by-step solved examples. Diagrams, tables, and practice problems are 
included to enhance conceptual clarity. 
 
Keywords 
Binary, Decimal, Octal, Hexadecimal, Number System, Base, Radix, Conversion, One’s Complement, Two’s 
Complement, Binary Arithmetic 

 
1. Introduction 

A number system is a systematic way of representing numbers using a fixed set of symbols (digits) and rules. Each 
system is characterized by its base (or radix), which determines how many unique digits are available and how positional 
values are calculated. 

In computer science, number systems are fundamental because all data—numbers, text, images, and instructions—
are ultimately represented in binary (base-2) form. Digital hardware such as processors and memory devices operate 
using two stable electrical states (ON/OFF), naturally corresponding to binary digits 1 and 0. 

 
1.1 Why Number Systems Matter in Computing 

• Enable data representation (integers, real numbers, characters) 

• Support arithmetic operations inside the CPU 

• Provide compact forms like octal and hexadecimal for readability 

• Bridge human-readable (decimal) and machine-level (binary) representations 
 

1.2 Key Terminology 

Term Meaning 

Base (Radix) Number of unique digits in a system 

Digit A single symbol used in a number system 

Positional Value Value of a digit based on its position 

Most Significant Digit (MSD) Leftmost digit 

Least Significant Digit (LSD) Rightmost digit 
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1.3 Positional Number System Concept 

• A positional number system assigns value to each digit based on its position and the base. 

• General Representation Diagram (ASCII) 

• Number = (dₙ dₙ₋₁ ... d₁ d₀ . d₋₁ d₋₂)₍b₎ 

• Expanded form: 

Value = dₙ·bⁿ + dₙ₋₁·bⁿ⁻¹ + ... + d₁·b¹ + d₀·b⁰ + d₋₁·b⁻¹ + d₋₂·b⁻² 
Where: 

dᵢ = digit at position i 
b = base of the number system 

 
1.4 Place Value Table (Example in Base 10) 
 

Position 3 2 1 0 -1 -2 

Power 10³ 10² 10¹ 10⁰ 10⁻¹ 10⁻² 

Value 1000 100 10 1 0.1 0.01 

Example: (472.35)₁₀ = 4×10² + 7×10¹ + 2×10⁰ + 3×10⁻¹ + 5×10⁻² 
 

1.5 Comparison of Positional Systems 
 

System Base Example Expansion 

Decimal 10 25₁₀ 2×10¹ + 5×10⁰ 

Binary 2 1011₂ 1×2³ + 0×2² + 1×2¹ + 1×2⁰ 

Octal 8 17₈ 1×8¹ + 7×8⁰ 

Hexadecimal 16 A3₁₆ 10×16¹ + 3×16⁰ 

 
1.6 Visual Interpretation (Binary Example) 
 

Bit Position 3 2 1 0 

Weight 8 4 2 1 

Digit 1 0 1 1 

Contribution 8 0 2 1 

Total = 8 + 0 + 2 + 1 = 11₁₀ 
 

1.7 Fractional Representation (Binary) 
 

Position -1 -2 -3 

Weight 1/2 1/4 1/8 

Example: (0.101)₂ = 1×1/2 + 0×1/4 + 1×1/8 = 0.625₁₀ 
 
1.8 Summary of Concepts 

• Every number system is defined by a base and digits 

• Values are determined using powers of the base 

• Binary is the foundation of digital systems 

• Understanding positional notation is essential for conversion and arithmetic operations 
 
2. Types of Number Systems 

Number systems are categorized based on their base (radix), which determines how many unique symbols (digits) 
are available and how positional values are computed. In computing, four primary number systems are widely used—
decimal, binary, octal, and hexadecimal. Each serves a specific purpose: decimal is human-friendly, binary is machine-
native, while octal and hexadecimal act as compact representations of binary for easier readability and debugging. 
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Tabular Overview 

Number System Base Digits Used 

Decimal 10 0–9 

Binary 2 0, 1 

Octal 8 0–7 

Hexadecimal 16 0–9, A–F 

 
2.1 Decimal Number System (Base 10) 

The decimal system uses ten digits (0–9) and is the standard system for everyday arithmetic. Each position 
represents a power of 10. 

Example: (538)₁₀ = 5×10² + 3×10¹ + 8×10⁰ = 500 + 30 + 8 
 
2.2 Binary Number System (Base 2) 

The binary system uses only two digits (0 and 1). It is fundamental to digital electronics because hardware circuits 
operate using two states (ON/OFF). 

Example: (1011)₂ = 1×2³ + 0×2² + 1×2¹ + 1×2⁰ = 8 + 0 + 2 + 1 = 11₁₀ 
 
2.3 Octal Number System (Base 8) 

The octal system uses digits from 0 to 7. It provides a more compact representation of binary numbers, where each 
octal digit corresponds to three binary bits. 

Example: (27)₈ = 2×8¹ + 7×8⁰ = 16 + 7 = 23₁₀ 
 
2.4 Hexadecimal Number System (Base 16) 

The hexadecimal system uses sixteen symbols: 0–9 and A–F (where A=10, B=11, ..., F=15). It is widely used in 
programming, memory addressing, and color codes. 

Example: (AF)₁₆ = 10×16¹ + 15×16⁰ = 160 + 15 = 175₁₀ 
 
2.5 Comparative Insight 

• Decimal is intuitive for humans but inefficient for machines. 

• Binary is ideal for hardware but verbose for humans. 

• Octal and hexadecimal provide compact and readable representations of binary data. 
 

Number System Base Digits Used 

Decimal 10 0–9 

Binary 2 0, 1 

Octal 8 0–7 

Hexadecimal 16 0–9, A–F 

 
3. Decimal Number System (Base 10) 

The decimal number system is the most widely used number system in everyday life. It is a base-10 positional 
number system, meaning it uses ten digits ranging from 0 to 9. The value of each digit in a decimal number depends 
not only on the digit itself but also on its position, which is associated with powers of 10. 

In a positional system, each digit is multiplied by a corresponding power of the base (10). The powers increase 

from right to left, starting from 100at the rightmost position. This positional weighting allows numbers to be 
represented efficiently and unambiguously. 

Structure Diagram 

Digit 3 4 5 

Power 10² 10¹ 10⁰ 

 
In this representation, the digit 3 is in the hundreds place, 4 is in the tens place, and 5 is in the units place. 
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Example 

The number (345)₁₀ can be expanded using positional values as follows: 

(345)₁₀ = 3 × 10² + 4 × 10¹ + 5 × 10⁰ 
= 3 × 100 + 4 × 10 + 5 × 1 
= 300 + 40 + 5 
= 345 
Thus, the decimal system expresses numbers as a sum of digits multiplied by powers of 10, making it intuitive and 

suitable for human calculations. 
 
 

4. Binary Number System (Base 2) 
The binary number system is a base-2 positional number system that uses only two digits: 0 and 1. It is the most 

fundamental number system in computer science because all digital systems, including computers and electronic 
circuits, operate using two discrete states—commonly represented as OFF (0) and ON (1). Due to this simplicity and 
reliability, binary is used to represent all forms of data in computing systems. 

In the binary system, each position in a number corresponds to a power of 2, increasing from right to left. The 

rightmost digit represents 20, the next represents 21, and so on. The value of a binary number is obtained by 
multiplying each digit by its corresponding power of 2 and summing the results. 

 
Binary Place Value Chart 

Position 4 3 2 1 0 

Value 16 8 4 2 1 

 
This chart shows how each position contributes to the total value of a binary number. 
Example 

Consider the binary number (1011)₂. Its value can be calculated as follows: 

(1011)₂ = 1×2³ + 0×2² + 1×2¹ + 1×2⁰ 
= 8 + 0 + 2 + 1 

= 11₁₀ 
Thus, the binary number 1011 is equivalent to 11 in the decimal system. 
In summary, the binary number system forms the backbone of modern computing, enabling efficient data 

processing and storage through simple two-state logic. 
 
5. Octal Number System (Base 8) 

Key Idea: 
Each octal digit represents 3 binary digits. 
 

6. Hexadecimal Number System (Base 16) 
The hexadecimal number system is a base-16 positional number system that uses sixteen distinct symbols to 

represent values. These include the digits 0 to 9 and the alphabetic characters A to F, where A represents 10, B 
represents 11, C represents 12, D represents 13, E represents 14, and F represents 15. This system is widely used in 
computer science because it provides a compact and human-readable representation of binary numbers, with each 
hexadecimal digit corresponding exactly to four binary bits (a nibble). 

In the hexadecimal system, the positional values are based on powers of 16. Similar to other positional number 

systems, each digit is multiplied by the corresponding power of 16 depending on its position, starting from 160on the 
rightmost side. This allows large binary numbers to be represented in a much shorter and more manageable form, 
which is particularly useful in programming, memory addressing, and debugging. 

 
Hexadecimal Digit Table 

Decimal Hex 

10 A 

11 B 

12 C 

13 D 
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Decimal Hex 

14 E 

15 F 

Example 

Consider the hexadecimal number (A3)₁₆. Its decimal equivalent can be calculated as follows: 

(A3)₁₆ = A×16¹ + 3×16⁰ 
= 10×16 + 3×1 
= 160 + 3 

= 163₁₀ 
Thus, the hexadecimal number A3 represents the decimal value 163. 
In summary, the hexadecimal number system serves as an efficient bridge between binary and decimal systems, 

making it an essential tool for programmers and computer engineers. 
 
7. Conversion Techniques 

Conversion between number systems is an essential skill in computer science, as it enables the transformation of 
data between human-readable formats (decimal) and machine-level representations (binary, octal, and hexadecimal). 
Each type of conversion follows a systematic procedure based on the base (radix) of the number system involved. 
 
7.1 Decimal to Binary Conversion 

The conversion from decimal (base 10) to binary (base 2) is performed using a repeated division method. In this 
method, the given decimal number is divided successively by 2, and the remainders are recorded at each step. The 
process continues until the quotient becomes zero. The binary equivalent is then obtained by reading the remainders 
from bottom to top. 

 
Flow Process 
Step 1: Divide the decimal number by 2 
Step 2: Record the remainder (0 or 1) 
Step 3: Divide the quotient again by 2 
Step 4: Repeat until quotient = 0 
Step 5: Write remainders in reverse order 
 
Example 

Convert 13₁₀ to binary: 
13 ÷ 2 = 6 remainder 1 
6 ÷ 2 = 3 remainder 0 
3 ÷ 2 = 1 remainder 1 
1 ÷ 2 = 0 remainder 1 
Reading from bottom to top: 

13₁₀ = 1101₂ 
 

7.2 Binary to Decimal Conversion 
The conversion from binary to decimal is performed by multiplying each binary digit by its corresponding power 

of 2, based on its position, and then summing all the values. 
 
Example 

Convert (1010)₂ to decimal: 

(1010)₂ = 1×2³ + 0×2² + 1×2¹ + 0×2⁰ 
= 8 + 0 + 2 + 0 

= 10₁₀ 
This method highlights the positional nature of the binary number system. 
 

7.3 Octal to Binary Conversion 
The conversion from octal (base 8) to binary (base 2) is straightforward because each octal digit corresponds exactly 

to three binary digits. Therefore, each octal digit is replaced by its equivalent 3-bit binary representation. 
 

Octal to Binary Mapping Table 
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Octal Binary 

0 000 

1 001 

2 010 

3 011 

4 100 

5 101 

6 110 

7 111 

Example 

Convert (57)₈ to binary: 
5 → 101 
7 → 111 
Therefore, 

(57)₈ = (101111)₂ 
 
7.4 Binary to Hexadecimal Conversion 

The conversion from binary to hexadecimal (base 16) involves grouping binary digits into sets of four bits, starting 
from the right. Each group is then replaced by its corresponding hexadecimal digit. 

 
Conversion Rule 

• Group binary digits into 4-bit blocks  

• Add leading zeros if necessary  

• Convert each group into its hexadecimal equivalent  
 
Example 

Convert (11010110)₂ to hexadecimal: 
Group into 4 bits: 
1101 0110 
Convert each group: 
1101 → D 
0110 → 6 
Thus, 

(11010110)₂ = (D6)₁₆ 
 
Summary of Conversion Methods 
Decimal ↔ Binary: Division and positional expansion  
Octal ↔ Binary: 3-bit grouping  
Binary ↔ Hexadecimal: 4-bit grouping  
 
These conversion techniques are widely used in programming, digital electronics, and data representation to ensure 

efficient communication between human users and computer systems. 
 

8. Binary Arithmetic 
Binary arithmetic refers to performing mathematical operations such as addition, subtraction, and multiplication 

using binary numbers (base 2). These operations follow rules similar to decimal arithmetic but are simplified due to 
the use of only two digits: 0 and 1. Binary arithmetic is fundamental to computer operations, as all calculations inside 
a computer system are carried out using binary logic. 
 
8.1 Binary Addition 

Binary addition is the simplest form of binary arithmetic and follows a set of basic rules based on combinations of 
binary digits and carry values. When adding binary numbers, a carry is generated whenever the sum exceeds 1. 

 
Truth Table for Binary Addition 
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A B Carry In Sum Carry Out 

0 0 0 0 0 

0 1 0 1 0 

1 1 0 0 1 

 
These rules can be extended when a carry-in is present during multi-bit addition. 
 
Example 
Consider the addition of two binary numbers: 
   1011 

   +  1101 
-------- 

      11000 
Step-by-step, the addition proceeds from right to left, carrying over whenever the sum of bits exceeds 1. The final 

result is (11000)₂. 
 
 

8.2 Binary Subtraction 
Binary subtraction can be performed using direct borrowing, but in computer systems, it is more efficiently handled 

using complement methods, namely One’s complement and Two’s complement. 
 
One’s Complement 
The One’s complement of a binary number is obtained by inverting all bits (changing 0 to 1 and 1 to 0). 
 
Example: 

     Original number: 0101 
One’s complement: 1010 
 
Two’s Complement Method 
The Two’s complement is widely used in computers for subtraction. It is obtained by: 
Step 1: Taking the One’s complement  
Step 2: Adding 1 to the result  
 
Example 
Subtract 5 from 9 using Two’s complement: 
9 = 1001 
5 = 0101 
 
Step 1: One’s complement of 5 → 1010 
Step 2: Add 1 → 1011 (Two’s complement) 
 
Now add: 
   1001 

    +  1011 
-------- 

       10100 
Discard the overflow carry: 
Result = 0100 (which is 4 in decimal) 
Thus, 9 − 5 = 4. 
 

8.3 Binary Multiplication 
Binary multiplication is similar to decimal multiplication but uses only binary digits (0 and 1). Each digit of the 

multiplier is multiplied with the multiplicand, and intermediate results are shifted and added accordingly. 
 
Example 

Multiply (101)₂ by (11)₂: 
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   101 
    ×   11 

-------- 
        101 
   + 1010 

-------- 
       1111 

 
Step-by-step: 
Multiply 101 by 1 → 101  
Multiply 101 by the next 1 (shift left) → 1010  
Add the partial results  

Final result = (1111)₂ 
 
Summary of Binary Arithmetic 

• Binary addition follows simple carry rules  

• Subtraction is efficiently performed using Two’s complement  

• Multiplication involves shifting and adding partial products  

• Binary arithmetic forms the core of all computations performed by digital systems and processors. 
 

9. Applications of Number Systems 
Number systems play a crucial role in various domains of computer science and digital technology. In digital 

circuits, binary numbers are used to represent electrical signals in the form of high (1) and low (0) states, forming the 
basis of logic gates and processors. In programming, number systems such as binary, octal, and hexadecimal are used 
for low-level coding, memory addressing, and debugging purposes. 

Furthermore, number systems are essential in data storage, where all types of data—including text, images, audio, 
and video—are encoded in binary form for efficient storage and retrieval. In the field of networking, number systems 
are used in IP addressing, subnetting, and data transmission, enabling communication between devices over networks. 
Thus, number systems form the foundation of modern computing and communication systems. 
 
10. Advantages of Binary System 

The binary number system offers several advantages that make it ideal for use in digital systems. One of its primary 
benefits is its simple implementation, as it requires only two states (0 and 1), which can be easily represented using 
electronic components. Additionally, binary systems are highly reliable in electronic environments, as they are less 
susceptible to noise and signal distortion compared to multi-level systems. 

Another key advantage is that binary arithmetic is efficient for computation, allowing computers to perform 
calculations quickly and accurately. These characteristics make binary the most suitable and universally adopted 
number system in computing. 

 
11. Summary 

In conclusion, number systems form the backbone of computer science and digital technology. This chapter has 
explored various number systems, including decimal, binary, octal, and hexadecimal, along with their structures, 
conversions, and arithmetic operations. A strong understanding of these concepts—especially binary arithmetic and 
conversion techniques—is essential for comprehending how computers represent, process, and manipulate data at the 
fundamental level. 
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CHAPTER 2:  
CONCEPTS OF DATA, INFORMATION, AND COMPUTER SYSTEMS IN 

THE DIGITAL ERA 
 

Dr. Prishu Pandey 
Assistant Professor, Mec,RU, India 

 
 

Abstract 
This chapter presents a comprehensive introduction to the fundamental concepts of data, information, and computer 
systems, along with their role in modern information processing. It begins by defining data as raw facts and 
information as processed, meaningful output, followed by an exploration of different types of data processing 
methods, including manual, mechanical, and electronic processing. The chapter further discusses the importance, uses, 
and levels of information in organizational decision-making, including operational, tactical, and strategic information. 
In addition, the chapter examines the characteristics and quality of information, highlighting key attributes such as 
accuracy, relevance, timeliness, and security. It also provides insights into electronic record keeping and compares 
electronic and manual systems. The evolution of computers through different generations is outlined, along with the 
fundamental components and characteristics of computer systems. Finally, the chapter explores real-world 
applications of computers across various domains such as education, business, healthcare, and home use, 
demonstrating their impact on modern society. 
 
Keywords 
Data, Information, Data Processing, Information Systems, Electronic Data Processing, Information Quality, 
Computer Systems, Computer Generations, Information Technology, Decision Making, Digital Systems 

 
Data: 

Data are the raw facts or figures which are processed to get the information. 
 

Need of Data Processing 
Data is processed to get the required results. Different operations may be performed on data. Therefore, data 

processing is defined as: "A sequence of operations on data to convert it into useful information is called data 
processing."  
 
The important operations that can be performed on data are:  

• Arithmetic and logical operations on data to get required results. 

• To send and receive data from one location to another. 

• Classification of data. 

• Arranging data into a specific order etc. 
 

The data processing is divided into three categories or levels.  
1. Manual Data Processing: In manual data processing, data is processed manually without using any machine or 

tool to get required result. In manual data processing, all the calculations and logical operations are manually 
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performed on the data. Similarly, data is manually transferred from one place to another. This method of data 
processing is very slow and errors may occur in the output. In India, data is still processed manually in many 
small business firms as well as government offices & institutions.  

2. Mechanical Data Processing: In mechanical data processing, data is processed by using different tools like 
calculators or other mechanical devices. This method of data processing is faster and more accurate than 
manual data processing.  

3. Electronic Data Processing: It is the modern technique to process data. The data is processed through 
computer. Data and set of instructions are given to the computer as input and the computer automatically 
processes the data according to the given set of instructions.  
The computer is also known as electronic data processing machine. This method of processing data is very 
fast and accurate. Now-a-days, the data is processed and analyzed through computers. For example, the results 
of students are prepared through computer; in banks accounts of customers are processed through computers 
etc. 

 
Information: 

Information is the processed data. Data is entered into and stored in a computer. After processing (such as 
formatting and printing) output data become information. Means useful data is called Information. 

 
Need of information: 

• Information is needed to survive in the modern competitive world. 

• Information is needed to create strong information systems and keep these systems up to date. 

• Information is needed for organizational decision making. 

• Most of the services sectors are depended on information including banking, financial organization, health 
care, entertainment, tourism and travel, education and numerous others. 

• Strong growth of information services fuelled by increasing competition and reduced product life cycle. 

• Need for sustainable development and quality life. 

• Improvement in communication and transportation brought in by use of information processing. 

• Use of information processing in reduction of energy consumption, reduction in pollution and a better 
ecological balance in future. 

• Use of information processing in land record managements, legal delivery system, educational institutions, 
natural resource planning, customer relation management and so on. 

 
The following list summarizes the five main uses and need of information by businesses and other organizations: 

• Planning - At the planning stage, information is the most important ingredient in decision making. 
Information at planning stage includes that of business resources, assets, liabilities, plants and machineries, 
properties, suppliers, customers, competitors, market and market dynamics, fiscal policy changes of the 
Government, emerging technologies, etc. 

• Recording - Business processing these days involves recording information about each transaction or 
event. This information collected, stored and updated regularly at the operational level. 

• Controlling - A business need to set up an information filter, so that only filtered data is presented to the 
middle and top management. This ensures efficiency at the operational level and effectiveness at the 
tactical and strategic level. 

• Measuring - A business measures its performance metrics by collecting and analyzing sales data, cost of 
manufacturing, and profit earned. 

• Decision-making - MIS is primarily concerned with managerial decision-making, theory of organizational 
behavior, and underlying human behavior in organizational context. Decision-making information 
includes the socio-economic impact of competition, globalization, democratization, and the effects of all 
these factors on an organizational structure. 

 
Level of Information: 

Information, as required at different levels can be classified as operational, tactical and strategic. 
 
1. Operational information: 
Operational information relates to the day-to-day operations of the organization and thus, is useful in exercising 

control over the operations that are repetitive in nature. Since such activities are controlled at lower levels of 
management, operational information is needed by the lower management. 
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For example, the information regarding the cash position on day-to-day basis is monitored and controlled at the 
lower levels of management. Similarly, in marketing function, daily and weekly sales information is used by lower level 
manager to monitor the performance of the sales force. 

It may be noted that operational information pertains to activities that are easily measurable by specific standards. 
The operational information mainly relates to current and historical performance, and is based primarily on internal 
sources of data. The predictive element in operational information is quite low and if at all it is there, it has a short 
term horizon. 

 
2. Tactical information: 
Tactical information helps middle level managers allocating resources and establishing controls to implement the 

top level plans of the organization. For example, information regarding the alternative sources of funds and their uses 
in the short run, opportunities for deployment of surplus funds in short- term securities, etc. may be required at the 
middle levels of management. 

The tactical information is generally predictive, focusing on short-term trends. It may be partly current and partly 
historical, and may come from internal as well as external sources. 

 
3. Strategic information: 
While the operational information is needed to find out how the given activity can be performed better, strategic 

information is needed for making choices among the business options. 
The strategic information helps in identifying and evaluating these options so that a manager makes informed 

choices which are different from the competitors and the limitations of what the rivals are doing or planning to do. 
Such choices are made by leaders only. 

Strategic information is used by managers to define goals and priorities, initiate new programs and develop policies 
for acquisition and use of corporate resources. For example, information regarding the long-term needs of funds for 
on-going and future projects of the company may be used by top level managers in taking decision regarding going 
public or approaching financial institutions for term loan. 

Strategic information is predictive in nature, relies heavily on external sources of data, has a long-term perspective, 
and is mostly in summary form. It may sometimes include ‘what if’ scenarios. However, the strategic information is 
not only external information. 

For long, it was believed that strategic information is basically information regarding the external environment. 
However, it is now well recognized that the internal factors are equally responsible for success or failures of strategies 
and thus, internal information is also required for strategic decision making. 

 
Figure 1.2 represents the types of information required at different levels of managerial hierarchy. 

 
 
It may be remembered that each type of information has its role to play in managerial effectiveness. Each type of 

information is needed with varying degree by the managers at all levels. Thus, a part of operational information may 
be used even by the chief executive officer of a company. 

The difference lies in the proportion of each type of information in the total information needs of managers at 
different levels of managerial hierarchy. 

 
Quality of information: 

The meaning of information quality lies in how the information is perceived and used by its customer.  Though 
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absolute attributes are important, it is how those attributes are perceived, now and in the future, that defines 
information quality.   Identifying quality information involves two stages: first, highlighting which attributes are 
important and second, determining how these attributes affect the customers in question.   Quality information meets 
certain recognized criteria such as "accuracy", "timeliness", "relevance", and  "understandability".  Following are the 
majors of information quality: 

 
1.Relevance: 
The key component for information quality is whether the information addresses its customer's needs.  The relevance 

of information reflects the degree to which it meets the real needs of clients. It is concerned with whether the available 
information sheds light on the issues that are important to users. Assessing relevance is subjective and depends upon 
the varying needs of users. 

 
2.Accuracy: 
The accuracy of statistical information is the degree to which the information correctly describes the phenomena it 

was designed to measure. It is usually characterized in terms of error in statistical estimates and is traditionally 
decomposed into bias (systematic error) and variance (random error) components. It may also be described in terms 
of the major sources of error that potentially cause inaccuracy (e.g., coverage, sampling, non response, response). 

 
3.Timeliness: 
Timely information is still current.  Implicit in this definition is a dynamic process where new information arises 

to replace the old.  Information has a cycle time which depends on how quickly new information can be processed 
and communicated to its customer. 

 
4.Completeness 
Incomplete information can lead its customer astray.  An example of this is the old story of blind travelers 

encountering an elephant in the road with each, after examining a small section, coming to a different conclusion 
regarding the object's identity.  However, complete information for one person may be incomplete for another.  For 
example, the marketing vice president and the director of research and development for a pharmaceutical company 
may be both be interested in the clinical trials tests for a new drug, but each may require different levels of detail.  

 
5.Coherence 
Coherence is how well the information "hangs together" and it consistent with itself.  Information can become 

incoherent through irrelevant details, confusing measures or ambiguous format which can confuse information 
customers and cause them to not receive or even reject the information's message.  Although information can be 
genuinely incoherent, incoherent information usually indicates an error in accuracy or timeliness. 

 
6.Format 
Information format refers to how the information is presented to the customer.  Two components of information 

format are its underlying form and its context for interpretation, which is sometimes referred to as its frame. 
The appropriate format for information depends on the information's customer and the information's use.  For 

example, an accountant may prefer twenty pages of numbers to a graphical summary, but may insist of using only 
multi-color pie charts for his presentation to the senior vice president of sales. 

The context with which we view information also is important.  For example, when a company benchmarks its 
performance against industry or functional world class leader, it seeks to give that information context.  For years 
financial analysts have viewed information in context, witness the focus on stock price performance over time, a 
portfolio manager's performance relative to the S&P 500, or corporate performance versus that of the corporation's 
industry. 

 
7.Accessibility 
Accessible information is information that can be obtained when needed.  Accessibility depends on the customer 

and even the specific circumstances for that customer.  For information quality to occur, timeliness and accessibility 
should complement each other.  Timely information that is inaccessible or accessible information that is obsolete, 
cannot satisfy an information customer's needs. 

Applications of information technology to customer services offer excellent examples of how firms can use quality 
in information accessibility to obtain competitive advantage witness 800 numbers for computer software and hardware 
firms, credit card providers and mutual funds.     
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8.Compatibility 
To paraphrase a famous line, "no information is an island."  Information quality  lies not only in the quality of the 

information itself, but also in how it can be combined with other information and delivered to a customer.  This often 
involves systems working together. 

  The proper information architecture enhances information quality by making the information suitable for 
enhanced uses.  A quality architecture implies a dynamic structure that can grow with changing customer requirements.  
This is necessary when companies must leverage their information base to develop new products and services as well 
as optimize their production and management processes. 

 
9.Security 
Historically, information security has been a stepchild of the information technology revolution.  Security often 

was either added on after information systems development was completed or ignored altogether.  Two aspects of 
information security are protecting information from people (logical security) and protecting information from natural 
disasters (disaster recovery planning).  Logical security relies on logical barriers such as passwords, data encryption and 
transaction authentication, along with human vigilance.  Disaster recovery planning involves protecting information 
and ensuring appropriate back-up and alternate processing procedures are in place. 

The topic of information security has become increasingly visible in recent years.  Indeed breaches of information 
security are a potential Achilles heel for the entire information technology revolution because information that is not 
secure cannot be trusted, and will not be used to its fullest potential. 

 
10.Validity 
Information has validity when it can be verified as being true and satisfying appropriate standards related to other 

dimensions such as accuracy, timeliness, completeness and security.  The most common form of verification is auditing 
information, either as an ongoing practice or as part of a special project.  Auditing can uncover mistakes and is a 
accepted measure of information quality.  An obvious example is the corporate financial statement, which to be 
credible must be audited by an independent party.  However, just as quality cannot be inspected into manufactured 
products, quality cannot be audited into information products. 

Validity is a resultant rather than a causal dimension of information quality.  Though validity may be high, other 
crucial dimensions may be low and overall, the information may be of poor quality.  Ultimately, optimizing the design 
and ongoing operation of the human and technological information system is the road to information quality. 

 
Electronic record keeping 

Advantages 

• Helps you record business transactions, including income and expenses, payments to workers, and stock 
and asset details. 

• Efficient way to keep financial records and requires less storage space. 

• Provides the option of recording a sale when you raise an invoice, not when you receive a cash payment 
from a client. 

• Easy to generate orders, invoices, debtor reports, financial statements, employee pay records, inventory 
reports. 

• Automatically tallies amounts and provides reporting functions. 

• Keeps up with the latest tax rates, tax laws and rulings. 

• Many accounting programs have facilities to email invoices to clients, orders to suppliers, or BAS returns 
to the Australian Taxation Office. 

• Allows you to back up records and keep them in a safe place in case of fire or theft. 
 

Manual record keeping 
Advantages 

• Less expensive to set up. 

• Correcting entries may be easier with manual systems, as opposed to computerized ones that can leave 
complicated audit trails. 

• The risk of corrupted data is much less. 

• Data loss is less of a risk, particularly if records are stored in a fire-proof environment. 

• Problems with duplicate copies of the same records are generally avoided. 

• The process is simplified as you don't need to be familiar with how accounting software calculates and 
treats your information. 
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The Difference/ comparison between Electronic and Paper Documents  
 
1. The magnitude of electronic data is way larger than paper documents  
This point is obvious to the majority of observers. Today’s typical disks are at several dozen gigabytes and these 

sizes grow constantly. A typical medium-size company will have PC’s on the desks of most white-collar workers, 
company-related data, accounting and order information, personnel information, a potential for several databases and 
company servers, an email server, backup tapes, etc. Such a company will easily have several terabytes of information. 
Accordingly, such a company has over 2 million documents. Just one personal hard drive can contain 1.5 million pages 
of data, and one corporate backup tape can contain 4 million pages of data. Thus the magnitude of electronic data that 
needs to be handled in discovery is staggering. In most corporate civil lawsuits, several backup tapes, hard drives, and 
removable media are involved. 

 
2. Variety of electronic documents is larger than paper documents  
Paper documents are ledgers, personnel files, notes, memos, letters, articles, papers, pictures, etc. This variety exists 

also in electronic form. But then spreadsheets are way more complex than ledger, for example. They contain formulas, 
may contain charts, they can serve as databases, etc. In addition to all added information, e.g. charts, ability to view 
the actual computations involved, e.g. formulae, the electronic spreadsheet supports experimentation with what-if 
version the discoverer may want to investigate. Personal digital assistants, pocket PCs, palm devices or BlackBerry 
devices, are subject to electronic discovery. Many of these devices can be used to send and retrieve e-mails. Since an 
e-mail deleted from a network may still exist on an individual employee’s PDA, parties may demand discovery of the 
contents of PDAs.  

 
3.Electronic documents contains attributes lacking in paper documents  
Computers maintain information about your documents, referred to as “metadata,” such as: author’s name, 

document creation date, date of it last access, etc. A hard copy of the document does not reveal metadata, although 
certain metadata items may be printed. Depending on what you do with the document after opening it on your 
computer screen, the actions taken may change the metadata collected about that document. Paper documents were 
never this complex.  

 
4 Electronic documents are more efficient than paper documents  
Paper documents are delivered by mail and stored locally in filing cabinet. For multiple users to access documents 

simultaneously one needs a set of documents per each accessing person. File cabinets are bulky and use up valuable 
office space. Paper documents are difficult to search, carry, copy, and modify. Paper documents are easily damaged, 
misfiled or misplaced. Electronic documents are delivered by networks, disks, flash memory and CD/DVD and are 
stored on a file system. Multiple users can read and review electronic document simultaneously. Computer file systems 
are getting smaller and contain more data every year. Personal file systems are physically smaller than a small cell 
phone; only very large companies need massive file systems that occupy a lot of real estate. It is almost too easy to 
search, carry, copy, and modify electronic documents. Electronic documents, in a well run operation, have copies and 
damage to a single copy causes extra work but no loss.  

 
5 The structure of electronic documents may reach complexity absent from paper documents  
A description of the structure of an object (i.e. document) identifies its component parts and the nature of the 

relationships between those parts. Describing documents (i.e. objects) this way points to the complexity of electronic 
documents.  

The following list shows some aspects of the complexity of electronic documents.  

• An electronic document may consist of subdocuments that do not even have to reside on  

• the same computer.  

• An electronic document may be written in HTML and displayed by a Web browser. Such paper documents 
don’t even exist.  

• An electronic document may have hyperlinks to other documents.  

• An electronic document may have dynamic parts. This holds in an obvious way to Web pages that can 
include (and invisible to the reader) programs in languages such as javaScript and ASP, which run in the 
browser and the reader views only the results of these runs. It may also hold to text document or 
spreadsheets as a result of embedded executable fields, functions and macros.  

• Electronic documents have much wider spectra than paper ones as they can include not only the classic, 
word-processed text but table databases or a part thereof as well as image, voice and video.  
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6 Electronic documents are more persistent and more difficult to destroy than paper documents  
Paper documents are easy to destroy. Throwing away or shredding makes paper documents disappear. Deleting an 

electronic document eliminates only the ubiquitous accessible copy. The document, i.e. its data, still exists and in 
systems such as Windows and Mac OS, an accessible reference to deleted documents may be in the trash bin. Restoring 
a document in the trash bin, i.e. a deleted document, revives the document to its original glory. Even removing the 
document from the thrash bin does not erase the documents data off the disk. Once removed from the thrash bin, 
documents data areas on the disk go into a “fee list” that makes those areas available for future data creation needs. 
The free list contains all areas not currently allocated to active documents as well as to deleted documents still in the 
trash bin. How long will an area stay on the free list (thereby still containing the deleted documents data)? That is 
difficult to predict due the huge variability of factors such as: future demand for disk space, size of current and future 
files, the current availability of disk space, etc.  

Even the complete deletion of a document, its trash bin instance and the allocation of the document’s data area on 
the disk does not typically extinguishes the document altogether. Several practices create copies of documents and are 
only marginally affected by document deletion:  

 

• Backups – most organizations and individuals create backup copies of documents as regular practice as 
precautionary actions. The backups are maintained independently of the document itself.  

• Documents may be exchanged by email, access through web pages and manually handed electronic copies. 
Thus created copies continue to exist after the deletion of the original document.  

• Even work on a simple text document is quite frequently preceded by creating a copy of the document 
being edited. Once again, such copies persist beyond the deleted document unless specifically deleted.  

 
7 Electronic documents change faster, more frequently and easier than paper documents  
Changes to an electronic document are fast and easy. The reason is obvious; all you need to do is make the change 

and save it. Changes to paper documents, however, require retyping the whole document. There are many other 
reasons to the difference in speed and frequency. We already said that documents may be dynamic. Web pages are 
made dynamic in order to ease change. For discovery, faster and frequent changes imply a need for a more meticulous 
and length monitoring of document discovery.  

 
8 Electronic documents last longer than paper documents  
Paper deteriorates with time; paper documents can be destroyed by flood and fire. Although these factors have 

their parallels in electronic documents, e.g. a flooded computer loses its data; typical backups of the documents 
practices maintain copies away from the “office.” Paper documents may enjoy the same treatment, but the frequency, 
extent and usage of such backups is substantially smaller. Electronic document suffer from upgrades in technology. If 
one used a peculiar word processor, e.g. WordStar, to write a document ten years ago, today it will be difficult to find 
a tool to read that document. Same holds for spreadsheets, databases, etc. Again, most companies have practices that 
avoided such problem by evolving documents with time.  

 
9 The redundancy in electronic documents is higher than in paper documents  

• There are several levels of redundancy to electronic documents.  

• Due to the type of recording used for electronic data, minor errors in a document can be corrected by 
computer tools. The tools rely on the redundancy of checksums and other devices  

• Due to frequent changes in documents, individuals learn to save previous versions of the documents. 
Doing that generates redundancy of document versions.  

• Emails, flash memories, CDs all proliferate documents and result in high redundancy 

• Most companies and many individuals make backup of documents  

• Tool that control versioning of files create built-in redundancy  
 
10 An electronic data is more likely to be created by several individuals than a paper document  
MS Word supports “Document Collaboration.” Where this term implies: “new objects, properties, and methods 

of the Word 10.0 Object Library shown in this article allow you to change the display of revisions and comments, 
accept and reject revisions, and start and end a collaborative review cycle.” Another tool, Workshare , is an add-on to 
Microsoft Word that manages collaboration on Word documents and integrates this activity with email and the 
organization’s document repository tool. Collaborations on databases (e.g. people using a bank’s ATMs update the 
bank’s database), spreadsheets (e.g. BadBlue), and Web sites are commonly practiced. This dwarfs collaborations on 
paper documents possible. For discovery it implies that the author of a Word document may not be the only person 
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involved in writing the document. One has to determine all the parties that collaborated on the document.  
 
11 Electronic documents may be created by electronic means while paper documents are created by 

humans  
Paper documents are always written by human beings. That is not necessarily the case with documents. We start 

with a simple, and rather common, example. The Quicken financial program will generate financial reports from a 
database of financial transactions.  

 
12 Electronic discovery requires support of an infrastructure that paper discovery has never needed  
The large volumes of data, its complexity and its variety of electronic documents have brought about many types 

of computer tools to help overcome the obvious difficulties.  
 

Brief History of Development of computers:  
The history of computers starts out about 2000 years ago in Babylonia (Mesopotamia), at the birth of the abacus, 

a wooden rack holding two horizontal wires with beads strung on them. We can divide the history in 5 generations: 
 
The Five Generations of Computers: 
 
1.First Generation (1940-1956) Vacuum Tubes: 
The first computers used vacuum tubes for circuitry and magnetic drums for memory, and were often enormous, 

taking up entire rooms. They were very expensive to operate and in addition to using a great deal of electricity, 
generated a lot of heat, which was often the cause of malfunctions. 

First generation computers relied on machine language, the lowest-level programming language understood by 
computers, to perform operations, and they could only solve one problem at a time. Input was based on punched 
cards and paper tape, and output was displayed on printouts. 

The UNIVAC and ENIAC computers are examples of first-generation computing devices. The UNIVAC was the 
first commercial computer delivered to a business client, the U.S. Census Bureau in 1951. 

 
2.Second Generation (1956-1963) Transistors: 
Transistors replaced vacuum tubes and ushered in the second generation of computers. The transistor was invented 

in 1947 but did not see widespread use in computers until the late 1950s. The transistor was far superior to the vacuum 
tube, allowing computers to become smaller, faster, cheaper, more energy-efficient and more reliable than their first-
generation predecessors. Though the transistor still generated a great deal of heat that subjected the computer to 
damage, it was a vast improvement over the vacuum tube. Second-generation computers still relied on punched cards 
for input and printouts for output. 

Second-generation computers moved from cryptic binary machine language to symbolic, or assembly, languages, 
which allowed programmers to specify instructions in words. High-level programming languages were also being 
developed at this time, such as early versions of COBOL and FORTRAN. These were also the first computers that 
stored their instructions in their memory, which moved from a magnetic drum to magnetic core technology. 

The first computers of this generation were developed for the atomic energy industry. 
 
3.Third Generation (1964-1971) Integrated Circuits: 
The development of the integrated circuit was the hallmark of the third generation of computers. Transistors were 

miniaturized and placed on silicon chips, called semiconductors, which drastically increased the speed and efficiency 
of computers. 

Instead of punched cards and printouts, users interacted with third generation computers through keyboards and 
monitors and interfaced with an operating system, which allowed the device to run many different applications at one 
time with a central program that monitored the memory. Computers for the first time became accessible to a mass 
audience because they were smaller and cheaper than their predecessors. 

 
4.Fourth Generation (1971-Present) Microprocessors: 
The microprocessor brought the fourth generation of computers, as thousands of integrated circuits were built 

onto a single silicon chip. What in the first generation filled an entire room could now fit in the palm of the hand. The 
Intel 4004 chip, developed in 1971, located all the components of the computer—from the central processing unit 
and memory to input/output controls—on a single chip. 

In 1981 IBM introduced its first computer for the home user, and in 1984 Apple introduced the Macintosh. 
Microprocessors also moved out of the realm of desktop computers and into many areas of life as more and more 
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everyday products began to use microprocessors. 
As these small computers became more powerful, they could be linked together to form networks, which eventually 

led to the development of the Internet. Fourth generation computers also saw the development of GUIs, the mouse 
and handheld devices. 

 
5.Fifth Generation (Present and Beyond) Artificial Intelligence: 
Fifth generation computing devices, based on artificial intelligence, are still in development, though there are some 

applications, such as voice recognition, that are being used today. The use of parallel processing and superconductors 
is helping to make artificial intelligence a reality. Quantum computation and molecular and nanotechnology will 
radically change the face of computers in years to come. The goal of fifth-generation computing is to develop devices 
that respond to natural language input and are capable of learning and self-organization. 

 
Computer system concept: 

 
 
The computer is a system of hardware devices organized according to the following system functions: 
1.Input. The input devices of a computer system include keyboards, touch screens, pens, electronic, optical 

scanners, and so on. They convert data into electronic machine-readable form for direct entry or through 
telecommunications links into a computer system. 

2.Processing. The central processing unit (CPU) is the main processing component of a computer system. (In 
microcomputers, it is the main microprocessor. ) hi particular, the arithmetic-logic unit, one of the CPU's major 
components, performs the arithmetic and logic functions required in computer processing. 

3.Output. The output devices of a computer system include video display units, printers, audio response units, 
and so on. They convert electronic information produced by the computer system into human-intelligible form for 
presentation to end users. 

4.Storage. The storage function of a computer system takes place in the computer's primary storage unit, or 
memory, and in secondary storage devices such as magnetic disk and tape units. These devices store data and program 
instructions needed for processing.IWC replica watches. 

5.Control. The control unit of the CPU is the control component of a computer system. It interprets computer 
program instructions and transmits directions to the other components of the computer system. 

 
Computer system characteristics: 

The characteristics of computers that have made them so powerful and universally useful are speed, accuracy, 
diligence, versatility and storage capacity. 
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1.Speed: Computers work at an incredible speed. A powerful computer is capable of performing about 3-4 million 
simple instructions per second. 

2. Accuracy: In addition to being fast, computers are also accurate. Errors that may occur can almost always be 
attributed to human error (inaccurate data, poorly designed system or faulty instructions/programs written by the 
programmer).  

3. Diligence: Unlike human beings, computers are highly consistent. They do not suffer from human traits of 
boredom and tiredness resulting in lack of concentration. Computers, therefore, are better than human beings in 
performing voluminous and repetitive jobs. 

4. Versatility: Computers are versatile machines and are capable of performing any task as long as it can be broken 
down into a series of logical steps. The presence of computers can be seen in almost every sphere – Railway/Air 
reservation, Banks, Hotels, Weather forecasting and many more. 

5. Storage Capacity: Today’s computers can store large volumes of data. A piece of information once recorded 
(or stored), in the computer, can never be forgotten and can be retrieved almost instantaneously. 

  
Capabilities and Limitations of a Computer 

Computers have become an essential part of modern life and are used in homes, schools, hospitals, banks, offices, 
and many other environments. They assist humans in performing a wide variety of tasks efficiently and accurately. 
Due to their versatility and power, people rely heavily on computers for work, communication, entertainment, and 
data storage. This widespread use is possible because computers possess several important capabilities. 
 

Capabilities of a Computer 

• One of the most significant features of a computer is its high processing speed. A computer can perform 
millions of calculations within a fraction of a second, making it extremely efficient for handling large 
volumes of data. 

• Another important capability is accuracy. When provided with correct data and instructions, computers 
can produce highly precise results. This is why they are widely used in scientific research, engineering, and 
financial systems. 

• Computers are also capable of storing vast amounts of data. Modern storage devices allow users to save 
and retrieve information easily whenever required. This makes computers highly useful for maintaining 
records and documents. 

• In addition, computers allow users to retrieve and modify previously stored work. Users can edit 
documents, duplicate files, and restore earlier versions, making work management convenient and flexible. 

• Computers are also known for their automation. Once a task is programmed, a computer can perform it 
automatically without requiring constant human intervention. 

• Another advantage is their ability to perform multiple tasks simultaneously. Users can run different 
programs at the same time, increasing productivity and efficiency. 

• Finally, computers can be upgraded and improved. Hardware components and software can be replaced 
or enhanced, allowing computers to adapt to new technologies and requirements. 

 
Limitations of a Computer 

• Despite their many advantages, computers have certain limitations. A computer can only perform tasks 
based on the instructions provided to it. It cannot think independently or make decisions beyond its 
programming. 

• Computers also cannot generate information on their own. They depend entirely on input data and 
instructions given by users. Without proper input, they cannot produce meaningful output. 

• Another limitation is that computers cannot distinguish between correct and incorrect data. If incorrect 
data is entered, the output will also be incorrect. This concept is often referred to as “Garbage In, Garbage 
Out” (GIGO). 

• Additionally, computers cannot correct wrong instructions automatically. If an error exists in a program 
or command, the computer will not be able to fix it and may stop functioning until the issue is resolved 
by a user. 

 
Applications of Computers in various fields(in general and pharmacy): 

Computers are used in so many fields in our daily life. From Engineers to Doctors, Students, Teachers, and 
Government Organization they all use computers to perform specific tasks, for entertainment or just to finish office 
work. Computers have made our life easier. With greater precision and accuracy and less time taking computers can 
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do a lot in short time while that task can take a lot of time while doing manually. Computers have taken industries and 
businesses to a whole new level. They are used at Home for work and entertainment purposes, at Office, in hospitals, 
in government organizations. Following are some fields of the uses of computers. 

 
A). Uses of Computer at Home: 
Computer can be used at home in the following ways. 
1.Home Budget: 
Computer can be used to manage Home Budget. You can easily calculate your expenses and income. You can list 

all expenses in one column and income in another column. Then you can apply any calculation on these columns to 
plan your home budget.  There are also specialize software that can manage your income and expenses and generate 
some cool reports. 

2.Computer Games: 
An important use of computers at home is playing games. Different types of games are available. These games are 

a source of entertainment and recreation. Many games are available that are specially developed to improve your mental 
capability and thinking power. 

3.Working from Home: 
People can manage the office work at home. The owner of a company can check the work of the employees from 

home. He can control his office while sitting at home. 
4.Entertainment: 
People can find entertainment on the internet. They can watch movies, listen to songs, and watch videos download 

different stuff. They can also watch live matches on the internet. 
5.Information: 
People can find any type of information on the internet. Educational and informative websites are available to 

download books, tutorials etc. to improve their knowledge and learn new things. 
6.Chatting & Social Media: 
People can chat with friends and family on the internet using different software like Skype etc. One can interact 

with friends over social media websites like Face book, Twitter & Google Plus. They can also share photos and videos 
with friends. 

 
B).Uses of Computers in Education: 
1.CBT(Computer based teaching): are different programs that are supplied on CD-ROM. These programs 

include text, graphics and sound. Audio and Video lectures are recorded on the CDs. CBT is a low cost solution for 
educating people. You can train a large number of people easily. 

Benefits of CBT: 
 Some benefits of CBT are as follows: 

1. The students can learn new skills at their own pace. They can easily acquire knowledge in any available time 
of their own choice. 

2. Training time can be reduced. 
3. Training materials are interactive and easy to learn. It encourages students to learn the topic. 
4. Planning and timing problems are reduced or eliminated. 
5. The skills can be taught at any time and at any place. 
6. It is very cost effective way to train a large number of students. 
7. Training videos and audios are available at affordable prices. 

 
2.Computer Aided Learning (CAL): 
Computer aided learning is the process of using information technology to help teaching and enhance the learning 

process. The use of computer can reduce the time that is spent on preparing teaching material. It can also reduce the 
administrative load of teaching and research. The use of multimedia projector and PowerPoint presentations has 
improved the quality of teaching. It has also helped the learning process. 

 
3.Distance Learning: 
Distance learning is a new learning methodology. Computer plays the key role in this kind of learning. Many 

institutes are providing distance learning programs. The student does not need to come to the institute. The institute 
provides the reading material and the student attends virtual classroom. In virtual classroom, the teacher delivers 
lecture at his own workplace. The student can attend the lecture at home by connecting to a network. The student can 
also ask questions to the teacher. 
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4.Online Examination: 
The trend of online examination is becoming popular. Different examination like GRE, GMAT and SAT are 

conducted online all over the world. The questions are marked by computer. It minimizes the chance of mistakes. It 
also enables to announce the result in time. 

 
C). Uses of Computers in Business: 
The use of computer technology in business provides many facilities. Businessmen are using computers to interact 

with their customers anywhere in the world. Many business tasks are performed more quickly and efficiently. 
Computers also help them to reduce the overall cost of their business. Computer can be used in business in the 
following ways. 

1.Marketing: 
An organization can use computers for marketing their products. Marketing applications provide information 

about the products to customers. Computer is also used to manage distribution system, advertising and selling 
activities. It can also be used in deciding pricing strategies. Companies can know more about their customers and their 
needs and requirements etc. 

2.Stock Exchange: 
Stock Exchange is the most important place for businessmen. Many stock exchanges use computers to conduct 

bids. The stockbrokers perform all trading activities electronically. They connect with the computer where brokers 
match the buyers with sellers. It reduces cost as no paper or special building is required to conduct these activities. 

 
D). Uses of computers in Pharmacy/Medical Field: 
1.Hospital Management System: 
Specialized hospital management software’s are used to automate the day to day procedures and operations at 

hospitals. These tasks may be online appointments, payroll admittance and discharge records etc. 
2.Patient History: 
Hospital management systems can store data about patients. Computers are used to store data about patients, their 

diseases & symptoms, the medicines that are prescribed. 
3.Patients Monitoring: 
Monitoring systems are installed in medical wards and Intensive care units to monitoring patients continuously. 

These systems can monitor pulse, blood pressure and body temperature and can alert medical staff about any serious 
situations. 

4.Life Support Systems: 
Specialized devices are used to help impaired patients like hearing aids.  
5.Diagnosis Purpose: 
A variety of software’s are used to investigate symptoms and prescribed medication accordingly. Sophisticated 

systems are used for tests like CT scan, ECG, and other medical tests. 
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Abstract 
This chapter provides a detailed understanding of the architecture and components of a computer system, focusing 
on its fundamental units such as the input unit, central processing unit (CPU), and output unit. It explains how these 
components interact to perform data processing tasks efficiently. Special emphasis is given to the structure and 
functions of the CPU, including the Arithmetic Logic Unit (ALU), Control Unit (CU), and memory unit. 
The chapter further explores different types of computer architectures, namely Von Neumann and Harvard 
architectures, highlighting their design principles and operational differences. In addition, it presents an in-depth 
discussion of computer memory systems, including primary memory, secondary memory, and cache memory, along 
with their characteristics and classifications. 
The role of input and output devices is also examined, along with various storage technologies such as magnetic and 
optical storage devices. The chapter concludes with a comprehensive overview of storage media, including hard disks, 
magnetic tapes, and floppy disks, emphasizing their structure, working mechanisms, and performance considerations. 
Overall, this chapter builds a strong foundation for understanding how computer systems are organized and how they 
manage data and instructions. 
 
Keywords 
Computer Architecture, CPU, ALU, Control Unit, Memory, Primary Memory, Secondary Memory, Cache Memory, 
Input Devices, Output Devices, Storage Devices, Von Neumann Architecture, Harvard Architecture, Magnetic 
Storage, Optical Storage 

 
Elements/components of A Computer System(Architecture):  

A computer system mainly has three components viz. Input Unit, Central Processing Unit and Output Unit. These 
components are the building blocks of a computer and define its architecture. 

 
The relationship among these components is well established by the following diagram:  
 

 

http://cdn.yourarticlelibrary.com/wp-content/uploads/2015/07/clip_image00277.jpg
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(i) Input Unit:  
Input unit is responsible for controlling the various input devices that are used to enter data into the computer. 

The commonly used input devices are mouse, keyboard, light pen, optical scanner etc. While some input devices are 
designed for special purposes such as Optical Character Recognition (OCR), Magnetic Ink Character Recognition 
(MICR) and Bar Code Reader etc, there are other devices that accept input by responding to physical touch and voice 
such as ATMs. 

 
 
(ii) Central Processing Unit (CPU):  
The CPU ensures the flow of data into the system by directing the data to enter the system, storing it into the 

memory and retrieving it when needed to produce the output. 
 
It has three parts:  
Arithmetic and Logic Unit (ALU): It performs all the arithmetical calculations and computations like addition, 

subtraction, multiplication and division. It is also responsible for logical calculations like comparisons among data 
items. 

Memory Unit: The data has to be stored in the memory blocks of the computer before it is retrieved for actual 
processing. 

Control Unit: As the name suggests, control unit controls and coordinates the activities of all the components of 
the computer system. It reads data from the memory, decodes the instructions, looks after its execution, and fetches 
the next instruction and so on. 

 
(iii) Output Unit:  
It controls various output devices like printer, graphic plotter, speech synthesizer, monitor (also known as Visual 

Display Unit or VDU) to produce the desired output and present it to the user. It ensures the convertibility of output 
into human readable form that is understandable by the user.  

http://cdn.yourarticlelibrary.com/wp-content/uploads/2015/07/clip_image00463.jpg
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 computer architectures:  
There are basically two types of digital computer architectures. The first one is called Von Neumann architecture 

and later Harvard architecture was adopted for designing digital computers. 
 
1.Von Neumann Architecture: 

 
 
It is named after the mathematician and early computer scientist John Von Neumann. In this the computer has 

single storage system (memory) for storing data as well as program to be executed. Processor needs two clock cycles 
to complete an instruction. Pipelining the instructions is not possible with this architecture. In the first clock cycle the 
processor gets the instruction from memory and decodes it. In the next clock cycle the required data is taken from 
memory. For each instruction this cycle repeats and hence needs two cycles to complete an instruction. This is a 
relatively older architecture and was replaced by Harvard architecture. 

 
2.Harvard Architecture: 
The Harvard architecture is computer architecture with physically separate storage and signal pathways for 

instructions and data. The term originated from the Harvard Mark I relay-based computer, which stored instructions 
on punched tape (24 bits wide) and data in electro-mechanical counters. These early machines had data storage entirely 
contained within the central processing unit, and provided no access to the instruction storage as data. Programs 
needed to be loaded by an operator; the processor could not boot itself. 

 

http://v-codes.blogspot.in/2010/09/difference-between-harward-and-von.html
http://cdn.yourarticlelibrary.com/wp-content/uploads/2015/07/clip_image00653.jpg
http://4.bp.blogspot.com/_c99lLjgQ8ho/TITToIOFEVI/AAAAAAAAAow/xMOWISGW29I/s1600/1.bmp


International Multidisciplinary Book Series Vol. 1, Issue 1 (2023) 

 https://ibseries.com/index.php/IMBS/ 

 

 

 

25 

 
 
 The name is originated from "Harvard Mark I" a relay based old computer. The computer has two separate 

memories for storing data and program. Processor can complete an instruction in one cycle if appropriate pipelining 
strategies are implemented. In the first stage of pipeline the instruction to be executed can be taken from program 
memory. In the second stage of pipeline data is taken from the data memory using the decoded instruction or address. 
Most of the modern computing architectures are based on Harvard architecture. But the number of stages in the 
pipeline varies from system to system.  

 
CPU: 

Alternately referred to as a processor, central processor, or microprocessor, the CPU is the Central Processing Unit 
of the computer. A computer's CPU handles all instructions it receives from hardware and software running on the 
computer. 
 
Components of the CPU 

In the CPU, the primary components are the ALU (Arithmetic Logic Unit) that performs mathematical, logical, 
and decision operations and the CU (Control Unit) that directs all of the processors operations. Following diagram 
gives working of CPU step by step. 

 
 
 
ALU: 
An arithmetic logic unit (ALU) is a digital circuit used to perform arithmetic and logic operations. It represents the 

fundamental building block of the central processing unit (CPU) of a computer. Modern CPUs contain very powerful 
and complex ALUs. In addition to ALUs, modern CPUs contain a control unit (CU).  

Most of the operations of a CPU are performed by one or more ALUs, which load data from input registers. A 
register is a small amount of storage available as part of a CPU. The control unit tells the ALU what operation to 
perform on that data and the ALU stores the result in an output register. The control unit moves the data between 
these registers, the ALU, and memory.  

 
How an ALU Works: 
It performs both bitwise and mathematical operations on binary numbers and is the last component to perform 

calculations in the processor. The ALU uses, to operands and code that tells it which operations to perform for input 
data. After the information has been processed by the ALU, it is sent to the computer's memory. 

Multiple Arithmetic Logic Units can be found in CPUs, GPUs and FPUs. In some computer processors, the ALU 
is divided into an AU and LU. The AU performs the arithmetic operations, and the LU performs the logical operations. 

An ALU performs basic arithmetic and logic operations. Examples of arithmetic operations are addition, 
subtraction, multiplication, and division. Examples of logic operations are comparisons of values such as NOT, AND, 
and OR.  

 

http://www.computerhope.com/jargon/c/compinst.htm
http://www.computerhope.com/jargon/h/hardware.htm
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http://www.computerhope.com/jargon/c/contunit.htm
http://www.computerhope.com/jargon/b/bitwoper.htm
http://www.computerhope.com/jargon/b/binary.htm
http://www.computerhope.com/jargon/o/operand.htm
http://www.computerhope.com/jargon/m/memory.htm
http://www.computerhope.com/jargon/c/cpu.htm
http://www.computerhope.com/jargon/g/gpu.htm
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 Control unit(CU): 
A control unit is circuitry that directs operations within a computer's processor. It lets the computer's logic unit, 

memory, as well as both input and output devices know how to respond to instructions received from a program. 
Examples of devices that utilize control units include CPUs and GPUs. 

A control unit works by receiving input information that it converts into control signals, which are then sent to the 
central processor. The computer's processor then tells the attached hardware what operations carry out. The functions 
a control unit performs depend on the type of CPU, due to the variance of architecture between different 
manufacturers. The following diagram illustrates how instructions from a program are processed. 

 
Memory: 

 
 
A memory is just like a human brain. It is used to store data and instructions. Computer memory is the storage 

space in computer where data is to be processed and instructions required for processing are stored. The memory is 
divided into large number of small parts called cells. Each location or cell has a unique address which varies from zero 
to memory size minus one. For example if computer has 64k words, then this memory unit has 64 * 1024=65536 
memory locations. The address of these locations varies from 0 to 65535. 

Memory is major part of computers that categories into several types. The computer memory offers several kinds 
of storage media some of them can store data temporarily and some them can store permanently. Memory consists of 
instructions and the data saved into computer through Central Processing Unit (CPU). 

 
Memory is primarily of three types 

• Cache Memory 

• Primary Memory/Main Memory 

• Secondary Memory 
 

 

http://www.computerhope.com/jargon/c/cpu.htm
http://www.computerhope.com/jargon/a/alu.htm
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Types of Computer Memory:-Memory is the best essential element of a computer because computer can’t perform 
simple tasks. The performance of computer mainly based on memory and CPU. Memory is internal storage media of 
computer that has several names such as majorly categorized into two types, Main memory and Secondary memory. 

1. Primary Memory / Volatile Memory. 
2. Secondary Memory / Non Volatile Memory. 
3.Cache Memory 
 
1. Primary Memory / Volatile Memory/ Main memory:- Primary Memory also called as volatile memory 

because the memory can’t store the data permanently. Primary memory select any part of memory when user want to 
save the data in memory but that may not be store permanently on that location. It also has another name i.e. RAM. 

Random Access Memory (RAM):- The primary storage is referred to as random access memory (RAM) due to the 
random selection of memory locations. It performs both read and write operations on memory. If power failures 
happened in systems during memory access then you will lose your data permanently. So, RAM is volatile memory.  
 

RAM categorized into following types. 

• DRAM 

• SRAM 

• DRDRAM 
 
Characteristics of Main Memory 

• These are semiconductor memories 

• It is known as main memory. 

• Usually volatile memory. 

• Data is lost in case power is switched off. 

• It is working memory of the computer. 

• Faster than secondary memories. 

• A computer cannot run without primary memory. 
 
2. Secondary Memory / Non Volatile Memory:- Secondary memory is external and permanent memory that is 

useful to store the external storage media such as floppy disk, magnetic disks, magnetic tapes and etc cache devices. 
Secondary memory deals with following types of components. 

Read Only Memory (ROM) :- ROM is permanent memory location that offer huge types of standards to save data. 
But it work with read only operation. No data lose happen whenever power failure occurs during the ROM memory 
work in computers. 

 
ROM memory has several models such names are following. 
1. PROM: Programmable Read Only Memory (PROM) maintains large storage media but can’t offer the erase 

features in ROM. This type of RO maintains PROM chips to write data once and read many. The programs or 
instructions designed in PROM can’t be erased by other programs. 

2. EPROM : Erasable Programmable Read Only Memory designed for recover the problems of PROM and ROM. 
Users can delete the data of EPROM thorough pass on ultraviolet light and it erases chip is reprogrammed. 

3. EEPROM: Electrically Erasable Programmable Read Only Memory similar to the EPROM but it uses electrical 
beam for erase the data of ROM. 

 
Characteristic of Secondary Memory 

• These are magnetic and optical memories 

• It is known as backup memory. 

• It is non-volatile memory. 

• Data is permanently stored even if power is switched off. 

• It is used for storage of data in a computer. 

• Computer may run without secondary memory. 

• Slower than primary memories. 
 
3.Cache Memory:- Cache memory is a very high speed semiconductor memory which can speed up CPU. It acts 

as a buffer between the CPU and main memory. It is used to hold those parts of data and program which are most 
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frequently used by CPU. The parts of data and programs are transferred from disk to cache memory by operating 
system, from where CPU can access them. 

 
Advantages:- The advantages of cache memory are as follows: 

• Cache memory is faster than main memory. 

• It consumes less access time as compared to main memory. 

• It stores the program that can be executed within a short period of time. 

• It stores data for temporary use. 
 
Disadvantages:- The disadvantages of cache memory are as follows: 

• Cache memory has limited capacity. 

• It is very expensive. 
 

Input device 
An input device is a piece of hardware that is used to enter data into a computer or a similar processing device 

such as a smart phone. 
Input devices are usually categorized as either manual or automatic. 
 
Examples of manual input devices are:  

• Keyboard 

• Mouse 

• Touchpad 

• Joystick 

• Touchscreen 

• Concept keyboard 

• Scanner 

• Graphics tablet 

• Microphone 

• Digital camera 

• Examples of automatic input devices are: 

• Barcode readers 

• Optical mark reader (OMR) 

• Magnetic Ink Character Recognition (MICR) 

• Optical Character Recognition (OCR) 

• Magnetic stripe readers 

• Sensors 

• Biometric devices 
 

Output device 
An output device is a piece of hardware that is used to output data that has been previously entered into a computer 

or similar processing device. 
In computing terms, an output device is a piece of hardware that obeys a computer command to do something in 

the real world. For example a printer is an output device that will produce a page of information when the correct 
commands are sent to it from a computer 

 
Here are some examples of output devices: 

• Monitor 

• Printer 

• Plotter 

• Projector 

• Speaker 

• Headphones 

• Light / LED 
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Storage device:- Physical components or materials on which data is stored are called storage media. Hardware 
components that read/write to storage media are called storage devices. Two main categories of storage technology 
used today are magnetic storage and optical storage. 

 
Primary magnetic storage:- 

• Diskettes 

• Hard disks (both fixed and removable) 

• High capacity floppy disks 

• Disk cartridges 

• Magnetic tape 
 
Primary optical storage 

• Compact Disk Read Only Memory (CD ROM) 

• Digital Video Disk Read Only Memory (DVD ROM) 

• CD Recordable (CD R) 

• CD Rewritable (CD RW) 

• Photo CD 
 
1) Magnetic Tapes: The Magnetic Tapes is the Type of Secondary Storage Device and this Device is used for 

taking back up of data and this Tape contains some magnetic fields and the Magnetic Tapes are used Accessing the 
data into the Sequential Form and the Tape Also Contains a Ribbon which is coated on the Single Side of the Tape 
and also contains a head which reads the data which is Recorded on to the Tape. And when we are reading the 
information from the disk then we can also read backward information means we can also back the Tape for Reading 
the Previous information. And For inserting the Tape into the System we also Requires Some Tape Drives Which 
Contains Tape and which is Responsible for Reading the contents from the Tapes.  

They can Store huge Amount of data into the Tape Drive , But the Main Limitation of the Tape Drive is that we 
can’t Access the Data from the Disks directly means if we want to 100th Record from the Tape then we must have to 
move all the Previous i.e. 99th Records first. And the Tapes are also easily damaged due to the Human Errors.  

 
2.Magnetic Disks:- This is also called as the hard disk and this is made from the thin metal platter which is coated 

on the both sides of the magnetic Disks. And the there are Many Plates or Platters into a single Hard Disk and all the 
Plates are Made from the Magnetic Materials and all the Disks are Rotate from the 700 to 3600 rpm means Rotation 
per Minute and the Hard Disk also Contains a head which is used for both Reading and Writing the Data from the 
Hard Disks. The disk surface is divided into concentric tracks (circles within circles). The thinner the tracks, the more 
storage. The data bits are recorded as tiny magnetic spots on the tracks. The smaller the spot, the more bits per inch 
and the greater the storage. 

The Plate of Disk is Divided into the Tracks and sectors and the collection of Tracks makes a Cylinder means all 
the Tracks of the Disk which a Consecutive Areas makes a Cylinder.  

The Disk is first divided into the Number of Tracks and the Tracks are further divided into the sectors and the 
Number of Tracks Makes a Cylinder. All the data is Stored into the disk by using Some Sectors and each sectors 
belongs to a Tracks. The Data is accessed from the Disk by using the heads, all the heads have Some Arm those are 
used for Reading the Data from the Particular Tracks and sector. When the Disk Rotates very high Speed then the 
Head also Moves, For Reading the data from the Disk the ARM touches with the Particular Track and read the data 
from that Location.  

For Locating a Particular data from the Disk the head Moves Around the Disk very Fastly and data which a user 
wants to Access must have an Address So that Arm of the head just use that Address Means the Number of Cylinder, 
Number of Track and Number of Sectors from which user wants to read the data. With the Help of these Read and 
Write heads we can also Read the Data from the Disk and we can also Stores some data onto the Disk. Some Time 
Considerations are also used when we are accessing or storing the data onto the hard disk.  

1)   Seek Time: - The Total Time which is Taken to Move on the Desired track is known as the seek Time. And 
time is always measured by using the Milliseconds.  

2)    Latency Time. : The time required to Bring the Particular Track to the Desired Location Means the Total 
Time to bring the Correct the Sector for Reading or for the read and Write head. This is also called as the Average 
Time.  

3)    Data Transfer Time: The Total Time which is required for Reading and Writing the data into the Disk is 
known as the Data transfer Time.  
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When we are Taking About the Magnetic Tapes then we can say that the Storage Capacity of the disk is Measure 

in the Form of Mega Bytes and when are talking about the Hard Disk then the Measurement will be in the Form of 
Giga Bytes. Means the Capacity of t the Hard Disk will be Read by using the Giga Bytes. The Magnetic Tapes are 
Sequential Access Device and the Hard Disk is the Direct Access Device means the data of this Disk will be Read 
from Any Location and the Data can be Read from the Disk by using the Read Write Heads. But hard Disks are 
Costlier than the Simple Magnetic Tapes. But the capacity of the Hard Disk is very high in compare to the Tapes.  

Tracks and Spots:-The disk surface is divided into concentric tracks (circles within circles). The thinner the tracks, 
the more storage. The data bits are recorded as tiny magnetic spots on the tracks. The smaller the spot, the more bits 
per inch and the greater the storage.  

Sectors:-Tracks are further divided into sectors, which hold a block of data that is read or written at one time; for 
example, READ SECTOR 782, WRITE SECTOR 5448. In order to update the disk, one or more sectors are read 
into the computer, changed and written back to disk. The operating system figures out how to fit data into these fixed 
spaces. Modern disks have more sectors in the outer tracks than the inner ones because the outer radius of the platter 
is greater than the inner radius 

 
Block diagram of Magnetic Disk 

3. Floppy Diskette: Floppy disk is a kind of storage device that can be used to  carried around? The Floppy Disk 
is also a Secondary Storage device which is used for storing the data in a Permanent Manner. The floppy is made up 
of Rigid Mylar Plastic and also contains a Magnetic black disk inside the Plastic Cover. The Floppy Disk also Stores 
all the Data into the Form of Tracks and Sectors and the floppy Disk provides both Reading and Writing the data into 
the Disk. The Floppy Disk is also called as Reusable Disk means the Floppy Disk Provides us the Facility to Read and 
Writes the Data into disk as and When Necessary and Also Many Times. We can Read and Write the data from the 
Disk.  

The Main Advantage of the Floppy Disk is that the Data can be Stored many Times but the Main Limitation of 
the floppy Disk is that floppy Disk have a Small capacity and the Floppy Disk also doesn’t have Reliability means the 
Data Stored into the Disk may not be used for Long Time because the floppy Disk is very Sensitive Thing when we 
Move the Head of the Disk Again and Again then the floppy disk gets Damaged. So that we can say that Floppy Disk 
is not a Reliable thing. And I the Other side the Cost of floppy Disk is also high means with the Comparison of the 
Other Storage Media’s Floppy Disk have some more cost.  

But the Main Advantage of the Floppy Disk is that floppy Disk is used for Moving the data from one Computer 
to Another With the Advent of the Floppy Disk we can Store the Data Into the Floppy Disk and after that we can 
Easily Remove that Disk from the System and Also Put the Disk into the Another System for Taking the Data.  

But we cannot Start or Run the System without the Hard Disk So that floppy Disk is used to Transfer the Files 
from one System into the. There are Two Types of floppy Disk Available first is the 3.5 and second is the 5.2. But for 
inserting the Floppy Disk into the System we must have to use the Floppy Disk Drive in the System.  

For Reading the data from the Disk there are also Some Read and Write heads those are too used. And the Head 
will touch the Surface of the floppy Disk So that this will lead to the Damage of the Disk So Quickly because when 
the Head Directly Touch the Surface of the Disk, then this will lead to the Scratches on the Disk and also cause 
Damage of the Disk. And the Drive can take only one Disk Means we can insert only one Floppy Disk at a Time into 
the Floppy Drive. The capacity of the floppy Disk is 1.44 MB. So that we can Floppy Disks as rare as Possible.  

Floppy Disk Contains a Notch which Specify Whether the data will be Read or Write Means to Say if we wants to 
protect our data then we can set the Notch of the Floppy Disk as a Read Only.  

 

http://ecomputernotes.com/fundamental/introduction-to-computer/floppy-disk
http://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
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4.Hard disk:- A hard disk drive also called hard drive, hard disk or disk drive is a device used for storing and 
retrieving digital data or information. A hard disk is a stack of disk known as the platter. A single hard disk usually 
consists of several platters and each platter requires two read/write heads, one for each side and is attached to a single 
access arm. Data are recorded electromagnetically in a concentric circle such as the track on a disk.  

Hard disk is still the most common storage device for all computers. Like diskettes hard drives store data in tracks 
divided into sectors. Physically however they look quite different to diskettes. Includes one or more metal platters 
mounted on a central spindle, like a stack of rigid diskettes. Each platter is covered with a metal coating and the entire 
unit is contained in a sealed chamber. The hard disk and drive is a single unit which includes the hard disk, the motor 
that spins the platters and a set of read/write heads. Because you cannot remove the disk from the drive the terms 
hard disk and hard drive are used interchangeably. Hard drives have become the primary storage devices for PCs 
because they are convenient and cost effective. They outperform diskettes in both speed and capacity. Hard disks 
offer capacities from several hundred MB and more. Most entry level PCs now come with hard disks of at least 6.8MB.  

 
Two important physical differences between hard disks and diskettes account for the differences in performance. 
1. Hard disks are sealed in a chamber 
2. Hard disk consists of a rigid metal platter (usually aluminum) rather than flexible Mylar. 
 
Hard disk spin between 3600 rpm and 7200 rpm compared to a diskette 300 rpm. The speed at which the disk 

spins is a major factor in overall performance. The rigidity of the disk and the high-speed rotation allows more data 
to be recorded on the surface. Waving a magnet past an electric coil causes a current to flow. The faster you wave the 
magnet and the closer the magnet is to the coil, the larger the current generated in the coil. The disk that spins faster 
can use smaller magnetic charge to make current flow to the read/write head. The drives heads can also use a lower 
density current to record data on the disk. Not only does hard disks pack the data closer together they also hold more 
data because they usually include multiple platters stack one on top of each other. This configuration means that the 
disk has more than 2 sides, in addition to side 0 and 1 there are sides 2, 3, 4, and so on. Larger capacity disks may use 
12 platters but both side of every platter are not always used. The number of sides that the disk uses is specified by 
the number of read/write heads. A particular disk may have 6 disks platters (12 sides) but only 11 heads à one side is 
not used to store data. Unused side is often the bottom one. The term cylinder is often used to refer to the same track 
across all the disks. Track 0 (outermost track) on every disk is cylinder 0. 

 
  
Platter :-A hard disk platter or the disk is a circular disk in which the magnetic data is stored. A hard disk drive 

can have several platters that are mounted on the same spindle. 
 spindle / spindle motor :-The spindle motor is responsible for turning the hard disk platters and  must provide 

stable, reliable and consistent turning , to allow the hard disk to function properly.  
Head : -Responsible for read - write operation of data from and to the platter.  
actuator : - Used to position the head arms to different tracks on the surface of the platter, actuator is used in 

changing from track to track the only operation on the hard disk that requires active movement. This mechanism of 
hard disk must works at extreme speed, with precise accuracy for the data to be read and write accurately on the platter. 
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Abstract 
This chapter provides a comprehensive overview of peripheral devices and the classification of computer systems 
based on size, structure, and purpose. It begins with a detailed explanation of input devices, highlighting their role in 
converting human-readable data into machine-processable form. Various input devices such as keyboards, mouse, 
scanners, and recognition systems (OCR, MICR, OMR) are discussed along with their functionalities. 
The chapter further explores output devices, including monitors, printers, and plotters, emphasizing their types, 
working principles, advantages, and limitations. Different display technologies such as CRT, LCD, LED, and OLED 
are also examined. In addition, the chapter provides an in-depth understanding of storage and printing technologies. 
Beyond peripheral devices, the chapter classifies computers based on size and processing power, including 
supercomputers, mainframe computers, minicomputers, and microcomputers. It also discusses computer types based 
on hardware structure, such as analog, digital, and hybrid computers, as well as classification based on purpose, 
including general-purpose and special-purpose computers. The chapter concludes with an explanation of personal 
computers, their characteristics, configurations, and types, offering a holistic understanding of modern computing 
systems. 
 
Keywords:Peripheral Devices, Input Devices, Output Devices, Storage Devices, Keyboard, Mouse, Scanner, Monitor, 
Printer, Plotter, Computer Classification, Supercomputer, Mainframe, Minicomputer, Microcomputer, Analog 
Computer, Digital Computer, Hybrid Computer, Personal Computer 

 
Peripheral Devices:- 
What is Input and Input Devices:- 

"Any data or instruction that is used by a computer is called input. This data or instruction can come directly from 
end user or from other devices." “An input device is a hardware device that is used to provide input (data / 
instructions) to a computer so that it can be processed". Input device translates words, sounds images, and actions 
that people understand into symbols that the system unit can process. Input devices include keyboards, Mouse, digital 
Camera and light pen. Besides the widely used input devices like keyboard & Mouse there are other different input 
devices that perform various input operations like a scanner scan images / documents. Webcams capture videos & 
images.  

For example, while you prepare word documents or spread sheets, you use the keyboard to enter text & numbers 
and use command keys to save / print documents. You can also perform operations on computer using voice 
commands. These are all different methods of providing an input to a computer. 

 
1.Keyboard:- 
A keyboard is an essential input device that combines a typewriter keyboard with a numeric keypad. The special 

purpose keys and the function keys are used to perform a special tasks like pressing Control key (CTRL) key in 
combination with “P” prints a document, or pressing the “F2” function key opens a window with help content about 
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any issue or topic. Nowadays Multimedia keyboards are common as they have task specific keys & buttons. For 
example, volume control ext. Wireless keyboards are also popular these days that can be connected to a tablet or a 
computer via Bluetooth. 

 
2. Mouse:- 
The mouse is another essential input device that controls the pointer displayed on the monitor. A mouse can have 

2 or more buttons. Mostly the Right-Mouse Button and the Left-Mouse button, and a wheel button for scrolling pages.  
 
Mouse is of three types. 
1.Mechanical Mouse 
A mechanical mouse is considered as the traditional mouse and is now replaced by optical mouse. A mechanical 

mouse has a ball on the bottom, which is attached to the system unit through a cord. A mechanical mouse requires 
periodic cleaning. 

2. Optical mouse 
Optical Mouse is widely used these days. Like the mechanical mouse, it does not have any moving parts. It emits 

& senses light to detect mouse movements. Optical mouse can be used on any surface with great precision as compared 
to Mechanical mouse. 

3.Wireless Mouse 
A wireless mouse or cordless mouse uses infrared or radio wares to communicate with the system units. A wireless 

mouse is battery powered and can be connected to a laptop or tablet computer.  
 
3.Character and mark recognition devices:- 
 Character and mark recognition devices are scanners that are able to recognize special characters and marks. 

Essentially used for certain applications. 
 
Types of character and mark recognition devices are as follows:- 
MICR (Magnetic Ink Character Recognition): Used by banks to read numbers written on cheque. Special 

purpose machine reads character made of ink containing magnetized particles. 
OCR (Optical Character recognition): Special preprinted characters that can be read by light source and changed 

into machine readable form. Used in department stores to read retail price tags by reflecting light. 
OMR (Optical Mark Recognition): An OMR device senses the presence or absence of a mark such as pencil 

mark. Used to calculate or store multiple choice tests. 
 
4.Scanner:- 
A scanner is an electronic device that scans printed or handwritten text documents, images, or a particular object 

to convert them into a digital file format. Most of the scanners use CCD, (charge-coupled device) or CIS, (Contact 
Image Sensor) as the image sensors. The common types of scanners we see today are flatbed scanners, handheld 
scanners, sheet-fed scanners, etc. 

1.  Flatbed Scanner:- A flatbed scanner is made up of a glass pane and a moving optical CIS or CCD array. The 
pane is illuminated with the help of bright light planted underneath it. The image which is to be scanned is then placed 
on the glass pane. The sensor and the source of light move across the glass pane to scan the document and produce 
its digital copy. 

2. Sheet-fed Scanner:- In sheet-fed scanners, the document that is supposed to be scanned is fed into the 
horizontal or vertical slot provided in the scanner. The vital components of sheet-fed scanner are the sheet-feeder, 
scanning module and calibration sheet. Such scanners are most often used to scan single page documents. It can't be 
used to scan thicker objects, like books, which turn out to be its major drawback. 

3. Handheld Scanner:- A handheld scanner is a small manual scanning device which is moved over the object 
that need to be scanned. For instance, if a document needs to be scanned, the handheld scanner has to be dragged 
over the document. Using a handheld scanner can prove to be a cumbersome task, as the hand needs to be steady all 
the time. Slight movement of the hand can lead to distortion of the image. One of the most utilized handheld scanner 
is the barcode scanner, typically used in shopping stores to valuate goods. 

4.Photo Scanner:- Photo scanners are mostly used to scan photographs. High resolution and color depth are the 
most vital requirements for scanning photographs, and photo scanner provides the same. If the motive of buying a 
scanner is to digitize film negatives and slides, then the photo scanner is the best option. They are specially designed 
to work on slides and negatives. The in-built software in some photo scanners can also help in cleaning old 
photographs. 

5. Film Scanner:- A film scanner is utilized to scan photographic films directly into a computer. The photographer 
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has direct control over certain aspects, such as cropping, ratio of original image on the film, etc. Some film scanner 
shave specialized software through which it is possible to minimize scratches and improve color quality. Low-end film 
scanners most often accept 35 mm film strips while the high-end scanners have interchangeable film loaders which 
can accept 35 mm strips or 120 mm ones, or individual slides. 

6.Portable Scanners:- Being small in size, portable scanners can be easily carried with oneself anywhere. Some 
scanners are as small as your PDAs, hence, can be easily carried in the pockets. Such scanners are useful for text 
document scanning. The drawback of these scanners is their limitation as far as resolution is concerned. They cannot 
be used for scanning photographs or other such applications which require high resolution scanning. 

 
5.Monitor:-  
A computer monitor, technically termed as a visual display unit, can be plainly described as an electronic device 

that transmits information from the computer onto a screen, thereby acting as an interface and connecting the viewer 
with the computer. At present, computer monitors are available in a variety of shapes, designs, and colors. However, 
based on the technology used to make computer monitors, they can be broadly categorized into three types. 

• CRT (Cathode Ray Tube) 

• LCD (Liquid Crystal Display) 

• LED (Light-Emitting Diodes) 

• OLED(Organic light-emitting diodes) 
 
CRT (Cathode Ray Tube) Monitors:- These monitors employ the CRT 

technology used most commonly in the manufacturing of television screens. In 
this, a stream of intense high energy electrons is used to form images on a 
fluorescent screen. A cathode ray tube is a basically a vacuum tube containing an 
electron gun at one end and a fluorescent screen at another end. From this 
electron gun, a process called thermionic emission generates a strong beam of 
electrons. These electrons travel through a narrow path within the tube with high 
speed using various electro-magnetic devices and finally strike the phosphor 
points present on the fluorescent screen, thus creating an image.  

 
There are several Advantages of using CRT monitors: 

• These monitors are highly reliable and efficient, and are capable of generating a resolution of up to 2048 
x 1536 pixels, thereby providing a clear picture quality. Also, CRT monitors that are now available are 
capable of producing thousands of different colors. 

• Secondly, CRT monitors are affordable and cost effective. 

• Unlike conventional CRT monitors, modern technological advancements have resulted in the 
development of flat screen CRT monitors that reduce the glare and are good for the eyes. 

 
Disadvantage of CRT Monitor:-  
However, the only concern with buying CRT monitors is that they are heavy and can occupy a great deal of work 

space. Also, these devices get heated up very easily. 
 
LCD (Liquid Crystal Display) Monitors:- Liquid crystal display, also known as liquid crystal diode, is one of 

the most advanced technologies available at present. Typically, an LCD monitor 
consists of a layer of color or monochrome pixels arranged schematically between 
a couple of transparent electrodes and two polarizing filters. Optical effect is 
achieved by polarizing the light in varied amounts and making it pass through the 
liquid crystal layer. At present, there are two types of LCD technology available. 
These include the active matrix or TFT and a passive matrix technology. Among 
these, TFT technology is more secure and reliable, and generates better picture 
quality. On the other hand, passive matrix has a slow response time and is slowly 
becoming outdated.  

 
In recent times, LCD monitors have become increasing popular with consumers. Some major advantages of using 

an LCD monitor include: 

• These monitors are compact, lightweight, and do not consume much desk space. 

• Secondly, these monitors do not consume much electricity and can even be operated by using batteries. 
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• Also, the images transmitted by these monitors do not get geometrically distorted and have little flicker.  

• However, LCD monitors do have certain disadvantages. Most importantly, these monitors are very 
expensive. Secondly, image quality is not constant when viewed from different angles. Also, an LCD 
monitor’s resolution is always constant. Any alterations can result in a reduced performance. 

 
LED (Light-Emitting Diodes) Monitors:- LED monitors are the latest types of monitors in the market today. 

Like LCD, it is again a flat panel display making use of light-emitting diodes for back-lightning instead of Cold Cathode 
Fluorescent (CCFL) back-lightning used in LCDs. Primarily, the display is of LCD only but the back-lightning is done 
by LEDs. LED monitors are said to use much lesser power than CRT and LCD. Thus, they are also considered 
environmental friendly. Other core advantages of LED monitors are: 

• They produce images with higher contrast 

• They have less negative environmental impact when disposed 

• Lifespan and durability of LED monitors is more than CRT or LCD monitors 

• Because of the technology, the monitor panels can be made very thin 

• Do not produce much heat while running 
 
The only Disadvantage is this LED monitors are little expensive than the former types. 
 
There are multiple ways by which LED back-lightning is done. 

• White-edge LEDs are fixed around the rim of the monitor. It used a special diffusion panel to spread light 
evenly behind the screen. 

• An array of LEDs are placed behind the screen. Their brightness is not controlled individually. 

• Again an array of LEDs are placed behind the screen, but the brightness of each individual LED is 
controlled separately. 

 
OLED Monitors:- Organic light-emitting diodes that can light up individual picture elements is an improvement 

in LED technology. It works without a backlight so the monitors can be thinner and more energy efficient while 
producing vivid color saturation and displaying deep black levels. Currently there are few OLED monitors on the 
market due to the high costs in manufacturing. It is a technology that is beginning to show up in HDTVs, and in time, 
if successful, may translate into the computer monitor market. 

 
Ultra-High Definition Monitors:- UHD takes LED technology and adds more pixels onto the screen, going 

from about 2 million pixels in full HD (1,920 by 1,080) to more than 8 million pixels in UHD (3,240 by 2,160). Also 
called 4K technology, the level of image detail and sharpness is excellent, especially when viewing videos, pictures, 
graphic designs and other content that is created in 4K. When sitting close to a UHD monitor, you can notice the 
clarity of the images on the screen.  

The primary disadvantage to a UHD monitor is the high price when compared to other LED monitors that are in 
full HD, but not UHD. Plus, the small amount of 4k content is a detriment.  

 
Touch screen Monitors:- Touch screens have been around for many years, and with advancements in technology, 

screens are sleeker, lighter and more accurate with your touch. You can type of the screen, but for some, keeping a 
keyboard and mouse for some tasks is still desired. A key advantage to a touch screen monitor is it allows you to use 
the touch option when you want to. Touch screen monitors are a little more expensive than non-touch monitors, but 
the pricing is pretty close. As the popularity of touch screens increases in all devices including Smartphone’s, tablets 
and laptops, touch screen computer monitors will also gain in popularity and convenience.  

 
Plasma Display Panel Monitor:- Plasma display panel monitors use small cells of charged gases to create an 

image. These cells are similar to household fluorescent light bulbs. Each plasma cell creates its own illumination, which 
eliminates the need for a separate back light and gives PDP monitors strong contrast. A plasma monitor is typically 
heavier than an LCD display. Plasma screens also draw more power than both LCD and LED monitors, and are 
susceptible to "burned in" images if they are left on for long periods of time. 

 
6.Printer:- A printer is an external output device that takes data from a computer and generates output in the form 

of graphics / text on a paper". There are two types of printers. 
1.Impact printers:- An impact printer makes contact with the paper. It usually forms the print image by pressing 

an inked ribbon against the paper using a hammer or pins. Following are some examples of impact printers. 
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• Dot-Matrix Printers(DMP):- The dot-matrix printer uses print heads containing from 9 to 24 pins. 
These pins produce patterns of dots on the paper to form the individual characters. The 24 pin dot-matrix 
printer produces more dots that a 9 pin dot-matrix printer, which results in much better quality and clearer 
characters. The general rule is: the more pins, the clearer the letters on the paper. The pins strike the 
ribbon individually as the print mechanism moves across the entire print line in both directions, i-e, from 
left to right, then right to left, and so on. The user can produce a color output with a dot-matrix printer 
(the user will change the black ribbon with a ribbon that has color stripes). Dot-matrix printers are 
inexpensive and typically print at speeds of 100-600 characters per second. 

 

• Daisy-wheel printers:- In order to get the quality of type found on typewriters, a daisy-wheel impact 
printer can be used. It is called daisy-wheel printer because the print mechanism looks like a daisy; at the 
end of each “Petal” is a fully formed character which produces solid-line print. A hammer strikes a “petal” 
containing a character against the ribbon, and the character prints on the paper. Its speed is slow typically 
25-55 characters per second. 

 

• Line printers:- In business where enormous amount of material are printed, the character-at-a-time 
printers are too slow; therefore, these users need line-at-a-time printers. Line printers, or line-at-a-time 
printers, use special mechanism that can print a whole line at once; they can typically print the range of 
1,200 to 6,000 lines per minute. Drum, chain, and band printers are line-at-a-time printers. 

 

• Drum printer:- A drum printer consists of a solid, cylindrical drum that has raised characters in bands 
on its surface. The number of print positions across the drum equals the number available on the page. 
This number typically ranges from 80-132 print positions. The drum rotates at a rapid speed. For each 
possible print position there is a print hammer located behind the paper. These hammers strike the paper, 
along the ink ribbon, against the proper character on the drum as it passes. One revolution of the drum 
is required to print each line. This means that all characters on the line are not printed at exactly the same 
time, but the time required to print the entire line is fast enough to call them line printers. Typical speeds 
of drum printers are in the range of 300 to 2000 lines per minute. 

 

• Chain printers:- A chain printer uses a chain of print characters wrapped around two pulleys. Like the 
drum printer, there is one hammer for each print position. Circuitry inside the printer detects when the 
correct character appears at the desired print location on the page. The hammer then strikes the page, 
pressing the paper against a ribbon and the character located at the desired print position. An impression 
of the character is left on the page. The chain keeps rotating until all the required print positions on the 
line have filled. Then the page moves up to print the next line. Speeds of chain printers range from 400 
to 2500 characters per minute. 

 

• Band printers:- A band printer operates similar to chain printer except it uses a band instead of a chain 
and has fewer hammers. Band printer has a steel band divided into five sections of 48 characters each. 
The hammers on a band printer are mounted on a cartridge that moves across the paper to the appropriate 
positions. Characters are rotated into place and struck by the hammers. Font styles can easily be changed 
by replacing a band or chain. 

 
2.Non-impact printers:- Non-impact printers do not use a striking device to produce characters on the paper; 

and because these printers do not hammer against the paper they are much quieter. Following are some non-impacted 
printers. 

 

• Ink-jet printers:- Ink-jet printers work in the same fashion as dot-matrix printers in the form images or 
characters with little dots. However, the dots are formed by tiny droplets of ink. Ink-jet printers form 
characters on paper by spraying ink from tiny nozzles through an electrical field that arranges the charged 
ink particles into characters at the rate of approximately 250 characters per second. The ink is absorbed 
into the paper and dries instantly. Various colors of ink can also be used. One or more nozzles in the print 
head emit a steady stream of ink drops. Droplets of ink are electrically charged after leaving the nozzle. 
The droplets are then guided to the paper by electrically charged deflecting plates [one plate has positive 
charge (upper plate) and the other has negative charge (lover plate)]. A nozzle for black ink may be all 
that’s needed to print text, but full-color printing is also possible with the addition of needed to print text, 
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but full-color printing is also possible with the addition three extra nozzles for the cyan, magenta, and 
yellow primary colors. If a droplet isn’t needed for the character or image being formed, it is recycled back 
to its input nozzle. Several manufacturers produce color ink-jet printer. Some of these printers come with 
all their color inks in a cartridge; if you want to replace on color, you must replace all the colors. Other 
color ink-jet printers allow you to replace ink individually. These printers are a better choice if user uses 
one color more than other colors. These printers produce less noise and print in better quality with greater 
speed. 

 

• Laser printers:- A laser printer works like a photocopy machine. Laser printers produce images on paper 
by directing a laser beam at a mirror which bounces the beam onto a drum. The drum has a special coating 
on it to which toner (an ink powder) sticks. Using patterns of small dots, a laser beam conveys information 
from the computer to a positively charged drum to become neutralized. From all those areas of drum 
which become neutralized, the toner detaches. As the paper rolls by the drum, the toner is transferred to 
the paper printing the letters or other graphics on the paper. A hot roller bonds the toner to the paper.Laser 
printers use buffers that store an entire page at a time. When a whole page is loaded, it will be printed. The 
speed of laser printers is high and they print quietly without producing much noise. Many home-use laser 
printers can print eight pages per minute, but faster and print approximately 21,000 lines per minute, or 
437 pages per minute if each page contains 48 lines. When high speed laser printers were introduced they 
were expensive. Developments in the last few years have provided relatively low-cost laser printers for use 
in small businesses. 

 
Advantages of Laser Printer:-  

• The main advantage of Laser printer is its speed & efficiency at which it prints high-quality quality graphics 
& text. 

• Laser printers produce high-quality output as compared to other printers. 

• Laser printers are quite and do not produce disturbing sounds. 

• They are also capable to produce color prints. 
 

Disadvantages of Laser Printer:- 

• The main disadvantage of Laser printer is its cost; they are relatively costly as compared to other printers. 

• The maintenance, repair & servicing charges are also high of these printers. 

• Laser printers emit small amount of ozone and are hazardous to health and the atmosphere. 
 
7. Plotters:- A plotter is a special output device used to produce hard copies of large graphs and designs on paper, 

such as construction maps, engineering drawings, architectural plans and business charts. The plotter is either a 
peripheral component that you add to your computer system or a standalone device with its own internal processor. 
Plotter has following types:- 

 

• 1.Drum Plotter:- A drum plotter is a pen plotter that wraps the paper around a drum with a pin feed 
attachment. The drum then rotates the paper as pens move across it and draw the image. It was the first 
output device used to print graphics and large engineering drawings. There are two types of drum plotters, 
external and internal. With an external drum plotter, the paper is wrapped around its external surface, 
while the internal drum plotter uses a sheet of paper wrapped around its internal surface. 

• 2.Flat-Bed Plotter:- A flat-bed plotter is a mechanical drafting device used with many CAD programs 
for designers. The paper remains stationary on a flat surface while a pen moves across it horizontally and 
vertically. This plotter may use several different pen colors to create the graphics. The size of the graphic 
is limited to the size of the flat-bed plotter's surface. 

• 3.Inkjet Plotter:- The inkjet plotter creates an image by spraying small droplets of ink on to paper. A 
popular choice for advertising agencies and graphic designers, inkjet plotters are used generally for large 
outputs, such as banners and billboards and large signs often seen along roadsides. They are available in 
thermal or piezoelectric models. Thermal inkjet plotters use heat to apply droplets of ink, while 
piezoelectric plotters use charged crystals to apply the ink. Inkjet plotters typically produce better quality 
graphics than other plotter types. 

• 4.Cutting Plotter:- The cutting plotter is a large scale cutting device that produces ready-cut mylar or 
vinyl lettering and graphics. Automated plotter knives cut into a sheet of the material lying on the plotter's 
flat surface area, carving out the design stored in the attached computer. Used for sign making, billboard 
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advertising and vehicle graphics, the devices offer far greater speed and precision than can be achieved 
with the traditional method of creating sign lettering and logos by hand. 

 
Types of computer according to their size and power:- Computers can be generally classified by size and power 
as follows, though there is considerable overlap .The four basic types of computers are as under:  

1. Supercomputer  2. Mainframe Computer  3. Minicomputer  4.Microcomputer 
 
1.Supercomputer:- An extremely fast computer that can perform hundreds of millions of instructions per second. 

The most powerful computers in terms of performance and data processing are the Supercomputers. These are 
specialized and task specific computers used by large organizations. These computers are used for research and 
exploration purposes, like NASA uses supercomputers for launching space shuttles, controlling them and for space 
exploration purpose. he supercomputers are very expensive and very large in size. It can be accommodated in large 
air-conditioned rooms; some super computers can span an entire building. 

Uses of Supercomputers 
Space Exploration:-Supercomputers are used to study the origin of the universe, the dark-matters. For these 

studies scientist use IBM’s powerful supercomputer “Roadrunner” at National Laboratory Los Alamos. 
Earthquake studies:- Supercomputers are used to study the Earthquakes phenomenon. Besides that 

supercomputers are used for natural resources exploration, like natural gas, petroleum, coal, etc. 
Weather Forecasting:- Supercomputers are used for weather forecasting, and to study the nature and extent of 

Hurricanes, Rainfalls, windstorms, etc. 
Nuclear weapons testing:- Supercomputers are used to run weapon simulation that can test the Range, accuracy 

& impact of Nuclear weapons.   
 
2.Mainframe computer:- A powerful multi-user computer capable of supporting many hundreds or thousands 

of users simultaneously. Although Mainframes are not as powerful as supercomputers, but certainly they are quite 
expensive nonetheless, and many large firms & government organizations uses Mainframes to run their business 
operations. The Mainframe computers can be accommodated in large air-conditioned rooms because of its size. Super-
computers are the fastest computers with large data storage capacity, Mainframes can also process & store large 
amount of data. Banks educational institutions & insurance companies use mainframe computers to store data about 
their customers, students & insurance policy holders. 

Popular Mainframe computers:- 
Fujitsu’s ICL VME    2.  Hitachi’s Z800 
 
3.Minicomputer:-  A multi-user computer capable of supporting up to hundreds of users simultaneously. 

Minicomputers are used by small businesses & firms. Minicomputers are also called as “Midrange Computers”. These 
are small machines and can be accommodated on a disk with not as processing and data storage capabilities as super-
computers & Mainframes. These computers are not designed for a single user. Individual departments of a large 
company or organizations use Mini-computers for specific purposes. For example, a production department can use 
Mini-computers for monitoring certain production process. 

Popular Minicomputers:- 
K-202   2.Texas Instrument TI-990   3. SDS-92   4. IBM Midrange computers 
 
4.Microcomputer:- Desktop computers, laptops, personal digital assistant (PDA), tablets & Smartphone’s are all 

types of microcomputers. The micro-computers are widely used & the fastest growing computers. These computers 
are the cheapest among the other three types of computers. The Micro-computers are specially designed for general 
usage like entertainment, education and work purposes. Well known manufacturers of Micro-computer are Dell, 
Apple, Samsung, Sony & Toshiba. Desktop computers, Gaming consoles, Sound & Navigation system of a car, 
Netbooks, Notebooks, PDA’s, Tablet PC’s, Smartphone’s, Calculators are all type of Microcomputers. 

 
Types of Computer according to their Hardware Structure:- Here are three basic kinds of computers. This is 
based on the hardware structure and the way physical quantities are represented in a computer. The following are the 
three types. 

Analog Computers:- Analog computers are used to process analog data. Analog data is of continuous nature and 
which is not discrete or separate. Such type of data includes temperature, pressure, speed weight, voltage, depth etc. 
These quantities are continuous and having an infinite variety of values. It measures continuous changes in some 
physical quantity e.g. The Speedometer of a car measures speed, the change of temperature  is measured by a 
Thermometer, the weight is measured by Weights machine. These computers are ideal in situations where data can be 
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accepted directly from measuring instrument without having to convert it into numbers or codes. Analog computers 
are the first computers being developed and provided the basis for the development of the modern digital computers. 
Analog computers are widely used for certain specialized engineering and scientific applications, for calculation and 
measurement of analog quantities. They are frequently used to control process such as those found in oil refinery 
where flow and temperature measurements are important. They are used for example in paper making and in chemical 
industry. Analog computers do not require any storage capability because they measure and compare quantities in a 
single operation. Output from an analog computer is generally in the form of readings on a series of dial (Speedometer 
of a car) or a graph on strip chart. 

 
Digital Computers:- A Digital Computer, as its name implies, works with digits to represent numerals, letters or 

other special symbols. Digital Computers operate on inputs which are ON-OFF type and its output is also in the form 
of ON-OFF signal. Normally, an ON is represented by a 1 and an OFF is represented by a 0. So we can say that digital 
computers process information, which is based on the presence or the absence of an electrical charge or we prefer to 
say a binary 1 or 0. A digital computer can be used to process numeric as well as non-numeric data. It can perform 
arithmetic operations like addition, subtraction, multiplication and division and also logical operations. Most of the 
computers available today are digital computers. The most common examples of digital computers are accounting 
machines and calculators. The results of digital computers are more accurate than the results of analog computers. 
Analog computers are faster than digital. Analog computers lack memory whereas digital computers store information. 
We can say that digital computers count and analog computers measures. 

 
Hybrid Computers:- A hybrid is a combination of digital and analog computers. It combines the best features of 

both types of computers, i-e. It has the speed of analog computer and the memory and accuracy of digital computer. 
Hybrid computers are used mainly in specialized applications where both kinds of data need to be processed. 
Therefore, they help the user, to process both continuous and discrete data. For example a petrol pump contains a 
processor that converts fuel flow measurements into quantity and price values. In hospital Intensive Care Unit (ICU), 
an analog device is used which measures patient's blood pressure and temperature etc, which are then converted and 
displayed in the form of digits. Hybrid computers for example are used for scientific calculations, in defense and radar 
systems. 

 
Type of computer according to their Purpose:- There are two types of computers according to their purpose. 

General-Purpose Computers:- Most computers in use today are General-Purpose computers — those built for 
a great variety of processing jobs. Simply by using a general purpose computer and different software, various tasks 
can be accomplished, including writing and editing (word processing), manipulating facts in a data base, tracking 
manufacturing inventory, making scientific calculations, or even controlling organization’s security system, electricity 
consumption, and building temperature. General purpose computers are designed to perform a wide variety of 
functions and operations. You will probably use this type of computer reading this article and I am using a general 
purpose computer typing this article in some software (MS Word). A general purpose computer is able to perform a 
wide variety of operations because it can store and execute different programs in its internal storage. Unfortunately, 
having this ability is often achieved at the expense of speed and efficiency. In most situations, however, you will find 
that having this flexibility makes this compromise a most acceptable one 

 
Special-Purpose Computers:- As the name states, a Special-Purpose Computer are designed to be task specific 

and most of the times their job is to solve one particular problem. They are also known as dedicated computers, 
because they are dedicated to perform a single task over and over again. Such a computer system would be useful in 
playing graphic intensive Video Games, traffic lights control system, navigational system in an aircraft, weather 
forecasting, satellite launch / tracking, oil exploration, and in automotive industries, keeping time in a digital watch, or 
Robot helicopter. While a special purpose computer may have many of the same features found in a general purpose 
computer, its applicability to a particular problem is a function of its design rather than to a stored program. The 
instructions that control it are built directly into the computer, which makes for a more efficient and effective 
operation. They perform only one function and therefore cut down on the amount of memory needed and also the 
amount of information which can be input into them. As these computers have to perform only one task, therefore, 
they are fast in processing. A drawback of this specialization, however, is the computer’s lack of versatility. It cannot 
be used to perform other operations. 

 
Difference between Supercomputer and Mainframe 

Supercomputer is a broad term for one of the fastest computers currently available. Supercomputers are very 
expensive and are employed for specialized applications that require immense amounts of mathematical calculations 
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(number crunching). For example, weather forecasting requires a supercomputer. Other uses of supercomputers 
scientific simulations, (animated) graphics, fluid dynamic calculations, nuclear energy research, electronic design, and 
analysis of geological data (e.g. in petrochemical prospecting). Perhaps the best known supercomputer manufacturer 
is Cray Research. 

Mainframe was a term originally referring to the cabinet containing the central processor unit or "main frame" of 
a room-filling Stone Age batch machine. After the emergence of smaller "minicomputer" designs in the early 1970s, 
the traditional big iron machines were described as "mainframe computers" and eventually just as mainframes. 
Nowadays a Mainframe is a very large and expensive computer capable of supporting hundreds, or even thousands, 
of users simultaneously. The chief difference between a supercomputer and a mainframe is that a supercomputer 
channels all its power into executing a few programs as fast as possible, whereas a mainframe uses its power to execute 
many programs concurrently. In some ways, mainframes are more powerful than supercomputers because they 
support more simultaneous programs. But supercomputers can execute a single program faster than a mainframe. The 
distinction between small mainframes and minicomputers is vague, depending really on how the manufacturer wants 
to market its machines. 

   
Personal computer(PC’s):- 

It can be defined as a small, relatively inexpensive computer designed for an individual user. In price, personal 
computers range anywhere from a few hundred pounds to over five thousand pounds. All are based on the 
microprocessor technology that enables manufacturers to put an entire CPU on one chip. Businesses use personal 
computers for word processing, accounting, desktop publishing, and for running spreadsheet and database 
management applications. At home, the most popular use for personal computers is for playing games and recently 
for surfing the Internet. 

Configuration and specifications of PC’s:-Personal computers first appeared in the late 1970s. One of the first 
and most popular personal computers was the Apple II, introduced in 1977 by Apple Computer. During the late 1970s 
and early 1980s, new models and competing operating systems seemed to appear daily. Then, in 1981, IBM entered 
the fray with its first personal computer, known as the IBM PC. The IBM PC quickly became the personal computer 
of choice, and most other personal computer manufacturers fell by the wayside. P.C. is short for personal computer 
or IBM PC. One of the few companies to survive IBM's onslaught was Apple Computer, which remains a major player 
in the personal computer marketplace. Other companies adjusted to IBM's dominance by building IBM clones, 
computers that were internally almost the same as the IBM PC, but that cost less. Because IBM clones used the same 
microprocessors as IBM PCs, they were capable of running the same software. Over the years, IBM has lost much of 
its influence in directing the evolution of PCs. Therefore after the release of the first PC by IBM the term PC 
increasingly came to mean IBM or IBM-compatible personal computers, to the exclusion of other types of personal 
computers, such as Macintoshes. In recent years, the term PC has become more and more difficult to pin down. In 
general, though, it applies to any personal computer based on an Intel microprocessor, or on an Intel-compatible 
microprocessor. For nearly every other component, including the operating system, there are several options, all of 
which fall under the rubric of PC. 

 
Main Characteristics of PC’s:- Today, the world of personal computers is basically divided between Apple 

Macintoshes and PCs. The principal characteristics of personal computers are that they are single-user systems and 
are based on microprocessors. However, although personal computers are designed as single-user systems, it is 
common to link them together to form a network. In terms of power, there is great variety. At the high end, the 
distinction between personal computers and workstations has faded. High-end models of the Macintosh and PC offer 
the same computing power and graphics capability as low-end workstations by Sun Microsystems, Hewlett-Packard, 
and DEC.  
 
Types of Personal Computer:- 

Actual personal computers can be generally classified by size and chassis / case.  
1. Type of computer according to chassis:- The chassis or case is the metal frame that serves as the structural 

support for electronic components. Every computer system requires at least one chassis to house the circuit boards 
and wiring. The chassis also contains slots for expansion boards. If you want to insert more boards than there are 
slots, you will need an expansion chassis, which provides additional slots. There are two basic flavors of chassis 
designs–desktop models and tower models–but there are many variations on these two basic types.  

 Tower model:- The term refers to a computer in which the power supply, motherboard, and mass storage devices 
are stacked on top of each other in a cabinet. This is in contrast to desktop models, in which these components are 
housed in a more compact box. The main advantage of tower models is that there are fewer space constraints, which 
makes installation of additional storage devices easier.  
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Desktop model:- A computer designed to fit comfortably on top of a desk, typically with the monitor sitting on 
top of the computer. Desktop model computers are broad and low, whereas tower model computers are narrow and 
tall. Because of their shape, desktop model computers are generally limited to three internal mass storage devices. 
Desktop models designed to be very small are sometimes referred to as slim line models. 

 
2. Type of computer according to size:- Then come the portable computers that are computers small enough 

to carry. Portable computers include notebook and subnotebook computers, hand-held computers, palmtops, and 
PDAs. 

Notebook computer:-An extremely lightweight personal computer. Notebook computers typically weigh less 
than 6 pounds and are small enough to fit easily in a briefcase. Aside from size, the principal difference between a 
notebook computer and a personal computer is the display screen. Notebook computers use a variety of techniques, 
known as flat-panel technologies, to produce a lightweight and non-bulky display screen. The quality of notebook 
display screens varies considerably. In terms of computing power, modern notebook computers are nearly equivalent 
to personal computers. They have the same CPUs, memory capacity, and disk drives. However, all this power in a 
small package is expensive. Notebook computers cost about twice as much as equivalent regular-sized computers. 
Notebook computers come with battery packs that enable you to run them without plugging them in. However, the 
batteries need to be recharged every few hours. 

Laptop computer:- A small, portable computer -- small enough that it can sit on your lap. Nowadays, laptop 
computers are more frequently called notebook computers. 

Subnotebook computer:- A portable computer that is slightly lighter and smaller than a full-sized notebook 
computer. Typically, subnotebook computers have a smaller keyboard and screen, but are otherwise equivalent to 
notebook computers. 

Hand-held computer:- A portable computer that is small enough to be held in one’s hand. Although extremely 
convenient to carry, handheld computers have not replaced notebook computers because of their small keyboards and 
screens. The most popular hand-held computers are those that are specifically designed to provide PIM (personal 
information manager) functions, such as a calendar and address book. Some manufacturers are trying to solve the 
small keyboard problem by replacing the keyboard with an electronic pen. However, these pen-based devices rely on 
handwriting recognition technologies, which are still in their infancy. Hand-held computers are also called PDAs, 
palmtops and pocket computers. 

Palmtop:- A small computer that literally fits in your palm. Compared to full-size computers, palmtops are severely 
limited, but they are practical for certain functions such as phone books and calendars. Palmtops that use a pen rather 
than a keyboard for input are often called hand-held computers or PDAs. Because of their small size, most palmtop 
computers do not include disk drives. However, many contain PCMCIA slots in which you can insert disk drives, 
modems, memory, and other devices. Palmtops are also called PDAs, hand-held computers and pocket computers. 

PDA:-  Short for personal digital assistant, a handheld device that combines computing, telephone/fax, and 
networking features. A typical PDA can function as a cellular phone, fax sender, and personal organizer. Unlike 
portable computers, most PDAs are pen-based, using a stylus rather than a keyboard for input. This means that they 
also incorporate handwriting recognition features. Some PDAs can also react to voice input by using voice recognition 
technologies. The field of PDA was pioneered by Apple Computer, which introduced the Newton MessagePad in 
1993. Shortly thereafter, several other manufacturers offered similar products. To date, PDAs have had only modest 
success in the marketplace, due to their high price tags and limited applications. However, many experts believe that 
PDAs will eventually become common gadgets. PDAs are also called palmtops, hand-held computers and pocket 
computers. 

Workstation:- A powerful, single-user computer. A workstation is like a personal computer, but it has a more 
powerful microprocessor and, in general, a higher-quality monitor. It is a type of computer used for engineering 
applications (CAD/CAM), desktop publishing, software development, and other types of applications that require a 
moderate amount of computing power and relatively high quality graphics capabilities. Workstations generally come 
with a large, high-resolution graphics screen, at large amount of RAM, built-in network support, and a graphical user 
interface. Most workstations also have a mass storage device such as a disk drive, but a special type of workstation, 
called a diskless workstation, comes without a disk drive. The most common operating systems for workstations are 
UNIX and Windows NT. Like personal computers, most workstations are single-user computers. However, 
workstations are typically linked together to form a local-area network, although they can also be used as stand-alone 
systems. In networking, workstation refers to any computer connected to a local-area network. It could be a 
workstation or a personal computer.  
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Abstract 
This chapter presents a comprehensive overview of computer software, operating systems, and programming language 
concepts, forming a critical foundation for understanding modern computing systems. It begins with the definition 
and classification of software into system software and application software, highlighting their roles in managing 
hardware and supporting user-oriented tasks. Various types of application software, such as word processing, database 
management, spreadsheet, presentation, and multimedia tools, are discussed with practical examples. 
The chapter further explores the concept of open-source software, emphasizing its collaborative development model 
and contrast with proprietary software. A detailed explanation of operating systems is provided, including their 
functions, user interfaces, and examples such as MS-DOS, Windows, Linux, and UNIX. The evolution and features 
of these operating systems are also examined. 
Additionally, the chapter introduces fundamental programming concepts, including algorithms, variables, data types, 
loops, functions, and object-oriented principles. It also explains the classification of programming languages into low-
level and high-level languages, along with their advantages, limitations, and real-world applications. Furthermore, the 
chapter covers language translators such as assemblers, compilers, and interpreters, explaining their roles in converting 
source code into executable programs. Overall, this chapter provides a structured understanding of software systems 
and their significance in computer science. 
 
Keywords: Software, System Software, Application Software, Open Source Software, Operating System, MS-DOS, 
Windows, Linux, Programming Concepts, Algorithms, Compiler, Interpreter, Assembler, Programming Languages, 
High-Level Languages, Low-Level Languages 

 
Software:- Computer software is the set of programs that makes the hardware perform a set of tasks in particular 
order. Hardware and software are complimentary to each other. Both have to work together to produce meaningful 
results. 

 
Types of software:- Computer software is classified into two broad categories; system software and application 
software. 

1.System Software:- System software consists of a group of programs that control the operations of a computer 
equipment including functions like managing memory, managing peripherals, loading, storing, and is an interface 
between the application programs and the computer. MS DOS (Microsoft’s Disk Operating System), UNIX are 
examples of system software. 

2. Application software:- Software that can perform a specific task for the user, such as word processing, 
accounting, budgeting or payroll, fall under the category of application software. Word processors, spreadsheets, 
database management systems are all examples of general purpose application software. 
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Types of application software are:- 
1. Word processing software: The main purpose of this software is to produce documents. MS-Word, Word Pad, 

Notepad and some other text editors are some of the examples of word processing software. 
2.Database software: Database is a collection of related data. The purpose of this software is to organize and 

manage data. The advantage of this software is that you can change the way data is stored and displayed. MS access, 
dBase, FoxPro, Paradox, and Oracle are some of the examples of database software. 

3. Spread sheet software: The spread sheet software is used to maintain budget, financial statements, grade sheets, 
and sales records. The purpose of this software is organizing numbers. It also allows the users to perform simple or 
complex calculations on the numbers entered in rows and columns. MS-Excel is one of the examples of spreadsheet 
software. 

4.Presentation software: This software is used to display the information in the form of slide show. The three 
main functions of presentation software is editing that allows insertion and formatting of text, including graphics in 
the text and executing the slide shows. The best example 

for this type of application software is Microsoft PowerPoint. 
5.Multimedia software: Media players and real players are the examples of multimedia software. This software 

will allow the user to create audio and videos. The different forms of multimedia software are audio converters, players, 
burners, video encoders and decoders. 

6. Open source software:- Open source refers to a program or software in which the source code (the form of 
the program when a programmer writes a program in a particular programming language) is available to the general 
public for use and/or modification from its original design free of charge. Open source code is typically created as a 
collaborative effort in which programmers improve upon the code and share the changes within the community. The 
rationale for this movement is that a larger group of programmers not concerned with proprietary ownership or 
financial gain will produce a more useful and bug-free product for everyone to use. 

The basics behind the Open Source Initiative is that when programmers can read, redistribute and modify the 
source code for a piece of software, the software evolves. Open source sprouted in the technological community as a 
response to proprietary software owned by corporations. Proprietary software is privately owned and controlled. In 
the computer industry, proprietary is considered the opposite of open. A proprietary design or technique is one that 
is owned by a company. It also implies that the company has not divulged specifications that would allow other 
companies to duplicate the product 

 
OERATING SYSTEM :- An operating system is a software component of a computer system that is responsible 
for the management of various activities of the computer and the sharing of computer resources. It hosts several 
applications that run on a computer and handles the operations of computer hardware. Users and application programs 
access the services offered by the operating systems, by means of system calls and application programming interfaces. 
Users interact with a computer operating system through Command Line Interfaces (CLIs) or Graphical User 
Interfaces known as GUIs. In short, an operating system enables user interaction with computer systems by acting as 
an interface between users or application programs and the computer hardware. Some of the common operating 
systems are LINUX, Windows, DOS etc. 

1.Introduction to MS-DOS:- An operating system is a set of interrelated programs that manage and control 
computer processing. The Microsoft Disk Operating System, MS-DOS, is a traditional microcomputer operating 
system that consists of four major components.:-  

• MS-DOS Kernel, 

• User Interface (shell), 

• MS-DOS BIOS,  

• Operating-system loader 
Short for Microsoft Disk Operating System, MS-DOS is a non-graphical command line operating system derived 

from 86-DOS that was created for IBM compatible computers. MS-DOS originally written by Tim Paterson and 
introduced by Microsoft in August 1981 and was last updated in 1994 when MS-DOS 6.22 was released. MS-DOS 
allows the user to navigate, open, and otherwise manipulate files on their computer from a command line instead of a 
GUI like Windows. 

Today, MS-DOS is no longer used; however, the command shell, more commonly known as the Windows 
command line is still used by many users. The picture to the right, is an example of what an MS-DOS window more 
appropriately referred to as the Windows command line looks like running under Microsoft Windows. 

Most computer users are only familiar with how to navigate Microsoft Windows using the mouse. Unlike Windows, 
MS-DOS is a command-line and is navigated by using MS-DOS commands. For example, if you wanted to see all the 
files in a folder in Windows you would double-click the folder to open the folder in Windows Explorer. In MS-DOS, 
to view that same folder you would navigate to the folder using the cd command and then list the files in that folder 
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using the dir command. 
 
2.Introduction to Windows :-Microsoft Windows is a series of operating systems and environments developed 

and marketed by Microsoft Corporation. The first version of Windows was released in 1985 as a graphical user 
interface to MS-DOS, providing multiple document support, mouse support, drop down menus, and color video 
drivers. Later versions gradually replaced many of MS-DOS's built-in hardware functions with their own enhanced 
functions, until Windows fully assimilated MS-DOS and became a full-fledged operating system. Microsoft Windows 
is now often referred to as an integrated operating system due to the high level of integration between the core kernel 
functions and other Microsoft software such as Outlook, Windows Explorer and Internet Explorer. Despite it's poor 
security record caused by this integration, Microsoft Windows is today the most widely used OS on personal home 
computers, laptop computers, and small business machines.  

As an integrated operating system, all Microsoft Windows versions come with preinstalled software that is ready 
to use upon installation. Basic text editors and calculators have been available since the first versions of Windows. 
Windows 98 added Media Player, Internet Explorer and Outlook Express. Windows Vista expands this with the 
Windows Mobility Center, Photo Gallery, DVD Maker, and the Linux-like Windows Sidebar. Vista is also the first 
version of Windows to have built-in security features. Although the second Windows XP service pack added a firewall 
and anti-virus monitoring service, Vista implements these features and more at the kernel level. Individual programs 
are 'sandboxed' and cannot access each other's memory. Critical drivers are executed in user mode, so crashes and 
malicious behavior cannot cause system-wide instability or security breaches. Even third-party anti-virus and anti-
spyware software runs outside the kernel, further protecting it from bugs and backdoors in those programs. 

 
3.Introduction to Linux:- Two of the most popular variations of UNIX come in the form of Linux. A big 

advantage of both Linux is that they are both open-source, that is, any user can contribute to the development of the 
OS. Versions of both operating systems are completely free. 

Linux can easily take the role of a server or client machine. However, they are considered to be more difficult to 
master as both utilize the command line rather than a user friendly GUI. There are several different distributions of 
Linux, but for each the underlying operating system remains the same. Apple Macintosh machines offer high 
performance sound and graphics editing and are therefore extremely popular in the design industry. Apple have 
developed their own operating system, the newest version of which is the Mac OS X, which is based on UNIX. Mac 
OS X is a very user friendly operating system and is increasingly popular for home PCs. 

 
4.Other Operating Systems:-  
UNIX:-A big advantage of UNIX is that it can be run on nearly every computer hardware platform including 

Apple Macintosh machines. The UNIX operating system is one of the oldest and most powerful operating systems. 
It was developed by Bell Laboratories. There are many variants of UNIX available. 

Novell NetWare:-Novell NetWare is an advanced network operating system. It has an advanced directory service 
structure similar to Microsoft’s Active Directory. Fortunately both directory services are interoperable as both 
directories use the x500 directory service standard. 

 
Computer programming concepts:- Following concepts are present in the majority of computer programming 
languages and/or are a fundamental part of the programming process.  

• Algorithm:- A set of steps for carrying out a specific task. Algorithms are used extensively in computer 
programming to arrive at a solution for a problem. The process of creating an algorithm involves 
documenting all the necessary steps needed to arrive at the solution and how to perform each step. A real 
world example of an algorithm would be a recipe. The instructions of a typical recipe (add ingredients, 
mix, stir, etc.) are an algorithm.  

• Source code:- The actual text used to write the instructions for a computer program. This text is then 
translated into something meaningful the computer can understand.  

• Compiler :- A software tool that translates source code into data that the computer can understand. 
Specifically, a compiler is used to turn source code into object code. The object code is then passed through 
a program called a linker which turns it into an executable program.  

• Data type :- The classification of pieces of information in a program. The amount of different data types 
varies between languages. Typically, there are data types for integers (whole numbers), floating-point 
numbers (numbers with a decimal part), and single characters. To distinguish between different data types, 
a computer uses special internal codes.  

• Variable :- A container which represents a value in a program. Variables can store different types of data 
including numeric values, single characters, and text strings. The value of a variable can change all 
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throughout a program.  

• Constant:- The same thing as a variable with one major difference - the value of a constant does not 
change, while the value of a variable can change all throughout a program.  

• Conditional :- A set of code that will execute only if a certain condition is true. Conditionals are used to 
test expressions and perform certain operations accordingly. For example, you could test a number input 
by the user and if it is too high print the message "The number entered is too high" and the program exits. 
Thanks to conditionals, a program can work differently every time it runs.  

• Array :- A special type of variable used in many programming and web languages including PHP, 
JavaScript, and Java that contains a list of related values. For example, a colors array would contain a list 
of colors.  

• Loop:- A segment of code that executes repeatedly based on a certain condition. Loops are used to 
perform tasks repeatedly a certain amount of times. For example, if you needed to print the numbers 1 to 
10. You can use a loop for this task instead of manually printing all the numbers.  

• Function :- A set of code used to carry out specific tasks. A function can take parameters which will affect 
its output as well as return values. Functions prevent unnecessary redundancy because you can use them 
as much as needed instead of retyping some code over and over. For example, if you need to multiply two 
numbers, instead of doing the calculation manually every time, you can supply the data to a function 
through some parameters which will do it for you.  

• Class :- A template for a real world object to be used in a program. For example, a programmer can create 
a car class which represents a car. This class can contain the properties of a car (color, model, year, etc.) 
and functions that specify what the car does (drive, reverse, stop, etc.). Classes are used in object-oriented 
programming.  

 
Two Basic Types of Computer Language:- Different kinds of languages have been developed to perform different 
types of work on the computer. Basically, languages can be divided into two categories according to how the computer 
understands them. 

• Low-Level Languages: A language that corresponds directly to a specific machine 

• High-Level Languages: Any language that is independent of the machine 

• There are also other types of languages, which include 

• System languages: These are designed for low-level tasks, like memory and process management 

• Scripting languages: These tend to be high-level and very powerful 

• Domain-specific languages: These are only used in very specific contexts 

• Visual languages: Languages that are not text-based 

• Esoteric languages: Languages that are jokes or are not intended for serious use 
These languages are not mutually exclusive, and some languages can belong to multiple categories. The terms low-

level and high-level are also open to interpretation, and some languages that were once considered high-level are now 
considered low-level as languages have continued to develop. 

 
Computer language or programming language is a coded syntax used by computer programmers to communicate 

with a computer. Computer language establishes a flow of communication between software programs. The language 
enables a computer user to dictate what commands the computer must perform to process data. These languages can 
be classified into following categories. 

• Machine language 

• Assembly language 

• High level language 
 
Low-Level Languages: 

Low-level computer languages are either machine codes or are very close them. A computer cannot understand 
instructions given to it in high-level languages or in English. It can only understand and execute instructions given in 
the form of machine language i.e. binary. There are two types of low-level languages: 

 
Machine Language: a language that is directly interpreted into the hardware. Machine language or machine code 

is the native language directly understood by the computer’s central processing unit or CPU. This type of computer 
language is not easy to understand, as it only uses a binary system, an element of notations containing only a series of 
numbers consisting of one and zero, to produce commands. 
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Machine language is the lowest and most elementary level of programming language and was the first type of 
programming language to be developed. Machine language is basically the only language that a computer can 
understand and it is usually written in hex. 

In fact, a manufacturer designs a computer to obey just one language, its machine code, which is represented inside 
the computer by a string of binary digits (bits) 0 and 1. The symbol 0 stands for the absence of an electric pulse and 
the 1 stands for the presence of an electric pulse. Since a computer is capable of recognizing electric signals, it 
understands machine language. 

 

Advantages Disadvantages 

Machine language makes fast and efficient use of the 
computer. 

All operation codes have to be remembered 

It requires no translator to translate the code. It is 
directly understood by the computer. 

All memory addresses have to be remembered. 

  
It is hard to amend or find errors in a program 

written in the machine language. 

 
Assembly Language: Its a slightly more user-friendly language that directly corresponds to machine language 

Assembly Level Language is a set of codes that can run directly on the computer’s processor. This type of language is 
most appropriate in writing operating systems and maintaining desktop applications. With the assembly level language, 
it is easier for a programmer to define commands. It is easier to understand and use as compared to machine language. 

 
Assembly language was developed to overcome some of the many inconveniences of machine language. This is 

another low-level but very important language in which operation codes and operands are given in the form of 
alphanumeric symbols instead of 0’s and l’s. 

 
These alphanumeric symbols are known as mnemonic codes and can combine in a maximum of five-letter 

combinations e.g. ADD for addition, SUB for subtraction, START, LABEL etc. Because of this feature, assembly 
language is also known as ‘Symbolic Programming Language.' 

 
This language is also very difficult and needs a lot of practice to master it because there is only a little English 

support in this language. Mostly assembly language is used to help in compiler orientations. The instructions of the 
assembly language are converted to machine codes by a language translator and then they are executed by the 
computer. 

 

Advantages Disadvantages 

Assembly language is easier to understand and use as 
compared to machine language.  

Like machine language, it is also machine 
dependent/specific. 

It is easy to locate and correct errors. 
Since it is machine dependent, the programmer also 

needs to understand the hardware. 

It is easily modified.   

 
High-Level Languages:  

 
High Level Languages are user-friendly languages which are similar to English with vocabulary of words and 

symbols. These are easier to learn and require less time to write. They are problem oriented rather than ‘machine’ 
based. Program written in a high-level language can be translated into many machine languages and therefore can run 
on any computer for which there exists an appropriate translator. 
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High-level computer languages use formats that are similar to English. The purpose of developing high-level 

languages was to enable people to write programs easily, in their own native language environment (English). 
High-level languages are basically symbolic languages that use English words and/or mathematical symbols rather 

than mnemonic codes. Each instruction in the high-level language is translated into many machine language 
instructions that the computer can understand. 

 
 

Advantages Disadvantages 

High-level languages are user-friendly 
A high-level language has to be translated into 

the machine language by a translator, which takes 
up time 

They are similar to English and use English vocabulary and 
well-known symbols 

The object code generated by a translator might 
be inefficient compared to an equivalent assembly 
language program 

They are easier to learn   

They are easier to maintain   

They are problem-oriented rather than 'machine'-based   

A program written in a high-level language can be translated 
into many machine languages and can run on any computer for 
which there exists an appropriate translator 

  

The language is independent of the machine on which it is 
used i.e. programs developed in a high-level language can be run 
on any computer text 

  

 
Types of High-Level Languages 

Many languages have been developed for achieving a variety of different tasks. Some are fairly specialized, and 
others are quite general. 

These languages, categorized according to their use, are:  
1) Algebraic Formula-Type Processing 
These languages are oriented towards the computational procedures for solving mathematical and statistical 

problems.  
Examples include: 

• BASIC (Beginners All Purpose Symbolic Instruction Code) 

• FORTRAN (Formula Translation) 

• PL/I (Programming Language, Version 1) 

• ALGOL (Algorithmic Language) 

• APL (A Programming Language) 
 
2. Business Data Processing 
These languages are best able to maintain data processing procedures and problems involved in handling files. 

Some examples include: 
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• COBOL (Common Business Oriented Language) 

• RPG (Report Program Generator) 
 
3. String and List Processing 
These are used for string manipulation, including search patterns and inserting and deleting characters. Examples 

are: 

• LISP (List Processing) 

• Prolog (Program in Logic) 

• Object-Oriented Programming Language 

• In OOP, the computer program is divided into objects. Examples are: 

• C++ 

• Java 
 
5. Visual Programming Language 
These programming languages are designed for building Windows-based applications. Examples are: 

• Visual Basic 

• Visual Java 

• Visual C  
 
Some of the High level languages are as followes:- 
    FORTRAN:- The first important algorithmic language was FORTRAN (formula translation), designed in 1957 

by an IBM team led by John Backus. It was intended for scientific  computations with real numbers and collections 
of them organized as one- or multidimensional arrays. Its control structures included conditional IF statements, 
repetitive loops (so-called DO loops), and a GOTO statement that allowed non sequential execution of program code. 
FORTRAN made it convenient to have subprograms for common mathematical operations, and built libraries of 
them. FORTRAN was also designed to translate into efficient machine language. It was immediately successful and 
continues to evolve. 

ALGOL:- ALGOL (algorithmic language) was designed by a committee of American and European computer 
scientists during 1958–60 for publishing algorithms, as well as for doing computations. ALGOL had recursive 
subprograms—procedures that could invoke themselves to solve a problem by reducing it to a smaller problem of the 
same kind. ALGOL introduced block structure, in which a program is composed of blocks that might contain both 
data and instructions and have the same structure as an entire program. Block structure became a powerful tool for 
building large programs out of small components. 

ALGOL contributed a notation for describing the structure of a programming language, Backus–Naur Form, 
which in some variation became the standard tool for stating the syntax (grammar) of programming languages. 
ALGOL was widely used in Europe, and for many years it remained the language in which computer algorithms were 
published. Many important languages, such as Pascal and Ada, are its descendants. 

LISP:- LISP (list processing) was developed about 1960 by John McCarthy at the Massachusetts Institute of 
Technology (MIT) and was founded on the mathematical theory of recursive functions (in which a function appears 
in its own definition). A LISP program is a function applied to data, rather than being a sequence of procedural steps 
as in FORTRAN and ALGOL. LISP uses a very simple notation in which operations and their operands are given in 
a parenthesized list. For example, (+ a (* b c)) stands for a + b*c. Although this appears awkward, the notation works 
well for computers. LISP also uses the list structure to represent data, and, because programs and data use the same 
structure, it is easy for a LISP program to operate on other programs as data. LISP became a common language for 
artificial intelligence (AI) programming, partly owing to the confluence of LISP and AI work at MIT and partly because 
AI programs capable of “learning” could be written in LISP as self-modifying programs. LISP has evolved through 
numerous dialects, such as Scheme and Common LISP. 

C Language:- The C programming language was developed in 1972 by Dennis Ritchie and Brian Kernighan at 
the AT&T Corporation for programming computer operating systems. Its capacity to structure data and programs 
through the composition of smaller units is comparable to that of ALGOL. It uses a compact notation and provides 
the programmer with the ability to operate with the addresses of data as well as with their values. This ability is 
important in systems programming, and C shares with assembly language the power to exploit all the features of a 
computer’s internal architecture. C, along with its descendant C++, remains one of the most common languages. 
 
Business-oriented languages 

COBOL:-COBOL (common business oriented language) has been heavily used by businesses since its inception 
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in 1959. A committee of computer manufacturers and users and U.S. government organizations established 
CODASYL (Committee on Data Systems and Languages) to develop and oversee the language standard in order to 
ensure its portability across diverse systems. COBOL uses an English-like notation—novel when introduced. Business 
computations organize and manipulate large quantities of data, and COBOL introduced the record data structure for 
such tasks. A record clusters heterogeneous data such as a name, ID number, age, and address into a single unit. This 
contrasts with scientific languages, in which homogeneous arrays of numbers are common. Records are an important 
example of “chunking” data into a single object, and they appear in nearly all modern languages. 

SQL:- SQL (structured query language) is a language for specifying the organization of databases (collections of 
records). Databases organized with SQL are called relational because SQL provides the ability to query a database for 
information that falls in a given relation. For example, a query might be “find all records with both last_name Smith 
and city New York.” Commercial database programs commonly use a SQL-like language for their queries. 
 
Education-oriented languages 

BASIC:- BASIC (beginner’s all-purpose symbolic instruction code) was designed at Dartmouth College in the 
mid-1960s by John Kemeny and Thomas Kurtz. It was intended to be easy to learn by novices, particularly non-
computer science majors, and to run well on a time-sharing computer with many users. It had simple data structures 
and notation and it was interpreted: a BASIC program was translated line-by-line and executed as it was translated, 
which made it easy to locate programming errors. Its small size and simplicity also made BASIC a popular language 
for early personal computers. Its recent forms have adopted many of the data and control structures of other 
contemporary languages, which makes it more powerful but less convenient for beginners. 

Pascal:- About 1970 Niklaus Wirth of Switzerland designed Pascal to teach structured programming, which 
emphasized the orderly use of conditional and loop control structures without GOTO statements. Although Pascal 
resembled ALGOL in notation, it provided the ability to define data types with which to organize complex 
information, a feature beyond the capabilities of ALGOL as well as FORTRAN and COBOL. User-defined data types 
allowed the programmer to introduce names for complex data, which the language translator could then check for 
correct usage before running a program. During the late 1970s and ’80s, Pascal was one of the most widely used 
languages for programming instruction. It was available on nearly all computers, and, because of its familiarity, clarity, 
and security, it was used for production software as well as for education. 

Logo:- Logo originated in the late 1960s as a simplified LISP dialect for education; Seymour Papert and others 
used it at MIT to teach mathematical thinking to schoolchildren. It had a more conventional syntax than LISP and 
featured “turtle graphics,” a simple method for generating computer graphics. (The name came from an early project 
to program a turtle like robot.) Turtle graphics used body-centered instructions, in which an object was moved around 
a screen by commands, such as “left 90” and “forward,” that specified actions relative to the current position and 
orientation of the object rather than in terms of a fixed framework. Together with recursive routines, this technique 
made it easy to program intricate and attractive patterns. 

Hypertalk:- Hypertalk was designed as “programming for the rest of us” by Bill Atkinson for Apple’s Macintosh. 
Using a simple English-like syntax, Hypertalk enabled anyone to combine text, graphics, and audio quickly into “linked 
stacks” that could be navigated by clicking with a mouse on standard buttons supplied by the program. Hypertalk was 
particularly popular among educators in the 1980s and early ’90s for classroom multimedia presentations. Although 
Hypertalk had many features of object-oriented languages (described in the next section), Apple did not develop it for 
other computer platforms and let it languish; as Apple’s market share declined in the 1990s, a new cross-platform way 
of displaying multimedia left Hypertalk all but obsolete (see the section World Wide Web display languages). 
 
Object-oriented languages:-  
Object-oriented languages help to manage complexity in large programs. Objects package data and the operations on 
them so that only the operations are publicly accessible and internal details of the data structures are hidden. This 
information hiding made large-scale programming easier by allowing a programmer to think about each part of the 
program in isolation. In addition, objects may be derived from more general ones, “inheriting” their capabilities. Such 
an object hierarchy made it possible to define specialized objects without repeating all that is in the more general ones. 
Object-oriented programming began with the Simula language (1967), which added information hiding to ALGOL. 
Another influential object-oriented language was Smalltalk (1980), in which a program was a set of objects that 
interacted by sending messages to one another. 

C++:- The C++ language, developed by Bjarne Stroustrup at AT&T in the mid-1980s, extended C by adding 
objects to it while preserving the efficiency of C programs. It has been one of the most important languages for both 
education and industrial programming. Large parts of many operating systems, such as the Microsoft Corporation’s 
Windows 98, were written in C++. 

Ada:- Ada was named for Augusta Ada King, countess of Lovelace, who was an assistant to the 19th-century 
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English inventor Charles Babbage, and is sometimes called the first computer programmer. Ada, the language, was 
developed in the early 1980s for the U.S. Department of Defense for large-scale programming. It combined Pascal-
like notation with the ability to package operations and data into independent modules. Its first form, Ada 83, was not 
fully object-oriented, but the subsequent Ada 95 provided objects and the ability to construct hierarchies of them. 
While no longer mandated for use in work for the Department of Defense, Ada remains an effective language for 
engineering large programs. 

Java:- In the early 1990s, Java was designed by Sun Microsystems, Inc., as a programming language for the World 
Wide Web (WWW). Although it resembled C++ in appearance, it was fully object-oriented. In particular, Java 
dispensed with lower-level features, including the ability to manipulate data addresses, a capability that is neither 
desirable nor useful in programs for distributed systems. In order to be portable, Java programs are translated by a 
Java Virtual Machine specific to each computer platform, which then executes the Java program. In addition to adding 
interactive capabilities to the Internet through Web “applets,” Java has been widely used for programming small and 
portable devices, such as mobile telephones. 

Visual Basic:- Visual Basic was developed by Microsoft to extend the capabilities of BASIC by adding objects 
and “event-driven” programming: buttons, menus, and other elements of graphical user interfaces (GUIs). Visual 
Basic can also be used within other Microsoft software to program small routines. 

 
Declarative languages:-  
Declarative languages, also called nonprocedural or very high level, are programming languages in which (ideally) a 
program specifies what is to be done rather than how to do it. In such languages there is less difference between the 
specification of a program and its implementation than in the procedural languages described so far. The two common 
kinds of declarative languages are logic and functional languages. 

Logic programming languages, of which PROLOG (programming in logic) is the best known, state a program as 
a set of logical relations (e.g., a grandparent is the parent of a parent of someone). Such languages are similar to the 
SQL database language. A program is executed by an “inference engine” that answers a query by searching these 
relations systematically to make inferences that will answer a query. PROLOG has been used extensively in natural 
language processing and other AI programs. 

Functional languages have a mathematical style. A functional program is constructed by applying functions to 
arguments. Functional languages, such as LISP, ML, and Haskell, are used as research tools in language development, 
in automated mathematical theorem provers, and in some commercial projects. 
 
Scripting languages:-  
Scripting languages are sometimes called little languages. They are intended to solve relatively small programming 
problems that do not require the overhead of data declarations and other features needed to make large programs 
manageable. Scripting languages are used for writing operating system utilities, for special-purpose file-manipulation 
programs, and, because they are easy to learn, sometimes for considerably larger programs. 

PERL (practical extraction and report language) was developed in the late 1980s, originally for use with the UNIX 
operating system. It was intended to have all the capabilities of earlier scripting languages. PERL provided many ways 
to state common operations and thereby allowed a programmer to adopt any convenient style. In the 1990s it became 
popular as a system-programming tool, both for small utility programs and for prototypes of larger ones. Together 
with other languages discussed below, it also became popular for programming computer Web “servers.” 
 
Document formatting languages:-  
Document formatting languages specify the organization of printed text and graphics. They fall into several classes: 
text formatting notation that can serve the same functions as a word processing program, page description languages 
that are interpreted by a printing device, and, most generally, markup languages that describe the intended function of 
portions of a document. 

TeX:- TeX was developed during 1977–86 as a text formatting language by Donald Knuth, a Stanford University 
professor, to improve the quality of mathematical notation in his books. Text formatting systems, unlike WYSIWYG 
(“What You See Is What You Get”) word processors, embed plain text formatting commands in a document, which 
are then interpreted by the language processor to produce a formatted document for display or printing. TeX marks 
italic text, for example, as {\it this is italicized}, which is then displayed as this is italicized. 

TeX largely replaced earlier text formatting languages. Its powerful and flexible abilities gave an expert precise 
control over such things as the choice of fonts, layout of tables, mathematical notation, and the inclusion of graphics 
within a document. It is generally used with the aid of “macro” packages that define simple commands for common 
operations, such as starting a new paragraph; LaTeX is a widely used package. TeX contains numerous standards “style 
sheets” for different types of documents, and these may be further adapted by each user. There are also related 
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programs such as BibTeX, which manages bibliographies and has style sheets for all of the common bibliography 
styles, and versions of TeX for languages with various alphabets. 

PostScript:- PostScript is a page-description language developed in the early 1980s by Adobe Systems 
Incorporated on the basis of work at Xerox PARC (Palo Alto Research Center). Such languages describe documents 
in terms that can be interpreted by a personal computer to display the document on its screen or by a microprocessor 
in a printer or a typesetting device. PostScript commands can, for example, precisely position text, in various fonts 
and sizes, draw images that are mathematically described, and specify colour or shading. PostScript uses postfix, also 
called reverse Polish notation, in which an operation name follows its arguments. Thus, “300 600 20 270 arc stroke” 
means: draw (“stroke”) a 270-degree arc with radius 20 at location (300, 600). Although PostScript can be read and 
written by a programmer, it is normally produced by text formatting programs, word processors, or graphic display 
tools. The success of PostScript is due to its specification’s being in the public domain and to its being a good match 
for high-resolution laser printers. It has influenced the development of printing fonts, and manufacturers produce a 
large variety of PostScript fonts. 

SGML:- SGML (standard generalized markup language) is an international standard for the definition of markup 
languages; that is, it is a meta language. Markup consists of notations called tags that specify the function of a piece of 
text or how it is to be displayed. SGML emphasizes descriptive markup, in which a tag might be “<emphasis>.” Such 
a markup denotes the document function, and it could be interpreted as reverse video on a computer screen, 
underlining by a typewriter, or italics in typeset text. SGML is used to specify DTDs (document type definitions). A 
DTD defines a kind of document, such as a report, by specifying what elements must appear in the document—e.g., 
<Title>—and giving rules for the use of document elements, such as that a paragraph may appear within a table entry 
but a table may not appear within a paragraph. A marked-up text may be analyzed by a parsing program to determine 
if it conforms to a DTD. Another program may read the markups to prepare an index or to translate the document 
into PostScript for printing. Yet another might generate large type or audio for readers with visual or hearing 
disabilities. 

 
World Wide Web display languages: 

HTML:- The World Wide Web is a system for displaying text, graphics, and audio retrieved over the Internet on 
a computer monitor. Each retrieval unit is known as a Web page, and such pages frequently contain “links” that allow 
related pages to be retrieved. HTML (hypertext markup language) is the markup language for encoding Web pages. It 
was designed by Tim Berners-Lee at the CERN nuclear physics laboratory in Switzerland during the 1980s and is 
defined by an SGML DTD. HTML markup tags specify document elements such as headings, paragraphs, and tables. 
They mark up a document for display by a computer program known as a Web browser. The browser interprets the 
tags, displaying the headings, paragraphs, and tables in a layout that is adapted to the screen size and fonts available to 
it. 

HTML documents also contain anchors, which are tags that specify links to other Web pages. An anchor has the 
form <A HREF= “http://www.britannica.com”> Encyclopedia Britannica</A>, where the quoted string is the URL 
(universal resource locator) to which the link points (the Web “address”) and the text following it is what appears in a 
Web browser, underlined to show that it is a link to another page. What is displayed as a single page may also be 
formed from multiple URLs, some containing text and others graphics. 

XML:- HTML does not allow one to define new text elements; that is, it is not extensible. XML (extensible markup 
language) is a simplified form of SGML intended for documents that are published on the Web. Like SGML, XML 
uses DTDs to define document types and the meanings of tags used in them. XML adopts conventions that make it 
easy to parse, such as that document entities are marked by both a beginning and an ending tag, such as 
<BEGIN>…</BEGIN>. XML provides more kinds of hypertext links than HTML, such as bidirectional links and 
links relative to a document subsection. Because an author may define new tags, an XML DTD must also contain 
rules that instruct a Web browser how to interpret them—how an entity is to be displayed or how it is to generate an 
action such as preparing an e-mail message. 

Web scripting:- Web pages marked up with HTML or XML are largely static documents. Web scripting can add 
information to a page as a reader uses it or let the reader enter information that may, for example, be passed on to the 
order department of an online business. CGI (common gateway interface) provides one mechanism; it transmits 
requests and responses between the reader’s Web browser and the Web server that provides the page. The CGI 
component on the server contains small programs called scripts that take information from the browser system or 
provide it for display. A simple script might ask the reader’s name; determine the Internet address of the system that 
the reader uses, and print a greeting. Scripts may be written in any programming language, but, because they are 
generally simple text-processing routines, scripting languages like PERL are particularly appropriate. 

Another approach is to use a language designed for Web scripts to be executed by the browser. JavaScript is one 
such language, designed by the Netscape Communications Corp., which may be used with both Netscape’s and 
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Microsoft’s browsers. JavaScript is a simple language, quite different from Java. A JavaScript program may be 
embedded in a Web page with the HTML tag <script language=“JavaScript”>. JavaScript instructions following that 
tag will be executed by the browser when the page is selected. In order to speed up display of dynamic (interactive) 
pages, JavaScript is often combined with XML or some other language for exchanging information between the server 
and the client’s browser. In particular, the XMLHttpRequest command enables asynchronous data requests from the 
server without requiring the server to resend the entire Web page. This approach, or “philosophy,” of programming 
is called Ajax (asynchronous JavaScript and XML). 

VB Script is a subset of Visual Basic. Originally developed for Microsoft’s Office suite of programs, it was later 
used for Web scripting as well. Its capabilities are similar to those of JavaScript, and it may be embedded in HTML in 
the same fashion. 

Behind the use of such scripting languages for Web programming lies the idea of component programming, in 
which programs are constructed by combining independent previously written components without any further 
language processing. JavaScript and VB Script programs were designed as components that may be attached to Web 
browsers to control how they display information. 

 
Language translator:- A computer language translator is a program that translates a set of code written in one 
programming language into a functional equivalent of the code in another programming language. The different types 
of computer translators are interpreters, source-to-source compilers, standard compilers, de compilers, assemblers and 
dis-assemblers. 

Computer language translators are the programs that execute instructions written in a high-level language. There 
are two ways to run programs written in a high-level language. The most common is to compile the program; the other 
method is to pass the program through an interpreter. 

1. Assembler:- An assembler translates assembly language into machine code. Assembly language consists of 
mnemonics for machine opcodes so assemblers perform a 1:1 translation from mnemonics to a direct instruction. For 
example: 

 
LDA #4 converts to 0001001000100100 
 
Conversely, one instruction in a high level language will translate to one or more instructions at machine level. 
 
Advantages of using an Assembler: 
1. Very fast in translating assembly language to machine code as 1 to 1 relationship. 
2. Assembly code is often very efficient (and therefore fast) because it is a low level language. 
3. Assembly code is fairly easy to understand due to the use of English-like mnemonics. 
Disadvantages of using Assembler: 

• Assembly language is written for a certain instruction set and/or processor. 

• Assembly tends to be optimized for the hardware it's designed for, meaning it is often incompatible with 
different hardware. 

• Lots of assembly code is needed to do relatively simple tasks, and complex programs require lots of 
programming time. 

 
2.Compiler:- A Compiler is a computer program that translates code written in a high level language to a lower 

level language, object/machine code. The most common reason for translating source code is to create an executable 
program (converting from a high level language into machine language). 

In other words we can say, A compiler is a special program that processes statements written in a particular 
programming language called as source code and converts them into machine language or “machine code” that a 
computer’s processor uses. Compiler translates high level language programs directly into machine language program. 
This process is called compilation.  

 

https://www.merriam-webster.com/dictionary/dynamic
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Fig.:- Compilation 
 
Advantages of using a compiler 
1. Source code is not included; therefore compiled code is more secure than interpreted code 
2. Tends to produce faster code than interpreting source code 
3. Produces an executable file, and therefore the program can be run without need of the source code 
 
Disadvantages of using a compiler 
1. Object code needs to be produced before a final executable file, this can be a slow process 
2. The source code must be 100% correct for the executable file to be produced 
 
3.Interpreter:- An interpreter program executes other programs directly, running through program code and 

executing it line-by-line. As it analyses every line, an interpreter is slower than running compiled code but it can take 
less time to interpret program code than to compile and then run it — this is very useful when prototyping and testing 
code. Interpreters are written for multiple platforms, this means code written once can be run immediately on different 
systems without having to recompile for each. Examples of this include flash based web programs that will run on 
your PC, MAC, games console and Mobile phone. 

In other words we can say, An interpreter translates high-level instructions into an intermediate form, which it then 
executes. Compiled programs generally run faster than interpreted programs. The advantage of an interpreter, 
however, is that it does not need to go through the compilation stage during which machine instructions are generated. 
This process can be time-consuming if the program is long.  

 

 
Fig:-Interpretation 

 
Advantages of using an Interpreter 
1.Easier to debug(check errors) than a compiler. 
2.Easier to create multi-platform code, as each different platform would have an interpreter to run the same code. 
3.Useful for prototyping software and testing basic program logic. 
 
Disadvantages of using an Interpreter 
1.Source code is required for the program to be executed, and this source code can be read making it insecure. 
2.Interpreters are generally slower than compiled programs due to the per-line translation method. 
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Abstract 
This chapter provides a comprehensive introduction to computer networking, Internet technologies, and electronic 
commerce (e-commerce). It begins by defining computer networks and their importance in enabling communication, 
resource sharing, and information exchange among connected systems. Various types of networks such as LAN, 
MAN, and WAN are discussed, along with their characteristics including topology, protocols, and network 
architecture. 
The chapter further explores Internet technology, describing how global networks are interconnected using standard 
protocols such as TCP/IP. Key components of the World Wide Web (WWW), including browsers, hypertext, HTML, 
URLs, and HTTP, are explained in detail. Additionally, modern Internet services such as email systems and search 
engines are examined, highlighting their structure, working mechanisms, and practical applications. 
The chapter also introduces the concept of e-commerce, differentiating it from e-business and discussing its benefits, 
applications, and technological features. Various models such as B2C, B2B, and C2C are analyzed, along with the 
evolution and growth stages of e-commerce. Finally, the chapter addresses the limitations and challenges in the 
adoption of e-commerce technologies. Overall, this chapter provides a strong foundation for understanding 
networking and digital business environments. 
 
Keywords: Computer Networks, LAN, MAN, WAN, Internet, TCP/IP, World Wide Web, HTML, URL, HTTP, 
Email Systems, Search Engines, E-Commerce, E-Business, Network Topology, Network Protocols, Digital 
Communication 

 
Introduction to Computer Networking:-  A computer network is a group of computer systems and other 
computing hardware devices that are linked together through communication channels to facilitate communication 
and resource-sharing among a wide range of users. Networks are commonly categorized based on their characteristics. 
Computers on a network are sometimes called nodes. Computers and devices that allocate resources for a network 
are called servers. 
 
Networks are used to:- 

• Facilitate communication via email, video conferencing, instant messaging, etc. 

• Enable multiple users to share a single hardware device like a printer or scanner 

• Enable file sharing across the network 

• Allow for the sharing of software or operating programs on remote systems 

• Make information easier to access and maintain among network users 
 
There are many types of networks, including:- 

http://www.webopedia.com/TERM/N/node.html
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• Local Area Networks (LAN) 

• Personal Area Networks (PAN) 

• Home Area Networks (HAN) 

• Wide Area Networks (WAN) 

• Campus Networks 

• Metropolitan Area Networks (MAN) 

• Enterprise Private Networks 

• Internetworks 

• Backbone Networks (BBN) 

• Global Area Networks (GAN) 

• The Internet 
 

Network Characteristics 
In addition to these types, the following characteristics are also used to categorize different types of networks: 

• Topology : The geometric arrangement of a computer system. Common topologies include a bus, star, 
and ring.  

• Protocol : The protocol defines a common set of rules and signals that computers on the network use to 
communicate. One of the most popular protocols for LANs is called Ethernet. Another popular LAN 
protocol for PCs is the IBM token-ring network.  

• Architecture : Networks can be broadly classified as using either a peer-to-peer or client/server 
architecture.  

 
Concept of LAN,WAN & MAN:-There are many types of computer networks, including the following: 

1. LAN:- A LAN (local area network) is a group of computers and network devices connected together, 
usually within the same building. By definition, the connections must be high speed and relatively 
inexpensive (e.g., token ring or Ethernet). Most Indiana University Bloomington departments are on 
LANs.  A LAN connection is a high-speed connection to a LAN. On the IUB campus, most connections 
are either Ethernet (10 Mbps) or Fast Ethernet (100 Mbps), and a few locations have Gigabit Ethernet 
(1000 Mbps) connections. 
2. MAN:- A MAN (metropolitan area network) is a larger network that usually spans several buildings in 
the same city or town. The IUB network is an example of a MAN.  
3. WAN:- A WAN (wide area network), in comparison to a MAN, is not restricted to a geographical 
location, although it might be confined within the bounds of a state or country. A WAN connects several 
LANs, and may be limited to an enterprise (a corporation or an organization) or accessible to the public. 
The technology is high speed and relatively expensive. The Internet is an example of a worldwide public 
WAN. 
 

Internet technology:-Internet technology is the ability of the Internet to transmit information and data through 
different servers and systems. Internet technology is important in many different industries because it allows people 
to communicate with each other through means that were not necessarily available. 
 
Concept of Internet technology:- The Internet is a global collection of computer networks that are linked together 
by devices called routers and use a common set of protocols for data transmission known as TCP/IP (transmission 
control protocol / Internet protocol). The primary purpose of the Internet is to facilitate the sharing of information. 
There are many different tools used on the Internet to make this possible. Some of the more common tools include 
email, listservs, newsgroups, telnet, gopher, FTP, and the world wide web. Probably the most popular of all Internet 
tools is the world wide web. 
 
World Wide Web (WWW):- The WWW is a collection of Internet sites that can be accessed by using a hypertext 
interface. Hypertext documents on the web contain links to other documents located anywhere on the web. By clicking 
on a link, you are immediately taken to another file or site to access relevant materials. The interesting thing about 
Hypertext links is that the links might take you to related material on another computer located anywhere in the world, 
rather than just to a file on your local hard drive. 
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Basic WWW Concepts:- 

• BROWSER -- A WWW browser is software on your computer that allows you to access the World Wide 
Web. Examples include Netscape Navigator and Microsoft Internet Explorer. Please know that a browser 
can’t work its magic unless you are somehow connected to the Internet. At home, that is normally 
accomplished by using a modem that is attached to your computer and your phone line and allows you to 
connect to, or dial-up, an Internet Service Provider (ISP). At work, it may be accomplished by connecting 
your workplace’s local area network to the Internet by using a router and a high speed data line. 

• HYPERTEXT AND HYPERMEDIA -- Hypertext is text that contains electronic links to other text. 
In other words, if you click on hypertext it will take you to other related material. In addition, most WWW 
documents contain more than just text. They may include pictures, sounds, animations, and movies. 
Documents with links that contain more than just text are called hypermedia. 

• HTML (HYPERTEXT MARKUP LANGUAGE) -- HTML is a set of commands used to create world 
wide web documents. The commands allow the document creator to define the parts of the document. 
For example, you may have text marked as headings, paragraphs, bulleted text, footers, etc. There are also 
commands that let you import images, sounds, animations, and movies as well as commands that let you 
specify links to other documents. If you wanted to create your own web page, you would need to know 
HTML or be able to use a tool that can generate HTML.  

• URL (UNIFORM RESOURCE LOCATOR) -- Links between documents are achieved by using an 
addressing scheme. That is, in order to link to another document or item (sound, picture, movie), it must 
have an address. That address is called its URL. The URL identifies the host computer name, directory 
path, and file name of the item. It also identifies the protocol used to locate the item such as hypertext, 
gopher, ftp, telnet or news.  

• HTTP (HYPERTEXT TRANPORT PROTOCOL) -- HTTP is the protocol used to transfer 
hypertext or hypermedia documents. 

• HOME PAGE -- A home page is usually the starting point for locating information at a WWW site.  

• CLIENTS AND SERVERS -- If a computer has a web browser installed, it is known as a client. A host 
computer that is capable of providing information to others is called a server. A server requires special 
software in order to provide web documents to others. 

 
Email Services:- E-mail, in full electronic mail, messages transmitted and received by digital computers through a 
network. An e-mail system allows computer users on a network to send text, graphics, and sometimes sounds and 
animated images to other users. On most networks, data can be simultaneously sent to a universe of users or to a 
select group or individual. Network users typically have an electronic mailbox that receives, stores, and manages their 
correspondence. Recipients can elect to view, print, save, edit, answer, forward, or otherwise react to communications. 
Many e-mail systems have advanced features that alert users to incoming messages or permit them to employ special 
privacy features. Large corporations and institutions use e-mail systems as an important communication link between 
employees and other people allowed on their networks. E-mail is also available on major public online and bulletin 
board systems, many of which maintain free or low-cost global communication networks. 

In short electronic mail, email (or e-mail) is defined as the transmission of messages over communications 
networks.  

 
Typical Components of an Email System:- Most email systems include a rudimentary text editor for composing 
messages, but many allow you to edit your messages using any editor you want. Some systems will also provide basic 
formatting, including bold, italics, font color and HTML. You can use the program to send the message to a recipient 
by specifying the recipient's address. You can also send the same message to several users at once. This is called 
broadcasting. 

Sent messages are stored in electronic mailboxes until the recipient fetches them. To see if you have any mail, you 
may have to check your electronic mailbox periodically, although many systems alert you when mail is received. After 
reading your mail, you can store it in a text file, forward it to other users, or delete it. Copies of memos can be printed 
out on a printer if you want a paper copy. 

 
Search Engines:- A search engine is a software program or script available through the Internet that searches 
documents and files for keywords and returns the results of any files containing those keywords. Today, there are 
thousands of different search engines available on the Internet, each with their own abilities and features. The first 
search engine ever developed is considered Archie, which was used to search for FTP files and the first text-based 
search engine is considered Veronica. Today, the most popular and well-known search engine is Google. 
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How to access a search engine:- For users, a search engine is accessed through a browser on their computer, smart 
phone, tablet, or another device. 
 
How a search engine works:- Because large search engines contain millions and sometimes billions of pages, many 
search engines not only just search the pages but also display the results depending upon their importance. This 
importance is commonly determined by using various algorithms. As illustrated in the figure below, the source of all 
search engine data is a spider or crawler, which automatically visits pages and indexes their contents. 

 

 
Once a page has been crawled, the data contained within the page is processed and indexed. Often, this can involve 

the steps below. 

• Strip out stop words.  

• Record the remaining words in the page and the frequency they occur. 

• Record links to other pages. 

• Record information about images or other embedded media. 
 
The data collected above is used to rank the page and is the primary method a search engine uses to determine if 

a page should be shown and in what order. 
Finally, once the data is processed it is broken up into one or more files, moved to different computers, or loaded 

into memory where it can be accessed when a search is performed. 
 

What is e-commerce? How does it differ from e-business? Where does it intersect with e-business? 
E-commerce, in the popular sense, can be defined as: The use of the Internet and the Web to conduct business 

transactions. A more technical definition would be: E-commerce involves digitally enabled commercial transactions 
between and among organizations and individuals. E-commerce differs from e-business in that no commercial 
transaction, an exchange of value across organizational or individual boundaries, takes place in e-business. E-business 
is the digital enablement of transactions and processes within a firm and therefore does not include any exchange in 
value. E-commerce and e-business intersect at the business firm boundary at the point where internal business systems 
link up with suppliers. For instance, e-business turns into e-commerce when an exchange of value occurs across firm 
boundaries. 

 
Benefits of E-commerce :- There are many benefits of bringing one's business to the Web. An e-business can offer 
personalized service, high-quality customer service and improved supply chain management. E-commerce in a way is 
equivalent to automation and innovation of commercial activities. It is absolutely clear that automation brings a 
number of distinct advantages including lesser investment. Automation frees valuable labor from menial tasks and 
also encourages the people concerned to pursue new and ideally beneficial initiatives, which would not have happened 
previously. We discuss the benefits of each model explained above.  

B2C applications are beneficial to existing retail stores and companies as this innovative application allows them 
to increase their customer base and hence their revenue. E-commerce helps them to reach entire demographics that 
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they might not be able to reach in a physical or "bricks and mortar" store. B2C is highly beneficial for consumers as it 
gives them access to a world of stores instead of the stores in their neighborhood. It brings a competitive trend giving 
consumers access to a wide variety of choices and lower prices. Some B2C web sites allow consumers to name their 
own prices for a variety of goods and services. Thus e-commerce brings forth such kinds of beneficial, consumers-
oriented innovations.  

B2C allows companies to extend their existing services to consumers as well. Consumers are able to order a special 
item to be delivered to a nearby store for pickup is a handy service that increases customer loyalty and this is possible 
only due to the advent of B2C. B2C applications open up a new world for companies that are not well known to 
outside world before.  

B2B is extremely beneficial to businesses because of its potential to drastically reduce the cost. By making 
communication easier and faster, using new technologies and standards, the quicker the inventory can move, the more 
efficient the process. Further on, B2B applications help automate communication between companies. This, apart 
from streamlining the process, helps reduce the potential for errors and helps provide better goods and services. 

B2B2C applications help B2C companies to raise profits. By leveraging the benefits of B2B to streamline and 
improve business, B2C companies have the ability to make more money by growing revenue and cutting unnecessary 
costs. Also a company which is successful in one area of e-commerce can capitalize on this success and knowledge 
gathered to other areas of their e-commerce plan.  

C2C and C2B2C applications allow consumers to interact themselves. This helps businesses to have a fairly easy 
revenue stream and consumers have access to an entirely new way to purchase and sell goods and services.  
 
Unique features of e-commerce technology:- The unique features of e-commerce technology include: 

• Ubiquity: It is available just about everywhere and at all times. 

• Global Reach: The potential market size is roughly equal to the size of the online population of the world. 

• Universal standards: The technical standards of the Internet and therefore of conducting e-commerce, are 
shared by all of the nations in the world. 

• Richness: Information that is complex and content-rich can be delivered without sacrificing reach. 

• Interactivity: E-commerce technologies allow two-way communication between the merchant and the 
consumer. 

• Information density: The total amount and quality of information available to all market participants is 
vastly increased and is cheaper to deliver. 

• Personalization/Customization: E-commerce technologies enable merchants to target their marketing 
messages to a person’s name, interests and past purchases. They allow a merchant to change the product 
or service to suit the purchasing behavior and preferences of a consumer. 

• Social technology: User content generation and social networking technologies  
 

Growth of E-commerce:- There are three different stages in the evolution of e-commerce. 
The three stages in the evolution of e-commerce are innovation, consolidation, and reinvention. Innovation took 

place from 1995-2000 and was characterized by excitement and idealistic visions of markets in which quality 
information was equally available to both buyers and merchants. E-commerce did not fulfill these visions during its 
early years, however. After 2000, e-commerce entered its second stage of development: consolidation. In this stage, 
more traditional firms began to use the Web to enhance their existing businesses. Less emphasis was placed on creating 
new brands. In 2006, though, e-commerce entered its current stage, reinvention, as social networking and Web 2.0 
applications reinvigorated e-commerce and encouraged the development of new business models. 

 
Limitations in growth of E-commerce:- One major limitation to the growth of e-commerce is the price of personal 
computers. Another limitation is the need for many people to learn complicated operating systems, at least in 
comparison to other technologies such as the television or the telephone. People must also learn a set of sophisticated 
skills to make effective use of the Internet and e-commerce capabilities. Another limitation is the unlikelihood that the 
digital shopping experience will ever replace the social and cultural experience that many seek from the traditional 
shopping environment. Finally, persistent global income inequality will exclude most of the world’s population, who 
do not and probably will not in the foreseeable future, have access to telephones or PCs. Social and cultural limitations 
are likely to be tougher to overcome than technological limitations. 
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Abstract 
This chapter provides a comprehensive understanding of the Microsoft Windows operating system, focusing on its 
structure, features, and essential utilities. It begins with an introduction to Windows as a graphical user interface (GUI)-
based operating system that enables users to interact with computer systems through point-and-click operations. The 
chapter explains the organization of Windows, including different types of windows such as program, document, and 
folder windows, along with their key components like title bars, menu bars, and scroll bars. 
The chapter further explores the concept of the desktop environment, including icons, taskbar, start menu, and system 
tray, which collectively enhance user interaction and system navigation. It also explains fundamental file management 
operations such as copying, moving, renaming, and deleting files and folders. 
Additionally, the chapter provides detailed insights into various Windows accessories and system tools, including 
Calculator, Notepad, Paint, Snipping Tool, Disk Cleanup, Disk Defragmenter, and System Restore. Accessibility tools 
such as Magnifier, Narrator, and On-Screen Keyboard are also discussed, highlighting their role in supporting users 
with special needs. The chapter concludes with an overview of Control Panel and Windows Explorer, emphasizing 
their importance in system configuration and file management. Overall, this chapter equips learners with practical 
knowledge for efficient use of the Windows operating system. 
 
Keywords: Windows Operating System, GUI, Desktop, Taskbar, Start Menu, File Management, Icons, Control Panel, 
Windows Explorer, System Tools, Disk Cleanup, Disk Defragmenter, System Restore, Windows Accessories, 
Accessibility Tools 

 
What is Windows? 

Window is an operating system and Graphical User Interface (GUI) created by Microsoft and found on most 
computer systems. 

•It allows for easy “point and click” operations between the user and the different files and programs with which 
they wish to work. 

•While there are many different versions of Windows, the fundamentals are the same. 
An understanding of the below tools and features will make it easier to use windows. 
 

Windows structure: 
The “window” refers a program or document or other object that is open. We can have multiple windows open at 

once and easily switch back and forth between them. We can move windows around, resize them or have a particular 
window expand onto the entire screen. 
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Types of Windows:- 
1. Program Windows –Applications like Word, Internet Explorer are comes under the program windows. 
2. Document Windows–these windows are Opens to a specific document within the applicable program window. 
3. Folder Windows –A folder, like “My Documents” that may contain other folders, documents, programs, etc. 

are comes under this category. 
 

Parts of a Window:- 
1. Title Bar –it appears at the top of the window. It has mainly contained these buttons:-  

            1. Minimize. 2. Maximize 3. Restore 4. Close 
 
To adjust the size and position of a window, we can click and drag on the title bar. When window is smaller we 

can also move our window to another position by dragging it by toolbar. Also we can resize our window by clicking 
on the “resize” button. 

 
2. Menu bar: - every window has a menu bar, which allows to access features within that particular program. For 

example office 2010 programs also have a menu bar and is called “the ribbon”. 
 
3. Scroll Bars: - Scroll bars often appear at the bottom and even more often on the right hand side of a window, 

if there is a lot of content. Scroll bars are disabled when the content displayed is limited enough to fit within the 
dimensions of the window. 

 
 
 
 
 
 
 
 
 
 
 
4. Cut/Copy/Paste:- 
Cut, copy, and paste commands can be used with to move text, graphics and other items from one application to 

the next (Internet Explorer to Microsoft Word, for instance).Copied or cut items are placed in temporary storage (the 
Clipboard) and can be retrieved as long as the computer is on or if the item hasn’t been replaced by another that you 
select. An item on the Clipboard can be pasted multiple times. 

 
Performing Cut/Copy/Paste:- 
1. Select the item (text or graphic) to be copied by either highlighting the text or right clicking on the graphic. 
2. Once we have made your selection, in the case of text, notice that it remains highlighted 
3. We can now right click on your selection and select 
    Copy OR Press [Ctrl] + [C] 
4. Now we have copied the material and we can use it to paste into another application. 



International Multidisciplinary Book Series Vol. 1, Issue 1 (2023) 

 https://ibseries.com/index.php/IMBS/ 

 

 

 

65 

5. Once we have copied the item, go to the application where we would like to paste it. 
6. Place your cursor where you want to paste the item in the document (a word file, email, etc.) 
7. Right Click and then select  
    Paste OR Press [Ctrl] + [V]. 
5. Moving/copying files and folders: - Similar to cutting and pasting text/graphics. 
6. Renaming files/folders. 
7. Creating new folders and shortcuts 
 

The Desktop: - The “Desktop” is the general work area of your computer. It gives you access to programs, folders 
and documents that you use frequently. This area is customizable on your own computer, though it is not something 
that can be changed on a public computer at the library. 

 

 
 

1. Icons: - An icon is a symbol/picture that acts as a button to open up a folder, document, application or other 
object. All icons need to be double clicked in order to open. 

 
Different Types of Icons 
1. Application Icons open up a program (an executable file), like Internet Explorer, Microsoft Word, etc. 
2. Folder Icons store and organize documents and applications. Often you will find folders within folders. 
3. Document icons represent a specific file, like a word document, picture, etc. These files typically have an 

association with the program that is used to open them. 

 
Windows operating system uses different icons to represent files, folders and applications. Icons found on the 

desktop are normally left aligned. The desktop icons basically provided by windows are: 
1. My Documents 
2. My Computer 
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3. My Network Places 
4. Recycle Bin 
5. Internet Explorer 
 

Recycle Bin:- Recycle bin makes it easy to delete and undelete files and folders. When a file or folder is deleted from 
any location, Windows stores it in the recycle bin. If a file is deleted accidentally, you can move it back from the recycle 
bin. We can also empty recycle bin to save disk space. 

 
Steps to move back the file or folder from the recycle bin:- 

1. Open Recycle bin by double clicking on its icon. 
2. Select the file or folder you want to move back. 
3. Click the right mouse. 
4. A menu will appear, choose restore from it. 
5. Windows will move the file or folder back to the location from where it was deleted. 
 

My Computer: - My computer lets you browse the contents of your computer. The common tasks that we can 
perform through my computer are: 

1. Access information stored as different storage devices connected with the computer, such as hard disk, floppy 
disk or CD ROM. 

2. Create, move, copy, delete or rename files, folders and programs from one disk to another disk. 
3. Execute or run programs from the disks. 
4. Configure devices of the computer. 
5. Add or remove a printer. 
 

Icons vs. Programs 
1. You double click on the icon to execute the program. 
2. When inside of the program, you single click on the commands or icons for that program. (Examples: MS 

Office, Internet Explorer, Firefox, Windows Media Player, etc.) 
 

2. The Taskbar: - The task bar is at the bottom of the desktop but you can move it to the top or either side of the 
screen by clicking and dragging it to the new location. Buttons representing programs currently running on your 
computer appears on the task bar. At the very left of the task bar is the start button, which allows access to other 
Windows programs and features that are not on the desktop. At the right side is an area called the system tray.  System 
tray shows programs running in the background, the clock, volume control, etc.  

 
 

3. Start Button:- Start button is found at the lower left corner of the screen. Click once on the start button to open a 
menu of choices. Through this button we can open the programs, installed on your computer and access all the utilities 
available in the windows environment. We can shutdown, restart and/or standby the computer by using the start 
button. 
 
Start menu displays a menu of choices:  
1. Default Programs: - choose default programs for web browsing, e-mail, playing music and other activities. Place 
the mouse pointer to the programs entry and a sub menu will open, showing all programs or applications currently 
installed. To open a program, which has been installed on your computer, click on it and the program will open. 
2. Favorites: - Favorites menu present a list of the Internet addresses that you have added to your Internet Explorer 
Favorite List.   
3. Documents: - Access letter, reports, notes and other kind of documents. The Documents menu lists the files you 
have recently worked on. You can open the most recently used document directly from here. To open a document 
from this list, simply click on it and the document will open. 
4. Control Panel: - one can change setting and customize the functionality of the computer by using this button. This 
menu provides the facility to change or configure the hardware or software settings of the computer. This menu leads 
to several choices. The individual icons in the Control Panel refer to a variety of tools to control the way of your 
computer, its components presents information, as well as the tools to control the behavior and appearance of the 
Windows interface. 
5. Find and search: - This option of the start menu helps in locating files or folders stored on the hard disk or 
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network. This command is very helpful in case we forget the exact location of a file or folder that we want to access. 
The search option presents different ways for finding a file or folder. These options include search based on name, 
type, size, and date and storage location of the file or folder. It opens a dialog box, where the user can type a name of 
the file or folder to search for. The procedure of using this command is given below: 

1. Click on Find option of the start menu, the Find dialog box will appear. 
2. Enter the name of the file or folder in the Named text box. 
3. From the Look in drop down list box choose the location where you imagine that your desired file or folder 

may be present. 
4. Click on the Find now button to start search. 
5. If find dialog box successfully searches the location of the desired file or folder, it will display it in the window 

below this dialog box. 
6. Help and support: - Find help topics, tutorials, troubleshooting and support services. To access the Help system 
of windows, you can select Help from the start menu. Help option helps us how to use the commands and menus and 
in case of problems how to trouble shoot the windows operating system. 
7. Run: - This command is used to execute a command or program directly instead of using the icon or program 
menu. Press the “Browse” button to locate the program you want to open through Run command. 
8. Shutdown:- Shutdown is a process in which computer closes all programs currently running and disconnects the 
devices connected with it and turns itself off. Following steps are followed to shutdown the computer:- 

1. Click on the start button to open the Start Menu. 
2. Click on the Shut Down. 
3. Shut down dialog box will appear. 
4. Choose the shut down option from the list and click the “OK” button. 

9. Devices and Printers:-view and manages devices, printers and printers job. 
10. Computer: - see the disk drive and other hardware connected the computer 
11. Music: - Play music and other audio files 
12. Pictures: - view and organize digital pictures. 

 

 
 

Windows Accessories :- Windows operating system ships with some handy applications known as Windows 
accessories. Calculator, Notepad, Paint, Explorer, WordPad are some of the most frequently used accessories. Apart 
from above mentioned applications, Windows has a few tools for Ease of Access and some System Tools. We’ll be 
briefly talking about them here. 

1.Calculator:- 
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Windows Calculator is a calculating application included in all the versions of Windows. It can be used to perform 

simple calculation, scientific calculation and Programming calculation. 
 

• Choose Start >> Programs >> Accessories >> Calculator to start Calculator application, or 

• Alternately you can open Run dialog box (Start >> Run) dialog box then type calc and hit enter. 

• From View menu choose the required type of calculator – Standard, Scientific, Programmer, Statistical 

• Edit >> Copy and Paste commands can be used to input the numbers into calculator or paste the result 
to other applications 

 
Calculator was first included with Windows 1.0 as a simple arithmetic calculator. In Windows 3.0, a Scientific mode 

was added, which included exponents and roots, logarithms, factorial-based functions, trigonometry (supports radian, 
degree and gradients angles), base conversions (2, 8, 10, 16), logic operations, Statistic functions such as single variable 
statistics and linear regression. 

In Windows 7, separate Programmer, Statistics, Unit Conversion, Date Calculation, and Worksheets modes were 
added. Calculator’s interface was revamped for the first time since its introduction. 

On the right of the main Calculator, one can add a panel with Date Calculation, Unit Conversion, and Worksheets. 
The included Worksheets allow one to calculate a result of a chosen field based on the values of other fields. Pre-
defined templates include calculating a car’s fuel economy (mpg and L/100 km), a vehicle lease, and a mortgage. In 
pre-beta versions of Windows 7, Calculator also provided a Wages template. 

 
2.Snipping Tool:-  Snipping Tool is another useful of Windows accessories included in Windows 7, Windows Vista, 
and Experience Pack for Windows XP Tablet PC Edition 2005. It was originally released as a powertoy for the Tablet 
PC. The program is a screen-capture tool that allows taking screenshots (called snips) of an open window, rectangular 
areas, a free-form area, or the entire screen. Snips can then be annotated using a mouse or a tablet, saved as an image 
file (PNG, GIF, or JPEG file) or an HTML page, or e-mailed.  
 

 
 
The Snipping Tool captures all or part of the computer display screen as a picture. You can save the picture and 

attach it to an e-mail or paste the picture into a document. Click the Start button, type snip, and click the Snipping 
Tool from the search results. The screen fades slightly, and the Snipping Tool toolbar appears. 

Snipping tool can be used to PrintScreen, annotate and use in other applications. 
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3. Paint:- 

 
 
Paint (formerly Paintbrush for Windows) is a simple graphics painting program that has been included with all 

versions of Microsoft Windows. It is often referred to as MS Paint or Microsoft Paint. The program opens and saves 
files as Windows bitmap (24-bit, 256 colors, 16 color, and monochrome) .BMP, JPEG, GIF. Paintbrush supports GIF 
without animation or transparency. Since Windows 98 Paint supports GIF with transparency. It also supports PNG 
(without alpha channel), and TIFF (without multiple page support). 

The program can be in color mode or two-color black-and-white, but there is no grayscale mode. For its simplicity, 
it rapidly became one of the most used applications in the early versions of Windows—introducing many to painting 
on a computer for the first time—and still has strong associations with the immediate usability of the old Windows 
workspace. 

 
4. Character Map:- Character Map is a utility included with Microsoft Windows operating systems and is used to 
view the characters in any installed font, to check what keyboard input (Alt code) is used to enter those characters, 
and to copy characters to the clipboard in lieu of typing them. 
 

 
The tool is usually useful for entering special characters. It can be opened via the command line or Run Command 

dialog using the ‘charmap’ command. 
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5.Notepad:- 
 

 
 
Notepad is a common text-only (plain text) editor. The resulting files—typically saved with the .txt extension—

have no format tags or styles, making the program suitable for editing system files that are to be used in a DOS 
environment. 

Notepad supports both left-to-right and right-to-left based languages, and one can alternate between these viewing 
formats by using the right or left Ctrl+Shift keys to go to right-to-left format or left-to-right format, respectively. 

 
6.WordPad:- 

 
 
Microsoft WordPad is a free rich text editor included with Microsoft Windows 95 and the later. Earlier to Windows 

95 there used to be an application called Write for the same task. Although capable of doing much more than Notepad, 
WordPad is not as advanced as Microsoft Word. 

WordPad can format and print text, but lacks intermediate features such as a spell checker, thesaurus, and support 
for tables. As such, it is suitable for writing letters or short pieces, but underpowered for work that relies heavily on 
graphics or typesetting. 
 
7.System Tools:- 

For a smooth performance of a system, periodic maintenance is necessary. Tools like Disk Check, Disk 
Derangement, etc., helps in system maintenance. Windows includes some of the system utilities such as Disk Cleanup, 
Disk Defragment, System Restore, Control Panel and so on. 

 
1.Disk Cleanup:- In Windows 7, Vista, and XP, Disk Cleanup frees disk space by cleaning areas that gather 

unneeded files. Using Disk Cleanup regularly, along with ScanDisk, DEFRAG, and up-to-date virus patterns, will help 
keep your computer running smoothly. 
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To run Disk Cleanup: 

• From the Start menu, select Programs or All Programs, then Accessories, then System Tools, and then 
Disk Cleanup. 

• Select the drive on which you would like to clear disk space (usually your C: drive), and click OK. 

• Select from the four areas that Disk Cleanup will check and clean up: 
 
Temporary Internet Files: Files stored on your local drive that allow web pages to load more quickly. 
 
Downloaded Program Files: A storage location for programs downloaded when you visit specific web sites that use 
ActiveX and Java applets. 
Recycle Bin: Files that have been marked as deleted. 
 
Temporary Files: Items in the TEMP folder. 

 
2.Disk Defragment:- Disk Defragmenter consolidates files so that each is saved in contiguous physical space on 

the hard drive. When your computer crashes or freezes, the drive becomes fragmented. This means the files may be 
broken up and stored in different locations in your computer. This causes programs and files to run more slowly. 
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To run Disk Defragmenter: 

• Close all programs. 

• Choose Start menu | All Programs | Accessories | System Tools | Disk Defragmenter. 

• Select the drive you want to clean and click OK. 

• Click Analyze. This may take several minutes. 

• Click Close or Defragment. If the drive needs defragmented and you choose Defragment, this may take 
several minutes to several hours, depending on the number of files to consolidate. 

 
3.System Restore:- System restore is a feature of Windows that allows you to roll back the system to the same 

configuration it had at an earlier time. If this feature is turned on (which it is by default) Windows will take periodic 
snapshots (called restore points) of your installation. It can use the information gathered in these snapshots to restore 
your system to a previous configuration. It is a good idea to create a restore point before you make major changes to 
your system, such as before installing new hardware or doing any major updates. 

 
To run System Restore: 

• Go to Start > Programs > Accessories > System Tools > System Restore. 

• The System Restore screen will com up. 

• Follow the on screen instructions 
 

 
 

4.Format:- There are times when Windows becomes so damaged or so compromised by hackers and Trojan 
programs that the only thorough solution is to essentially start all over. This is accomplished by formatting your hard 
drive, which means erasing all of the programs and the data on your machine, and re-installing Windows. 

The format creates a new root directory and file system for the disk. It can also check for bad areas on the disk, 
and it can delete all data on the disk. To be able to use a new disk, you must first use this command to format the disk. 

 



International Multidisciplinary Book Series Vol. 1, Issue 1 (2023) 

 https://ibseries.com/index.php/IMBS/ 

 

 

 

73 

 
 
8.Control Panel:- The Control Panel is a part of the Microsoft Windows graphical user interface. It allows users to 
view and manipulate basic system settings and controls via applets. You can use control panel for the tasks such as 
adding hardware, adding and removing software, controlling user accounts, and changing accessibility options. 
Additional applets can be provided by third party software. 

In recent versions of Windows, the Control Panel has two views, Classic View and Category View, and it is possible 
to switch between these through an option that appears on either the left side or top of the window. 

The classic view consists of shortcuts to the various control panel applets, usually without any description (other 
than the name). The categories are seen if the user use “Details” view. 

The category view consists of categories, which when clicked on display the control panel applets related to the 
category. In Windows Vista, the category used applets below the name of the category. 
 
9.Accessories also have  few vision, hearing and ability tools. The first one is: 

1.The Magnifier:- The Magnifier is a display utility that makes the computer screen more readable by people who 
have low vision by creating a separate window that displays a magnified portion of the screen. Magnifier provides a 
minimum level of functionality for people who have slight visual impairments. 

Usually the Magnifier by default is set to show up at the top of the screen, but you can move it around by using 
your left mouse button: Click ad hold down the left button and move the magnifier window to where you want it, 
then let go of the button. 

When you open the Magnifier a new window appears: The Magnifier Settings window. From that window you can 
change the level of magnification, change the tracking and the presentation.To get out of the magnifer mode simply 
click Exit. 

 
2.The Narrator:- It is available From Windows 2000 and newer. The Narrator is a text-to-speech utility for people 

who are blind or have low vision. Narrator reads what is displayed on the screen—the contents of the active window, 
menu options, or text that has been typed.  

The Narrator is designed to work with Notepad, WordPad, Control Panel programs, Internet Explorer, the 
Windows desktop, and some parts of Windows Setup. Narrator may not read words aloud correctly in other programs. 
Narrator has a number of options that allow you to customize the way screen elements are read. 

 
3.The On-screen Keyboard:- On–Screen Keyboard is a utility that displays a virtual keyboard on the computer 

screen. This tool allows people with mobility impairments to type data by using a pointing device or joystick. Besides 
providing a minimum level of functionality for some people with mobility impairments, On–Screen Keyboard can 
also be helpful for people who do not know how to type. 

The program in which you want to type characters must be active while you are using On–Screen Keyboard. The 
accessibility tools in the Windows operating system are intended to provide a minimum level of functionality for users 
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with special needs. 
 

 
 
10.Windows explorer:- The tool's fundamental purpose is to let you view, open, copy, move, and otherwise manage 
your files and folders. So learning how to use it is key for tasks like importing photos from the aforementioned memory 
card, copying files to a flash drive, setting up folders to keep your data organized, and so on. 
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Abstract 
This chapter provides a comprehensive understanding of word processing and Microsoft Word, focusing on its role 
in creating, editing, formatting, and managing documents efficiently. It begins by explaining the concept of word 
processing as an evolution from traditional typing methods to digital document creation, emphasizing flexibility and 
ease of editing. 
The chapter further explores the features of Microsoft Word, including text formatting, table creation, AutoCorrect, 
mail merge, templates, macros, and large document management tools. It also explains essential document operations 
such as creating, saving, editing, and formatting documents. 
In addition, the chapter provides a detailed overview of the Microsoft Word interface, including components such as 
the title bar, menu bar, toolbars, status bar, and ruler. Various menus such as File, Edit, View, Insert, Format, Tools, 
and Table are discussed, along with their functions and commands. The chapter also highlights the role of toolbars 
and their customization for efficient task execution. Overall, this chapter equips learners with practical knowledge and 
skills required for professional document preparation and office productivity. 
 
Keywords:Word Processing, Microsoft Word, Document Editing, Text Formatting, Toolbars, Menu Bar, File 
Management, Mail Merge, Templates, Macros, Document Interface, Office Applications, Desktop Publishing 

 
WORD Processing : MS WORD 
Word Processing:- 

The act of writing is the continuous processing of words. Usually, we start with a rough draft. Then we change 
things: we move text around, insert new text, delete some text and so on and so forth, until we are satisfied with the 
final document. 

Doing all this with a typewriter requires constant marking and retyping of drafts, mainly because you are typing 
directly onto the paper and the only way to change what’s on the paper is to start all over again and with a new piece 
of paper. But with word processing, you type your material into the computer’s memory (and view your work on the 
screen). As you are not typing directly onto the paper, you can replace, move, copy, insert, delete, overwrite or correct 
any words, sentences, paragraphs, pages - any amount of text - at any time, before your material becomes the document 
on paper. 

In a word processing software or word processor, you can format your text with a variety of typefaces, add graphics, 
and set your work in sophisticated formats, such as newspaper like columns. When you are done, you print it. And 
with a high-quality inkjet or laser printer, your final document can look as if it were professionally printed. 

Best of all, a word processor lets you make changes to your work with amazing ease. All word processors let you 
delete, insert, copy, and move text whenever you get a new idea, and this will change the way you write. 
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MS Word:- 
MS Word or in short Word enables you to accomplish all of your basic word processing tasks and fulfill most of 

your desktop publishing needs. You can use word to generate all your memos, letters, reports, and other text intensive 
documents. Word’s most valuable contribution is its flexibility with text and its ability to incorporate data from other 
MS Office components in their original format to produce comprehensive documents. 

 
Important features of Word:- Besides Basic features of any word processing S/W package, MS word has features 
like: 

1. 1.Easy table creation and formatting features such as table AutoFormat, which allows you to focus on your 
data and let Word handle that formatting. 

2. 2.AutoCorrect and AutoFormat features that catch typographical errors automatically and allow you to use 
predefined shortcuts and typing patterns to quickly format your documents. 

3. Large-document management features, like the ability to create tables of contents, index, list of figures and 
cross references. 

4. 4.Mail-Merge Helper which allows you to quickly create merged documents like master mailing and mailing 
labels. 

5. Automation by means of macro creation. 
6. The ability to insert fields that make your documents more dynamic by facilitating user input, system input 

for data (like date), and other special features that need to be updated regularly. 
7. Built-in and custom templates that allow fast document creation based on boilerplate text and styles, Auto 

text, macros, and tool bars stored with individual templates. 
8. Master document view that allows you to manage very large documents by incorporating subdocuments 

into one primary master document. 
 

Create a document:- 
The following procedure creates a new, blank document. 
On the Standard toolbar, click New Blank Document. 
To use templates, wizards, and existing documents as a starting point, do one of the following: 
 
From a template or wizard 
1. On the File menu, click New. 
2. In the New Document task pane, under New from template, click General Templates. 
3. Click the tab for the type of document you want to create, and then double-click the icon for the template or 

wizard you want. 
 
Tips: 
Creating file from a copy of an existing document 
1. On the File menu, click New. 
2. In the New Document task pane, under New from existing document, click Choose document. 
3. Click the document you want to create a new document from. 
 
If you want to open a document that was saved in a different folder, locate and open the folder. 
4. Click Create New. 
This document is created in the folder that contains the original document. 
 

Save a document:- 
To quickly save a document, click Save on the Standard toolbar. To save a document in a different location or 

format, use the procedures below. 
 
Saving a document with different name 
On the File menu, click Save As. 
1. In the File name box, enter a new name for the file. 
2. Click Save. 
 
Saving a document with different format and file name 
On the File menu, click Save As. 
1. The File name box, enter a new name for the file. 
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2. From Save as Type select the format. 
3. Click on Save. 
 

Editing a document:- 
(a) Deleting text: Select the text and press Delete key. 
(b) Deleting characters: Press Backspace key to delete character before insertion point or press Delete Key to delete 

character at insertion point position. 
(c) Inserting character: Position insertion point where you want to insert character, make sure Insert key is On type 

the character you want to insert. 
(d) Overtyping character: Position insertion point from where you want to overtype character, make sure Insert 

key is Off, type the character you want to overtype. 
Note: if OVR is display in black in status bar it means overtyping mode is on. Overtyping mode can be turned 

on/off by press Insert Key. 
(e) Inserting paragraph: To insert paragraph position, the insertion point and press enter, and then start typing the 

text for new paragraph. 
(f) Splitting paragraph: To split paragraph position the insertion point from where you want to split the paragraph 

and press enter key. To join the splitted paragraph press Backspace Key. 
(g) Replacing Text: To replace text, select the text and start typing new text. 
(h) Finding text using find command 

1. On the Edit menu, click Find. 
2. In the Find what box, enter the text that you want to search for. 
3. Select any other options that you want. 

 
Microsoft Word Interface:- 

Microsoft Word is a word processing program that allows for the creation of both simple and sophisticated 
documents. The program is equipped with templates and wizards to help you create useful documents such as resumes, 
letters and fax cover sheets. There are also features that allow you to add professional looking graphics to your 
documents. 

Below is an image of the Microsoft Word Interface.   

 

Title Bar: This bar lists the name 
of  the program and the title of the 
current document. 

Menu Bar: This bar displays the 
headings for each drop-down 
menu.   Commands are grouped under 
each of these menu headings according 
to function. 

Standard Toolbar: This toolbar 
contains short cuts to some of the 
most frequently used commands from 
the menu bar. 

Formatting Toolbar: This toolbar 
contains short cuts to some of the 
most frequently used commands 
found under the FORMAT menu 
item.    

Status Bar: This bar displays 
information about the active 
document. 

 1.Title Bar:- 
 

 
 
At the top of the Word interface is the title bar.   This bar is present on all Windows applications and acts as a 

reminder of the program that you are using, as well as the title of the document that you are editing.   In this particular 

http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Title%20Bar
http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Menu%20Bar
http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Standard%20and%20Formatting%20Toolbar
http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Standard%20and%20Formatting%20Toolbar
http://www.scils.rutgers.edu/techsos/Word/wordinterface1.htm#Status%20Bar
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example, the document has not been named so it has the default name of Document1. 
 
In the upper right hand corner of the interface you will notice a set of 3 buttons.  The button with the flat piece ( 

_ ) on it is the minimize button.  The button in the middle is the resize button and may have one square or two squares 
on it.  The last button has an X on it and is called the close button.  

 
In the image of the full screen shown at the top of this page you will notice that there are two sets of these 

buttons.  The top set of these is for the program, Microsoft Word.  The bottom set of these is for the document that 
you are currently viewing.  For the top set, minimize will drop the program MSWord from your view, but will not 
close the program.  Hold down the ALT key on your keyboard and press the TAB key to bring MSWord back into 
your view. The resize button will either make the MSWord window large enough to fit the full monitor (the single 
square) or small enough to where you can see it and whatever is behind it (the two squares).  These work in a similar 
fashion for the document that you are working on.  The minimize button will drop your document to the bottom of 
the page, where it will only be represented by a small title bar.  The resize button will either make the document large 
enough to fit the full MSWord window (the single square) or small enough to where you can see it and other documents 
that you have opened  simultaneously (the two squares).  The close button will close the document, just as if you went 
to FILE | CLOSE on the menu or it will close the program, just as if you went to FILE | EXIT on the menu. 

   
2.Menu Bar:- 
 

 
The menu bar is below the title bar.   There are nine menu options on the menu bar.  When you click on any of 

these options (File, Edit, View, Insert, Format, Tools, Table, Window or Help) a drop-down menu of commands will 
appear below it.   

  
3.Standard and Formatting Toolbar:- 
 

 

 
 
Below the menu bar are the toolbars.   Toolbars consist of icons that act as short-cuts to the commands found 

under the menus.  The icons on the toolbars are organized according to function and according to the most commonly 
used commands in MSWord.  The toolbar that usually appears directly below the menu bar is called the Standard 
Toolbar.  The toolbar just below that is called the Formatting Toolbar.  These toolbars can be customized and moved 
around on the screen.   The option for displaying or hiding a toolbar is found under the menu item VIEW | 
TOOLBARS. The toolbar will be discussed in more detail in the next section of the MSWord tutorial.  A ToolTip 
(yellow tag) appears when you move the mouse over any of the icons on the toolbar.  The ToolTip explains what 
function that particular icon performs. 

  
4.Status Bar:- 
 

 
 
At the bottom of the Word interface is the status bar.  This bar displays information about your document such as 

the page that is currently displayed on the screen (Page 1), the total number of pages in the document (1/1, i.e. 1 of 1) 
and the line in which the cursor is currently positioned (Ln 1).  The right side of the status bar shows whether keys 
such as OVERTYPE are active or inactive. All of these keys in this example are inactive. 

  

http://www.scils.rutgers.edu/techsos/excel/excelquickref.htm
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Name Function Menu Location 

New Creates a new, blank document FILE | NEW 

Open 
Displays the Open dialog box so that you can 

retrieve an existing document 
FILE | OPEN 

Save 
Saves the active document to a specified 

location 
FILE | SAVE 

Print Prints active document FILE | PRINT 

Print Preview 
Displays what the document will look like when 

you print it 
FILE | PRINT PREVIEW 

Spell Checker 
Checks active document for spelling and 

grammatical errors 
TOOLS | SPELLING 

Cut 
Cuts the selected text and places it on the 

clipboard 
EDIT | CUT 

Copy  
Copies the selected text and places it on the 

clipboard 
EDIT | COPY 

Paste 
Pastes the contents of the clipboard to a new 

location 
EDIT | PASTE 

Format Painter 
Copies the formatting of the selected text to a 

new text selection 
  

Undo Undoes the last document change EDIT | UNDO 

Redo Redoes the last action that was undone EDIT | REDO 

Insert Hyperlink Creates a hyperlink from the selected text INSERT | HYPERLINK 

Web Toolbar Shows web toolbar VIEW | TOOLBARS | WEB 

Tables Toolbar Shows tables toolbar 
VIEW | TOOLBARS | 

TABLES 

Insert Table Inserts a table TABLE | INSERT TABLE 

Insert Excel 
Worksheet 

Inserts an Excel Worksheet   

Text Columns Changes the number of text columns per page FORMAT | COLUMNS 

Drawing Shows drawing toolbar 
VIEW | TOOLBARS | 

DRAWING 

Document Map Changes the view of the document VIEW | DOCUMENT MAP 

Show/Hide Non-
Print Characters 

Shows and hides non-print characters (for 
example the symbol for new paragraph) 

  

View 
Magnifies or reduces the document contents by 

the specified zoom percentage 
VIEW | ZOOM 

Office Assistant Help function HELP 
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Name Function Menu Location 

Style Changes the style of the selected text FORMAT | FONT 

Font Changes the font for the selected text FORMAT | FONT 

Font Size Changes the point size of the selected text FORMAT | FONT 

Bold Makes the selected text bold FORMAT | FONT 

Italic Makes the selected text italic FORMAT | FONT 

Underline Underlines the selected text FORMAT | FONT 

Align Left Aligns the selected text/paragraph(s) left FORMAT | PARAGRAPH 

Center Centers the selected text/paragraph(s) FORMAT | PARAGRAPH 

Align Right Aligns the selected text/paragraph(s) right FORMAT | PARAGRAPH 

Justify Justifies the selected text/paragraph(s) FORMAT | PARAGRAPH 

Numbers 
Creates a numbered list or numbers the 

selected paragraph(s) 
FORMAT | BULLETS AND 

NUMBERING 

Bullets 
Creates a bulleted list or adds bullets the 

selected paragraph(s) 
FORMAT | BULLETS AND 

NUMBERING 

Decrease Indent 
Decreases the indentation of the selected 

paragraph(s) 
FORMAT | PARAGRAPH  

Increase Indent 
Increases the indentation of the selected 

paragraph(s) 
FORMAT | PARAGRAPH 

Borders 
Creates a border around the selected 

text/paragraph(s) 
FORMAT | BORDERS AND 

SHADING 

Highlight Allows you to highlight specified text    

Font Color Allows you to change the color of the text FORMAT | FONT 

 
The Toolbar:- 

A toolbar is a bar containing buttons and options that you use to carry out commands. With toolbars, commands 
become just handy and easily accessible to users. The buttons contained in them are used to access commands more 
quickly than by opening the menus and the respective dialog boxes. 

 
Displaying A Toolbar Using the View Menu  

• On the Menu bar, click View. This displays the View menu. 

• Then, on the View menu, point to Toolbars item. 

• Select and click the name of the desired toolbar from the Toolbars sub-menu. The toolbar you selected 
will then appear on screen. 
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There are multiple toolbars options are available, some of them are frequently used. They are as followed:- 
 

1.Standard Toolbar:- the Standard toolbar is, by default, docked directly below the Menu bar, and it contains buttons 
used for performing tasks similar to the commands available in the Menu bar.  the name and purpose/use of each of 
the buttons on the Standard toolbar are as follows. 

 
NAME 

 
ICON 

 
USE 

New 
 

Creates a new blank document based on the  
default or current template. 

Open 
 

Opens a document previously created and saved in  
Word. 

Save 
 

Saves new changes to the current document or  
file, with its filename, location and document format. 

E-mail 
 

Sends the content of the current document as the  
body of an E-mail message. 

Search 
 

Finds files, Web pages and Outlook items based  
on the search criteria you enter. 

Print 
 

Prints the active document or selection. 

Print Preview 
 

Shows how a document or file will look when you  
print it. 

Spelling 
 

Checks spelling in the active document, file or  
item. 

Cut 
 

Removes the selected item from the active  
document and places it in the Clipboard. 

Copy 
 

Copies selected text or object to the Clipboard. 

Paste 
 

Pastes the item you cut or copied into (the  
position of the insertion point) the document from the Clipboard. 

Format Painter 
 

Copies the format from a selected text or object  
and applies it to the text or object you click. 

Undo 
 

Reverses the last action or deletes the last  
entry you typed. Click the arrow next to this icon to select and reverse  
multiple actions at a time. 

Redo 
 

Reverses the action of the last Undo command.  
Click the arrow next to this icon to select and reverse multiple Undo  
command actions. 

Insert Hyperlink 
 

Inserts a new hyperlink or edits the selected  
hyperlink. 

Tables and 
Borders  

Displays Tables and Borders toolbar, which  
offers tools for editing/formatting a table and its content. 

Insert Table 
 

Inserts a table in the document. Click and drag  

http://3.bp.blogspot.com/_d8vcEINJUSQ/TCPyc-WqXQI/AAAAAAAAAHQ/tqHC51AOVbY/s1600/New+Blank+Document.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCPy7c2Us2I/AAAAAAAAAHY/Xus4KdJY_OM/s1600/Open.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCPzBcjnUjI/AAAAAAAAAHg/lDAhsfDDTb0/s1600/Save.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCPzKhh4rYI/AAAAAAAAAHo/DZePXcomNbQ/s1600/Email.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPzTEL3RoI/AAAAAAAAAHw/Reuy10qtqkE/s1600/Search.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPzbuVVt2I/AAAAAAAAAH4/4_i57xJw6Yg/s1600/Print.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPzhE6DlcI/AAAAAAAAAIA/fRZZoWH2s_s/s1600/Print+Preview.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPznZVqSiI/AAAAAAAAAII/B5p25TE3SPI/s1600/Spelling+and+Grammar.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCPztSuHccI/AAAAAAAAAIQ/f-v4odNjsWI/s1600/Cut.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCPzy9q3WxI/AAAAAAAAAIY/peOy_6kf2gw/s1600/Copy.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPz4l1hNoI/AAAAAAAAAIg/UTjvIQpm4FA/s1600/paste.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCPz-Ch-MlI/AAAAAAAAAIo/grFzJg7v5Mc/s1600/Format+Painter.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCP0G81QQ7I/AAAAAAAAAIw/G3gTLNeaE0U/s1600/Undo.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP0MgciqAI/AAAAAAAAAI4/zt0w2CYvjaM/s1600/redo_COLORED.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCP0TvjgpFI/AAAAAAAAAJA/oITeMKqiric/s1600/Insert+Hyperlink.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP0ZG4YAEI/AAAAAAAAAJI/6CiJxwL_oxA/s1600/Tables_and_BordersCOLORED.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCP0jb-BWrI/AAAAAAAAAJQ/vnwIoV2ru_I/s1600/InsertTable_COLORED.jpg
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to specify the number of rows and columns. 

Insert Microsoft 
Excel Worksheet  

Inserts a new Microsoft Excel worksheet at the  
insertion point. Click and drag to specify the number of rows and columns.  
Use the Excel tools on the toolbar to edit the table. 

Columns 
 

Changes the number of columns in a document or a  
section of a document. 

Drawing 
 

Shows or hides the Drawing toolbar. 

Document Map 
 

Used to turn on or off the Document Map.  
Document Map shows the outline structure of a document so that you can  
quickly navigate through the document and keep track of your location in it. 

Zoom 
 

Used to "zoom in" to get a close-up view of a  
document or "zoom out" to see more of the page at a reduced size. 

Show/Hide 
 

Shows or hides non-printing characters, such as  
tab characters, paragraph marks and hidden text. 

Office Assistant  
(Microsoft 
Office Help) 

 

Opens Help or invokes the Office Assistant to  
provide help topics and tips to help you accomplish your task. 

 
2. Formatting toolbar:- The Formatting toolbar offers shortcut buttons to help format a document quickly. From 
the Formatting toolbar, you can quickly apply formatting attributes such as Font; Font Color; Alignment; Line Spacing; 
Bullets and Numbering, etc, document text, to save time. 

 
The following table provides a list of Formatting toolbar buttons and a brief description of each. 

 
NAME 

 
ICON 

 
USE 

Style 
 

Opens a Style drop-down list from which you can  
select one. 

Font 
 

Changes the font of the selected text or number.  
Click the drop-down arrow beside the box and select a font from the list. 

Font Size 
 

Changes the size of the selected text or number.  
Enter a size value in the box, or select an appropriate size from the  
drop-down list. 

Bold 
 

Applies or removes bold formatting to or from a  
selected text or number. 

Italic 
 

Makes selected text or number italic, but  
removes italic from selected text or number if it's already italic. 

Underline 
 

Underlines (rules a line)  or removes  
underline formatting from selected text or number. 

Align Left 
 

Aligns the selected text, number or inline  
object to the left with a jagged edge. 

Center 
 

Aligns selected text, numbers or inline objects  
to the center. 

Align Right 
 

Aligns the selected text, number or inline  
objects to the right, with a jagged edge. 

http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP0pa6vu7I/AAAAAAAAAJY/FaPGoRiCh_A/s1600/Insert_Microsoft_Excel_Worksheet.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCP00WOwKII/AAAAAAAAAJg/5CuYATcRSKo/s1600/Collumns.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCP1AptbwxI/AAAAAAAAAJo/kM3DM1jBstI/s1600/Drawing.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP1GTxzoXI/AAAAAAAAAJw/9D6XzBM3uW4/s1600/DocumentMap.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP1NHEojTI/AAAAAAAAAJ4/gRYmdpSgQm8/s1600/Zoom.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCP1WIm1vWI/AAAAAAAAAKA/cLQ3nIc497A/s1600/Show_Hide_Pa.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCP1fQcJIQI/AAAAAAAAAKI/dgN0SwfV7yk/s1600/MicrosoftWordHelp.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCZmTS6HK3I/AAAAAAAAALA/72Dogbpk7_c/s1600/Style.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZoI7U46PI/AAAAAAAAALI/XJNGtsJvpN8/s1600/FontBox.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCZorJX4d4I/AAAAAAAAALQ/JbyVxseJjKQ/s1600/Font+Size.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZo6ANnAHI/AAAAAAAAALY/W4Fw-Jnmn2Q/s1600/Bold.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZpYGcfKCI/AAAAAAAAALo/aLKrrY23VO0/s1600/Italic.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCZpyd75wzI/AAAAAAAAALw/DzJYN-07csI/s1600/Bullets.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCZqRSTpC2I/AAAAAAAAAL4/hWKxZu2yI3U/s1600/Align+Left.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCZqY3s20AI/AAAAAAAAAMA/X2TGuv8yg7o/s1600/Center.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZqggxhSTI/AAAAAAAAAMI/C3Ftjnw97gQ/s1600/Align+Right.jpg
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Justify 
 

Aligns the selected paragraphs to both the left  
and right margins or indents. 

Numbering 
 

Adds numbers to or removes numbers numbers from  
selected paragraphs. 

Bullets 
 

Adds bullets to or removes bullets from the  
selected paragraphs. 

Decrease 
Indent  

Indents the selected paragraph to the previous  
tab stop or indents the content of the selected item to the left by one  
character width of the standard font. 

Increase 
Indent  

Indents the selected paragraph to the next tab  
stop or indents the content of the selected item to the right by one  
character width of the standard font. 

Outside 
Border  

Adds or removes a border around the selected  
text, paragraphs, cells, pictures or other objects. 

Highlight 
 

Marks text so that it is highlighted and stands  
out from the surrounding text. 

Font Color 
 

Formats the selected text with the color you  
click 

 
3.Drawing Toolbar:- The Drawing toolbar is located at the bottom of the window, between the Horizontal Scroll 
bar and the Status bar. Like every other toolbar, this also contains smart icons representing shortcuts to Main menu 
commands in Word. 

It holds buttons/tools used in creating drwaings, such as rectangles, ovals, lines, arrows, WordArt text, etc. It also 
offers tools for inserting organizational charts and ready-made pictures and Clip Arts from their different locations. 
     Also included in this toolbar are tools for formatting inserted objects and for adding special effects such as shadow 
or 3-D to lines, rectangles, ovals, etc. Like every other toolbar also, the Drawing toolbar can be displayed or hidden. 
 
The following table shows a list of tools offered on the Drawing toolbar, and their functions: 

 
NAME 

 
ICON 

 
USE 

Draw 
 

Offers a number of options for defining the  
relative positions, arrangements, rotation, etc, of drawings in a document.  
It also offers tools for changing the shape of AutoShapes. 

Select Objects 
 

Changes the pointer to a selection arrow so you  
can click to select objects in the active window. 

AutoShapes 
 

Offers a group of ready-made shapes that include  
basic shapes, such as rectangles and circles, including a variety of lines  
and connectors, block arrows, flowchart symbols, stars and banners, and  
callouts. 

Line 
 

Allows you to draw a straight line where you  
click or drag in the active window. 

http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZqpHoPWJI/AAAAAAAAAMQ/OLcBFTgiVb8/s1600/Justify.jpg
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Arrow 
 

Draws or inserts a line with an arrow head where  
you click or drag in the active window. 

Rectangle 
 

Draws a rectangle where you click and drag on  
the active window. You can also draw a square using this tool by holding  
SHIFT while you drag. 

Oval 
 

Draws an oval where you click and drag in the  
active document. To draw a (perfect) circle, hold down SHIFT while you 
drag. 

Text Box 
 

Draws a text box with horizontal direction where  
you click and drag in the active document. 

Insert WordArt 
 

Creates decorative text by inserting a Microsoft  
Office drawing objects. 

Insert Diagram 
 

Creates an organizational chart or a circle,  
radial, pyramid, or Venn or target diagram in your document. 

Clip Art 
 

Opens the Clip Gallery where you can select the  
clip art image you want to insert in your document or update your clip art  
collection. 

Insert Picture 
 

Inserts an existing picture in your  active  
document at the insertion point. 

Fill Color 
 

Adds, modifies, or removes the fill color or  
effects from the selected object. 

Line Color 
 

Adds, modifies, or removes the line color from  
the selected object. 

Font Color 
 

Allows you to add, modify, or remove the text  
color of the selected text. 

Line Style 
 

Used to select a thickness for the selected  
line. 

Dash Style 
 

Allows you to control the appearance of the  
selected line. 

Arrow Style  
 

Allows you to select the style of arrowhead. 
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http://3.bp.blogspot.com/_d8vcEINJUSQ/TCaHRiCUXwI/AAAAAAAAAOA/p2qLd9FMbUQ/s1600/Rectangle_COLORED.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaKGISF4MI/AAAAAAAAAOY/UDcyWGjsz54/s1600/Oval_COLORED.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaKUhEpC8I/AAAAAAAAAOg/f8xxa--H70I/s1600/Text+Box_COLORED.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaKiio77gI/AAAAAAAAAOo/TAJs69_Gjcw/s1600/Insert+WordArt_COLORED.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCaK2RKfC4I/AAAAAAAAAOw/P4zT91N-n-g/s1600/Insert+Diagram+or+Organizational+Chart_COLORED.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCaLMpUs7rI/AAAAAAAAAO4/jsn-9Seq2-g/s1600/Insert+ClipArt.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaLghlJS9I/AAAAAAAAAPA/LeW0O0qJsYg/s1600/Insert+Picture.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaL3gs_9EI/AAAAAAAAAPI/wjNU23VvBkY/s1600/Fill+Color.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaMIDbv__I/AAAAAAAAAPQ/DXkrWClLQLY/s1600/Line+Color.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaMWpT5H6I/AAAAAAAAAPY/PQc4VY6f3vQ/s1600/Font+Color.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaMf-FgVkI/AAAAAAAAAPg/ImJEIJoIyPw/s1600/Line+Style.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCaMuY_P2qI/AAAAAAAAAPo/cPU3-NBP75M/s1600/Dash+Style.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaM5n9LGTI/AAAAAAAAAPw/Eaxi_9JHJqU/s1600/Arrow+Style.jpg


International Multidisciplinary Book Series Vol. 1, Issue 1 (2023) 

 https://ibseries.com/index.php/IMBS/ 

 

 

 

85 

Shadow Style 
 

Allows you to select the shadow appearance of  
the selected drawing object. 

3-D Style 
 

Allows you to add depth to drawing objects such  
as lines, AutoShapes, and freeform objects. 

 
 

Ruler:- The ruler is a measurement tool found with some software programs that allow the program's user to align 
graphics, text, tables, or other elements on a page. When enabled the horizontal ruler appears at the top of the 
document, and the vertical ruler is on the left-side of the document. In the pictures below are examples of how the 
ruler may appear in Microsoft Word. 
 

 
 
How to enable and disable the Ruler in Microsoft Word:- 

• Click the View drop-down-menu at the top of Word. 

• Check Ruler to enable the Ruler or uncheck Ruler to disable the Ruler. 

•  

  
 
Menu(Menu Bar):- The menu bar is the part of a browser or application window, typically at the top left side, 

that houses drop-down menus that allow the user to interact with the content or application in various ways.   
In Microsoft Word, for example, the "File" menu, for example, provides options to open a file, create a new one, 

and save or print -- among others. The "Edit" menu allows the user to perform such functions as copying and pasting, 
finding and replacing text. Some of them are as follows:- 

 
1.The File Menu:-The file menu is one you will find yourself using extensively. It is used to create new documents, 

open existing documents and saving your new/updated documents. It also includes the page setup, print preview, and 
other important functions relating to your document and its properties.  

 

http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaNELptoJI/AAAAAAAAAP4/H0DZGrMiu6M/s1600/Shadow+Style.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCaRVJGejDI/AAAAAAAAAQA/MOq4zrcH1Y8/s1600/3-D+Style.jpg
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New: This creates a new Microsoft Word document. The page setup of the new document, ie, the size, margins, 

etc, will depend on your page settings.  
Open: This opens an existing Microsoft Word document, it will open a file explorer window allowing you to 

navigate to the file you want to open.  
Close: This will close the current word document. Microsoft Word may prompt you to save the file, if you have 

made changes to the document since the last save. 
Save: Saves the current document, replacing the existing file (if previously saved).  
Save As: This allows you to save the document as a different file. This is very useful, imagine you open your 

letterhead template and write a letter that you want to save, if you just saved it (using the option above), it would 
replace your letterhead template. When you click on Save As you will be able to choose the new filename and location 
for your document.  

Save As Web Page: This option will save the current document with the HTM(L) extension, allowing it to be 
viewed by a web browser.  

Search: Clicking Search will open the basic search window, allowing you to search your computer for documents 
containing certain text.  

Versions: This feature allows you to save different versions of the current Microsoft Word document. For 
example, if you changed your letterhead and wanted to keep the older version too. 

Web Page Preview: Clicking on this option will display your current document as it would look in a web browser. 
When you click, Microsoft Word will open the document in your default web browser. 

Page Setup: This opens the page setup options dialogue box. It allows you to set the properties (dimensions, 
margins, etc) of the current document and change the default for new Microsoft Word documents.  

Print Preview: Selecting this option opens the print preview window, allowing you to preview how your document 
will look when printed. 

Print: Opens the print dialogue box allowing you to print the current document. 
Send To: Hovering your mouse over this option will allow you to send your document via email, or export it to 

Microsoft Powerpoint (if installed). 
Properties: This will open the Microsoft Word document properties dialogue box, allowing you to view/edit 

various properties of the document. Including author information, statistics, type, location and filesize of the 
document.  

Exit: Clicking this will exit Microsoft Word, it may prompt you to save any unsaved documents.  
 

http://www.helpwithpcs.com/software/microsoft-word-margin-setup.php


International Multidisciplinary Book Series Vol. 1, Issue 1 (2023) 

 https://ibseries.com/index.php/IMBS/ 

 

 

 

87 

 
2.The Edit Menu:-The edit menu, as its name suggests, includes commands relating to the editing of your 

document. It includes important editing features such as undo, repeat, cut, copy, paste, select all, find, replace and 
more.  

Undo (last task): This option allows you to undo the last thing you did in your Microsoft Word document, in our 
example (fig 1.1) you can see our last action was to type some text. This is a handy command, especially if you delete 
something by accident. 

 

 
 
     Repeat (last task): This repeats your last action. In our example clicking on the Repeat Typing will repeatedly 
insert the same piece of text into the document.  

Cut: This command will cut (delete) the currently selected element. For example if you highlight (select) some text 
and then click on cut, it will be deleted.  

Copy: The Copy command will copy the curently selected element (text, image, etc) into the office clipboard. It 
can then be inserted (pasted) into a document using the Paste command (see below), which will appear in the edit 
menu once you have copied something to the office clipboard.  

Office Clipboard: This command will display the current contents of the office clipboard, allowing you to click 
on the stored elements to insert (paste) them directly into the current document. Elements (text, images, etc) can be 
added to the clipboard using the Copy command (see above), this clipboard will also show any elements stored in the 
Windows Clipboard.  

Paste: This will paste (insert) into the current document the last element to be stored in the Office Clipboard.  
Paste Special: Clicking on this command will bring up the Microsoft Word Paste Special dialogue box, it allows 

you to control the format of the text that will be inserted (pasted) from the Office/Windows clipboard.  
Paste as Hyperlink: This command allows you to link (create a hyperlink) to a certain place in another Microsoft 

Word document, Excel worksheet, PowerPoint slide, or Access database. To achieve this, first copy the element that 
you want to link to into the clipboard, and then select the Paste as Hyperlink command.  

Clear: This command allows you to remove any formatting from the currently selected (highlighted) element 
(text/image). It also allows you to delete the selected element.  

Select All: This will select (highlight) every element in the current document.  
Find: Find allows you to search the current document for a certain word or phrase.  
Replace: Replace allows you to replace a given text with a substitute of your choice.  
Goto: Goto allows you to go directly to a certain page, section, line, bookmark, comment, footnote, endnote, field, 

table, graphic, equation, object, or heading.  

http://www.helpwithpcs.com/jargon/database.htm
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Links: This allows you to manage any linked objects in the current document. A linked object is information (data) 
that is stored in another file, for example a Microsoft Excel spreadsheet, Microsoft Access database, or other 
compatible source. We will be covering linked objects in a future Microsoft Word tutorial.  

Objects: This command allows you to manage any embedded objects within the current document.  
 
3.The View Menu:- This menu is used to control not only the visual layout of your Word document but also the 

printing configuration. It is also used to select which toolbars are visible in the Word environment. Commands include 
web layout, print layout, outline, task pane, toolbars, ruler, header and footer, footnotes, full screen view and zoom.  

 

 
 
Normal: Selecting this will show your current document in a layout without the document margins.  
Web Layout: The Web Layout view will show you how the current document will look on a web browser, a full-

screen layout.  
Print Layout: This view will show the document in a layout including all margins and page breaks.  
Outline: The Outline view allows you to change the structure of your document, when selected it will open the 

Outline Toolbar. The Outline Toolbar allows you to, amongst other things, move headings up or down and/or change 
the heading types.  

Task Pane: This command toggles (shows/hides) the Task Pane. The task pane is designed to give you quick 
access to frequently used commands, including Document Commands, The Office Clipboard, Basic Search, Style and 
Formatting and more.  

Toolbars: When you hover your mouse pointer over Toolbars you will be presented with a submenu, this includes 
all of the different toolbars that are available. You can toggle (hide/show) the different toolbars by simply clicking on 
them within the submenu.  

Ruler: Clicking on this will toggle (hide/show) the document ruler which appears across the top and down the 
side of the Microsoft Word document.  

Document Map: The document map is a handy feature which allows you to navigate the current document, it 
will list the headings (heading 1, heading 2, etc) in the current document. To go directly to a certain paragraph heading, 
simply click on it in the left hand pane that opens.  

Header and Footer: This allows you to edit the header and footer of the current document. We show you how 
to edit the header and footer in our letterhead tutorial here.  

Footnotes: This command will show all footnotes and endnotes (you will be promoted for which) within the 
current document. Footnotes and Endnotes will be covered in a future Microsoft Word tutorial.  

Markup: This will toggle (hide/show) any Markup (comments and tracked alterations/additions) in the current 
document.  

Full Screen: This will show the current Microsoft Word document in full screen mode.  
Zoom: This will open the zoom dialogue box, enabling you to change the percentage of zoom for the current 

view.  
 

http://www.helpwithpcs.com/software/create-letterhead-word.php
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4. The Insert Menu:-  
The insert menu is used to place various objects into your document, such as page numbers, pictures, symbols, 

comments and other objects. Commands include break, date and time, field, symbol, reference, web component, text 
box, file and hyperlink.  

 

 
 

Break: This command opens the Break dialogue box, allowing you to insert page breaks and section breaks into 
the current document. 

Page Numbers: Clicking on Page Numbers will open a dialogue box, which allows you to insert page numbers 
into the document using various options.  

Date and Time: This command will open the Date and Time dialogue box. You can choose from many different 
date and time formats, you may also have different languages to choose from. 

Autotext: Choosing this option will open the Microsoft Word Autotext dialogue box. We will cover Autotext in a 
future tutorial.  

Field: This command allows you to enter specified fields into your document. The available fields include Date & 
Time, Document Automation, Document Information, Equations and Formulas, Index and Tables, Links and 
References, Mail Merge, Numbering and User Information.  

Symbol: This allows you to insert symbols and special characters into your document. For example, if you wanted 
to include a copyright symbol or a trademark symbol, then you would use this feature. Other symbols (special 
characters) include currency symbols, mathematical symbols and foreign language alphabet characters.  

Comment: This command will place a comment into the document at the location of the cursor. You will be able 
to type your comment into the comment box, once done, simply click anywhere outside of the comment box. 

Reference: The Reference command will allow you to insert a footnote, caption, cross-reference, index, and tables. 
Web Component: This command is used to insert any web components into your Microsoft Word document. 
Picture: Allows you to insert a picture into your document. You will be offered various locations to locate the 

image, including clip art, the file system on your computer, and a digital camera or scanner.  
Diagram: The Diagram command will open the diagram gallery dialogue box. You can choose from a selection 

of diagrams to insert into your document, including an organization chart, cycle diagram, radial diagram, pyramid 
diagram, venn diagram and a target diagram. You may have less or more diagrams available to insert, depending on 
your Microsoft Word installation.  

Text Box: This allows you to insert text boxes, we will be covering text boxes in a future tutorial.  
File: Enables you to insert part or all of a file into the current document.  
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Object: This command will insert an object of your choice, including media clips, Microsoft Excel charts and 
worksheets, Microsoft Powerpoint slides and presentations.  

Bookmark: This handy feature allows you to bookmark a certain element (text, image, etc). You can name the 
bookmark and then return to it at any time by using the goto command in the edit menu. 

Hyperlink: The Insert Hyperlink dialogue box allows you to add a hyperlink to an existing file, web page, certain 
place in the current document, a new document, or an email address.  

 
5.The Format Menu:- 
A guide to the format menu which controls your font's properties along with the borders and shading options. 

Commands include paragraph, bullets and numbering, columns, tabs, text direction, background, autoformat, reveal 
formatting and more.  

Font: This will change the font attributes of either the currently selected text, or any subsequent text, using the 
font dialogue box.  

Paragraph: This command will open the Paragraph dialogue box, allowing you to make changes to either existing 
text or subsequent text. To change an existing paragraph, select the text you wish to change and then use this command 
to make the alterations, such as alignment, indentation, and spacing. 

 

 
 
 
    Bullets and Numbering: This is a handy command, it creates indented lists with various formats. You can either 
click the command and then start typing your list (pressing enter for the next line), or you can select some existing text 
to convert to a list. The listing format options include bulleted, numbered, outline numbered, and other styles.  

Borders and Shading: This command allows you to create borders and shading on elements within your 
Microsoft Word document. The borders and shading can be applied to text, paragraphs, pictures, and more.  

Columns: The Columns command will split the current document into the number of columns you specify. You 
can either split the whole page, or just from that point onwards.  

Tabs: This command allows you to manage tabs, including the alignment, spacing, and whether the tab has a leader 
or not.  

Drop Cap: A drop cap is a letter at the start of a paragraph of text that spans 2 or more rows of text, you will 
often see a drop cap in a book at the start of a chapter. This tool allows you to either add a drop cap character to your 
document or change an existing letter (at the start of a sentence) to a drop cap.  

Text Direction: This allows you to change the text direction of a text object, for example a text box.  
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Change Case: The Change case tool allows you to alter the case of existing text. Options include sentence case, 
lowercase, uppercase, title case, and toggle case.  

Background: This changes the background colour (color) of your Microsoft Word document. It also allows you 
to add watermarks and use different gradient effects.  

Theme: The themes command will open the theme dialogue box, allowing you to change the theme of your 
document, including heading style, hyperlinks and background colour (color).  

Frames: This command opens the Frames dialogue box.  
AutoFormat: The AutoFormat feature will format a whole document with preset attributes.  
Styles and Formatting: This will open the Styles and Formatting toolbar, allowing you create headings, lists and 

more.  
Reveal Formatting: Clicking on this will show a dialogue box detailing the format attributes of the selected 

element. 
Object: Allows you to make changes to any existing objects within the current document.  
 
6.The Tools Menu:- 
The tools menu will also be one you may use regularly, it includes the options command which controls spelling 

and grammar, security and more. Commands include language, word count, speech, letters and mailing, macro, 
customize and more.  

 

 
 
Spelling and Grammar: This command will check the spelling and grammar of the current Microsoft Word 

document. It also allows you to add words to the dictionary, as well as changing the dictionary language (if available). 
Language: The language tool has various options, including setting the language of the document, translating text, 

open the thesaurus and manage hyphenation. 
Word Count: This will open the Word Count dialogue box, enabling you to count the amount of words in the 

whole document, or the currently selected text. 
AutoSummarize: This can be a handy feature of Microsoft Word, depending on the type and format of your 

document. It will summarize a document using the attributes you give it, for example, you can choose the percentage 
of the document to be used for the summary, as well as the format of the summary.  

Speech: This will open the Speech Recognition feature of Microsoft Word (if installed/available).  
Track Changes: Clicking on this command will cause Microsoft Word to track any subsequent changes to the 

document. These changes can then be viewed by turning on the Markup option on the Edit menu. 
Compare and Merge Documents: This feature enables you to easily compare and/or merge 2 documents. 
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Protect Document: This command allows you to control the protection of the document, including tracked 
changes, comments and forms. 

Online Collaboration: Enables NetMeeting allowing you to communicate with others in real time via the internet 
or local network. 

Letters and Mailing: Gives you access to various features, including the Mail Merge Wizard, the Letter Wizard, 
the Envelopes and Labels tool, and the Mail Merge Toolbar.  

Macro: This opens the Macro Dialogue box, allowing you to manage subsequent and existing macros. We will be 
covering Microsoft Word macros in a future tutorial. 

Templates and Add-Ins: Opens the Templates and Add-Ins Dialogue box, allowing you to add, remove or update 
styles and template. 

AutoCorrect Options: Opens the AutoCorrect dialogue box, enabling you to manage capitalisation, and also the 
replace text as you type settings. 

Customize: Allows you to customize the Microsoft Word toolbars, commands, and other options. 
Options: This opens the main options dialogue box in Microsoft Word. It allows you to change many aspects of 

the current document and Microsoft Word environment.  
 
7.The Table Menu:- 
Tables are a great way of laying out content within your document. The table menu provides all you need to manage 

your tables and cells. Includes draw table, insert, delete, merge cells, split cells, split table, autoformat, convert, sort 
and more.  

 

 
 
Draw Table: This command opens the Tables and Borders dialogue box with the draw table tool active. First you 

draw the outline of your table, then using the same tool, you can create cells by vertical or horizontal movements 
within the table. 

Insert: Allows you to insert a whole table or just columns, rows and cells into the current document.  
Delete: Delete complete tables, columns, rows and selected cells.  
Select: This command allows you to select the current table, column, row or cell.  
Merge Cells: This tool will merge the currently selected cells into one.  
Split Cells: This will split the selected cell/s into your chosen amount of columns and rows, it will also offer (if 

more than one cell selected) to merge the selected cells before the split.  
Split Table: This command will split the current table, making the split at the currently selected cells.  
Table AutoFormat: This command will open the Microsoft Word Table AutoFormat dialogue box, where you 

can choose from a number of different table templates, including preset fonts and cell background colours (colors).  
AutoFit: This tools gives you several options for resizing the selected table in relation with the contents or window. 
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It also allows you to automate the distribution between columns and rows. 
Heading Rows Repeat: This handy tool will repeat the currently selected row at the top of every page for the 

length of the table.  
Convert: This command will convert existing text into a table format. The text will have to have a common 

separator to indicate the different columns, it will also needs new paragraphs where you would like each row. 
Sort: This opens the Sort Table dialogue box. You can choose which column you would like to sort and by what 

order.  
Formula: This tool allows you to apply a formula to the selected cell. For example, if you wanted to add up the 

contents of several rows in a specific column, you could use the SUM formula in the Formla dialogue box.  
Hide Gridlines: This simply hides the gridlines of the selected table. 
Table Properties: This will display the various properties of the selected table.  
 

Keyboard Shortcuts in MS Word:-  
 

Commonly used keyboard combinations 

Ctrl+N  
 

Open a new word document 
quickly. 

Ctrl+X  
 

Cut- Removes the selection from the 
active document and places it on the 
clipboard. 

Ctrl+O  
 

Opens a previously saved 
document. 

Ctrl+C  
 

Copies the selection to the clipboard 

Ctrl+W  
 

Closes the active window, but 
does not Exit Word. 

Ctrl+V  
 

Paste - Inserts the contents of the 
clipboard at the insertion point (cursor) 
or whatever is selected. 

Ctrl+S  
 

Saves the active document 
with its current file name, 
location and format. 

Ctrl+A  
 

Selects all text and graphics in the 
active window. 

Ctrl+P  
 

Prints the active file, also 
gives the opportunity to change 
print options 

Ctrl+F  
 

Find - Searches for specified text in 
the active document 

Alt+F4  
 

Exit - Closes Microsoft 
Word. 

Ctrl+B  
 

Bold - Formats selected text; make 
text bold, or remove bold formatting 

Ctrl+Z  
 

Undo the last action. This 
selection can be repeated several 
times. 

Ctrl+I  
 

Italic - Formats selected text; make 
text italic or remove italic 

Ctrl+Y  
 

Redo - After an action has 
been undone, it can be reinstated 
in the document. 

Ctrl+U  
 

Underline - Formats selected text; 
make text underlined or remove 
underline 

 
Less commonly used keyboard combinations  

 

Increase selected text in increments 
like the drop down font menu (Thanks 
Daniel) 

 

Apply superscript 
formatting 

 

Decrease selected text in increments 
like the drop down font menu  

Apply subscript 
formatting 

 

Increase selected text one point 
 

Copy formats 

 

Decrease selected text one point 
 

Paste formats 

 

Change case of the letters 
 

Single space lines 

 

Underline words but not spaces 
 

Set 1.5 line spacing 
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Double underline text 
 

Double space lines 

 

Center a paragraph 
 

Delete one word to 
the left 

 

Justify a paragraph 
 

Delete one word to 
the right 

 

Left align a paragraph 
 

Right align a 
paragraph 

 

Indent a paragraph from the left 
 

Insert a line break 

 

Create a hanging indent 
 

Reduce a hanging 
indent 

If text is already selected and you want to extend the selection area  

 

Extend selection one character to the 
left  

Extend selection one 
character to the right 

 

Extend selection to the end of a word 
 

Extend selection to 
the beginning of a word 

If you want to move the cursor  

 

One character to the right 
 

One character to the 
left 

 

One word to the right 
 

One word to the left 

 

To the end of a document 
 

To the beginning of a 
document 
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Abstract 
This chapter provides a detailed understanding of editing and formatting operations in Microsoft Word, which are 
essential for creating professional and well-structured documents. It begins by explaining the concept of editing, 
including fundamental operations such as adding, deleting, copying, moving, and pasting text. These operations form 
the basis of document modification and content management in word processing. 
The chapter further explores various formatting techniques, including character formatting, paragraph formatting, 
page formatting, and the use of bullets and numbering. It highlights the importance of formatting in enhancing 
document readability and presentation. Advanced features such as borders and shading, headers and footers, footnotes 
and endnotes, and page setup options are also discussed. 
In addition, the chapter explains document previewing and printing processes, including print preview features, print 
dialog options, and page range selection. These tools help users ensure accuracy and layout correctness before 
producing a hard copy. Overall, this chapter equips users with practical skills required for efficient document editing, 
formatting, and printing in Microsoft Word. 
 
Keywords 
Document Editing, Text Formatting, Microsoft Word, Copy Paste, Cut Operation, Paragraph Formatting, Page Setup, 
Print Preview, Headers and Footers, Footnotes, Document Processing, Office Applications. 
 
Editing A Word Document:-  

Editing a word file means making changes in the text contained in a file. Everyone needs to edit a word file at some 
point or other to incorporate the changes which may arise. Editing a word file is one of the most basic MS office word 
operations. Editing a file covers these basic areas. 

• Adding new text. 

• Deleting a part of the text 

• Copying a text. 

• Moving text. 

• Pasting text. 

• Formatting text. 
 
Thus, following are the simple operations for editing a word file. 
 

1.For Adding New Text 
If you want to add new text at the end of a file, simply place the cursor to the end part and start typing using the 

keyboard. 
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For adding text in between a document, place the cursor to the required portion and start typing. 
 

2.Deleting A Part of The File 
If you wish to delete some parts from the end of the file, take the cursor to the end point and keep pressing 

“Backspace” till the text is cleared. 
You can also select the part you want to clear by left clicking on the text and dragging the mouse along. After the 

part has been selected, simply click “Backspace” and the text gets deleted. 
 

3.Copying A Text 
If you want to copy an entire word file, simply select the whole file or use keyboard shortcut Control + A and then 

right click to select the option “Copy”. You can also use keyboard shortcut Control + C. Doing so will copy the entire 
text. 

If you want to copy selected text, you need to select the part of the text initially by left clicking and dragging the 
mouse and then follow the same procedure. 

 
4.Moving Text 

• If you want to move some text from one part of the document to another, simply select the part. 

• Right click upon the selected part and choose “Cut”. 

• Move to the desired location where you want to move the cut part. Place the cursor at the desired place. 

• Click paste or use Control +V. 

• The text block has moved from one part to another. 
 

5.Pasting Text 
Pasting a text is also simple as the copied contents simply need to be put in the desired place by right clicking and 

using “Paste” option. Keyboard shortcut Control + V also does the same. 
 

6.Formatting A Text 
Formatting refers to changing the font style, size, italics and other related parameters. A good formatted text can 

help in creating a nice impression. Further, formatting is required to highlight certain important factors and points.     
The main steps to consider while formatting are as follows. 

• Select the text that you want to format. If it is the entire document, click Control + A or select the specific 
portion. 

• After you have selected the part, you want to format, click on the Home tab in the top row. 

• You can see a dropdown list with font name and adjacent to it you have another drop down list displaying 
font size.  
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As you can see, there are various fonts and you may select the one you want. 
 

 
 

As you can see in the above screenshot, you may alter font size with the drop box. You can change either of them 
if you want another font or different size. 

 

 
 

• You can adjust more with advanced font settings. 

• Just below the font name and size, you have another row with options like 

• Bold: if you want to bold some points, click on the icon. To remove bold, click again. 

• Italics: for italicizing a portion, click “I”. For removing the italics, click it again. 

• Underline: if you wish to underline a part, click on the “U” button. Clicking on the same button again will 
remove the underline. 
 

 
 

As you can see, the different options like Bold, Italics, and Underline are present in the home tab itself. There are 
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other options as well, like make a strikethrough, use subscript, change case from lowercase to uppercase or vice versa. 
You can even capitalize the first letter of each word or highlight a certain part using different colors. 

 
Formatting document:- 
(i) Character Formatting: before applying character formatting you have to select the text, after selecting the text click 
on Font on Format menu and provide required settings such as: 

(a) Under font tab: font, font style, size, font color, under-line. 
(b) Under font tab: effects – emboss, shadow, superscript, subscript etc. 
(c) Under character spacing tab: scale, positioning etc. 
(d) Under text effect tab: las vegas light etc. 
 

(ii) Border and Shading: to apply border and shading, select the text and click on Border and Shading on Format menu. 
(a) use Border tab: to apply border color, border type etc. 
(b) use Page Border tab: to apply border color, border type to the whole page. 
(c) use Shading tab: to apply fill color and pattern. 
 

 (iii) Paragraph Formatting: before apply paragraph formatting select the paragraph if formatting is to be applied on 
multiple paragraph or, position insertion point on paragraph if formatting is to be applied on single paragraph then 
click on Paragraph on Format menu and provide required settings such as: 

a) Under Indent and Spacing tab: Set alignment of paragraph, specify paragraph alignment such as left, right, 
center, justify and outline level 

b) Under Indent and Spacing tab: Set paragraph indentation or margin such as left indent, right indent, under 
special specify first line indent, hanging indent. 

c) Under Indent and Spacing tab: Set paragraph spacing such as paragraph before space, paragraph after space, 
spacing between lines in paragraph. 

 
(iv) Bullets and Numbering: Select the items you want to add bullets or numbering to. On the Formatting toolbar, 
click Bullets or Numbering to apply bullets and numbering. To remove bullets and numbering from items select the 
items, on the Formatting toolbar, click Bullets or Numbering. 

 
(v) Page Formatting: formatting of page can be performed using following commands and their settings: 

(a) Page Setup:  
Under Margin tab specify, left, top, right, bottom margin, gutter margin(margin for binding the pages), orientation 

of page (portrait or landscape). If you select mirror margin from Multiple pages, left and right margin becomes inside 
and outside margin and gutter position is set to left, mirror margin and gutter margin are useful when book is going 
to be prepared with bindings. 

 
Under Paper tab specify paper size, paper source for first page and remaining page, height and width of custom 

paper size. 
Under Layout tab specify margin for header and footer text. page if you want to set different header and footer 

text for first page, odd page and even page tick mark the option different odd and even, different for first. You can 
set line numbers and border for page. 

 
(b) Setting Header, Footer and Page no.: Header is the text that appears on top of page and footer is the text that 

appears on bottom of the page. You can set title of chapter, author of the chapter or publisher, page no., date, time 
or any thing that you want as header or footer text. 

1. On the View menu, click Header and Footer to open the header or footer area on a page. 
2. To create a header, enter text or graphics in the header area click on Insert Page No. icon on Header and 

Footer toolbar . 
3. To create a footer, click Switch Between Header and Footer icon on the Header and Footer toolbar to move 

to the footer area, and then enter text or graphics. 
4. If necessary, format text by using buttons on the Formatting toolbar. 
5. When you finish, click Close on the Header and Footer toolbar. 
 

Setting Footnote and Endnote: 
Footnotes and endnotes are used in printed documents to explain, comment on, or provide references for text in 

a document. You might use footnotes for detailed comments and endnotes for citation of sources. 
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1. In print layout view, click where you want to insert the note reference mark. 
2. On the Insert menu, point to Reference, and then click Footnote. 
3. Click Footnotes or Endnotes. By default, Word places footnotes at the end of each page and endnotes at the 

end of the document. You can change the placement of footnotes and endnotes by making a selection in the 
Footnotes or Endnotes box. 

4. In the Number format box, click the format you want. 
5. Click Insert. Word inserts the note number and places the insertion point next to the note number. 
6. Type the note text 
 

Print preview:- Print preview is a feature that allows you to view what a printed version of the document would look 
like on the screen before printing a hard copy. By using print preview, you can find any errors that may exist or fix the 
layout before printing, which can save ink or toner and paper by not having to print more than once. 

To open the print preview feature, click the print preview icon on the toolbar, like that shown in the picture or 
click File and choose the Print Preview option. 

 

 
 

Shortcut keys 
Microsoft Word - Press Ctrl + F2 to open the print preview for the document you're currently viewing. 
Or Choose File Print Preview from the menu bar. 
 

 
 
 
Once you have accessed Print Preview, your document will now be in Print Preview mode. It will look something 

like this: 
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Print Preview mode displays how your file is formatted. If you want to take a closer look, use the zoom feature. 

The zoom feature zooms in closer, giving you a better view of your file. 
 

Following is the  Print Preview toolbar: 

 
 
 

• The Print button prints a file. 

• The View Ruler button displays the vertical and horizontal rulers. Rulers help edit margin settings. 

• If your file consists of multiple pages, the Multiple Pages button allows you to either view one page or 
several pages at a time. 

• Use zoom, then use the scroll bars to view your file. 

• Use the Shrink to Fit button to fit your information to one page. 

• If you want to exit or close Print Preview, click Close on the Print Preview toolbar. 
 

Print :- To print the work following commands can be used : 
 
1.Choose File Print from the menu bar (Ctrl+P). 

The print dialog box will appear. 
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Or Click the Print button on the Standard toolbar. 

The file automatically prints. The print dialog box will not appear. 
 
The Print dialog box:-  Following image shows that how the Print dialog box looks like and has following options 

in Word : 
Printer selection 
In the Name: drop-down box, the name(s) of your printer display(s). When working in an office environment, it 

is possible that your computer is part of a network that accesses several printers. Make sure you direct your print job 
to the correct printer. 

Page range selection 
The default setting is all. If you want to print only the current page, select the current page radio button. If you 

want to print only part of a document but it is more than one page, select the Pages radio button and enter the page 
numbers you want to print. 

Copies selection 
In this section, there is a Number of copies: box. The default setting is 1 copy. Manually enter the number you 

want to print by highlighting the number. Enter the number of copies you want to print. You can use the up or down 
arrows to indicate the desired number of copies. 

Collate is the default setting. Collate means to put pages in the proper order. If you want to turn off the collating 
feature, deselect the radio button. This means if you print more than one copy of a document, all of the first pages 
will print together, all of the second pages will print together, and so on. 

 

 
Print what section 

• You want to print a document. Leave this at the default setting. 

• Print section 

• The default setting is all pages in range. However, in the drop-down box, select even pages or odd pages 
if you want, or select a range of pages. 
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Gawakshi Choudhary 
Dungar College, department of Geography,India 

 
 

Abstract 
This chapter provides an in-depth exploration of advanced features of Microsoft Word, focusing on tools that enhance 
productivity, automation, and document quality. It begins by introducing advanced functionalities such as styles, tables, 
bookmarks, watermarks, hyperlinks, templates, and document conversion into formats like PDF. These features 
enable users to create structured and professional documents efficiently. The chapter further explains powerful tools 
such as Find and Replace, which facilitates quick navigation and modification within large documents, and the 
Thesaurus, which assists in improving vocabulary and writing quality. It also covers automation features including 
AutoText, AutoCorrect, and AutoFormat, which streamline repetitive tasks and improve consistency. 
A significant portion of the chapter is dedicated to Mail Merge, explaining its process and applications in generating 
personalized documents such as letters, labels, and emails. Additionally, the chapter discusses working with tables, 
graphics, charts, and macros, highlighting their role in organizing data and automating complex tasks. 
Finally, the chapter covers document conversion techniques and file format compatibility, enabling users to adapt 
documents across different platforms. Overall, this chapter equips users with advanced skills required for efficient 
document creation, automation, and professional communication. 
 
Keywords: Advanced Microsoft Word, Mail Merge, Find and Replace, AutoText, AutoCorrect, AutoFormat, 
Templates, Macros, Tables, Charts, Document Conversion, Hyperlinks, Word Processing Automation, Office 
Productivity Tools 

 
Advanced Microsoft Word Features:- Some of the advanced features of Microsoft Word 2010 are listed below: 

• Using Styles 

• Using Tables 

• Creating a Table of Contents 

• Creating and Using Bookmarks 

• Inserting Watermarks 

• Creating Hyperlinked Text 

• Importing Files in Other Formats 

• Creating Symbol Shortcuts 

• Using Document Templates 

• Saving as PDF 

• Using Comments and Changes 
 

Find and Replace:- 
Microsoft Word's Find feature, search through lengthy documents for a particular word, phrase, or character string. 

We can choose to selectively or automatically replace the searched text with a different word, phrase, or character 
string. To access the "Find" and "Find and Replace" feature following steps are used. 

1.Go to the "Home" tab menu on the Ribbon of Microsoft Word 2007/2010/2013, at the furthest right of the 

https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/tables-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/contents-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/bookmarks-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/watermarks-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/hyperlinks-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/importing-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/shortcuts-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/templates-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/savingpdf-2010.html
https://web.wpi.edu/Academics/ATC/Collaboratory/HowTo/Word/comments-2010.html
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group is the "Editing" options. Click the Editing item, a popup menu will appear and now you can see the "Find" 
and "Replace" items at the top of the box. It seems not obvious to find out Find and Replace on the Ribbon. 

 
 
2.A dialog Box will be open. To locate a word or phrase in a Word document, Find. Enter the word or phrase into 

the Find what: field and select Find Next. To replace a word or phrase, select the Replace tab and enter the text to be 
found and the text to be replaced. Select Replace for one instance at a time or Replace All to change all at once. 

 

 
 
 

Where to Search 
Find and Find and Replace can be applied to an entire document or to just a portion of it. That choice is made 

from the Search drop-down menu, which is viewed on the left side of the dialog box about half way down. If this 
option is not shown, click the More button to display the bottom half of the dialog with more options. 
 

 
 

Search Direction 
If this feature is not visible, click the more buttons on the Find & Replace dialog box to make the options visible. 
 

Using Thesaurus:- A thesaurus is a software tool included with some word processors that provides synonyms for 
selected words on command. Users using Microsoft Word can open a thesaurus by highlighting the word one want to 
look up and pressing the shortcut key Shift+F7. 

There are a couple of ways to find synonyms in Word 2013.  
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1.To go straight to the thesaurus, click Review > Thesaurus.  

 
 
The Thesaurus list opens with a list of synonyms for any selected word. To insert or copy a word from the 

Thesaurus, pause over the word so you can click the dropdown arrow, and then click Insert or Copy. To keep looking, 
click any word in the Thesaurus list to switch to synonyms for that word.  

2. The other way to find synonyms is to simply right-click any word in your document and click Synonyms. This 
opens a short list. If you see a word you like, click it to replace the original word.  

 

 
3.If none of the words is quite right, click Thesaurus at the bottom of the list to see more possibilities.  
 

 
 
Using Auto (Automatically insert/Formatting text):- There’s more than one way to automatically enter text in 

Word. 
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1.Auto Text:-we can  insert blocks of preformatted text using AutoText from our AutoText gallery. This is useful, 
for example, when we need to repeatedly enter the same large block of text and the text contains a lot of formatting. 
we create AutoText entries by adding selected text to the AutoText gallery. 

2.Auto Correct:-Word can also automatically complete a word, phrase, or sentence after we’ve typed only a few 
characters. To do this, we first add the text entries in the AutoCorrect dialog box. 

3. Auto format:- Word also have AutoFormat settings, such as automatic formatting of hyphens and dashes, 
fractions, hyperlinks, quotation marks, and bulleted or numbered lists.  

1.Auto Text:- 
1. Add text to the AutoText gallery 

• AutoText entries are stored as building blocks. To create a new entry, use the Create New Building Block 
dialog box. 

• In your document, select the text that you want to add to your gallery of AutoText entries. 

• On the Insert tab, in the Text group, click Quick Parts, point to AutoText, and then click Save Selection 
to AutoText Gallery. 

• Fill out the information in the Create New Building Block dialog box. Most of the default values are fine, 
but including a unique name and description makes the AutoText easier to use. 
 

 
• Name:    Type a unique name for the AutoText building block. 

• Gallery:    Select the AutoText gallery. 

• Category:    Select the General category, or create a new category. 

• Description:    Type a description of the building block. 

• Save in:    Click the name of the template in the drop-down list. For example, click Normal. 

• A template must be open to be displayed in the drop-down list of template names. 

• Options:    Choose one of the following: 

• Select Insert content in its own page to place the building block on a separate page, set off from the rest 
of your content with page breaks. 

• Select Insert content in its own paragraph to make the content into its own paragraph, even if the user's 
cursor is in the middle of a paragraph. 

• Select Insert content only for all other content. 
 

2.Enter text using AutoText 

• On the Insert tab, click Quick Parts, and then point to AutoText. 

• Click the entry that you want to add.  
2.Auto Correct:- 

1.Add text to the AutoCorrect list 
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• To add text entries that are inserted automatically when you type a specific set of characters, use the 
AutoCorrect list in the AutoCorrect dialog box. 

• Select the text you want to automatically insert. 

• Click the File tab. 

• Click Options. 

• Click Proofing. 

• Click AutoCorrect Options, and then click the AutoCorrect tab. 
 

 
 

• Select the Replace text as you type check box, if it is not already selected. 

• Under Replace, type the characters that you want to use for your automatic text. The text that you selected 
in your document should appear under With. 

• The AutoCorrect list is global across the Office programs that support this feature. When you add or 
delete a word from the list in one program, the other Office programs are also affected. 

 
2.Enter text using AutoCorrect 

As you type in your document, the text in the left column of the AutoCorrect list, under Replace, is automatically 
replaced with the text in the right column, under With. 
 
3.AutoFormat :-  AutoFormat feature is used to quickly apply or change automatic formatting such as hyphens and 
dashes, fractions, hyperlinks, quotation marks, and bulleted or numbered lists. To turn off automatic formatting, 
simply clear each option you want to turn off on the AutoFormat As You Type tab. 

a. The AutoFormat As You Type options are global options that apply to all files for a program. 
b.The AutoFormat As You Type options can’t be applied to previously written text in Outlook, PowerPoint, Excel, 

Publisher, and Visio. 
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Mail Merge:- 
Mail Merge is a powerful tool for writing and sending a personalized letter or e-mail to many different people at 

the same time. You can also use it to create envelopes or labels with each recipient' information. Mail Merge imports 
data from another source such as Excel and then uses that data to replace placeholders throughout your message with 
the relevant information for each individual you are messaging. You can use it to quickly create personalized messages 
for hundreds of people at once. 

 
Mail merge process 

The mail merge process has three documents involved in creating and printing letters and emails, or labels and 
envelopes. 

main document  
This document contains text and graphics (a logo or an image, for example) that are identical for each version of 

the merged document. An example of identical content is the return address on the envelope or in the body of a letter 
or an email message.  

mailing list 
This document contains the data that is used to fill in information in your main document. For example, your 

mailing list contains the addresses to be printed on the labels or envelopes. 
merged document  
This document is a combination of the main document and the mailing list. Information is pulled from your mailing 

list and inserted in your main document, resulting in the merged document—the letter, email, labels, or envelopes—
personalized for different people on the mailing list.  

 
Mail Merge 

Use the Mail Merge Wizard to create form letters, mailing labels, envelopes, directories, and mass e-mail and fax 
distributions. To complete the basic process, you: 

  Open or create a main document. 
  Open or create a data source with individual recipient information. 
  Add or customize merge fields in the main document. 
  Merge data from the data source into the main document to create a new, merged 
document. 
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(a) Writing the form letter 
Write the form letter then 
1. On the Tools menu, point to Letters and Mailings, and then click Mail Merge Wizard. 
2. Under Select document type, click Letters. 
3. The active document becomes the main document. 
4. Click Next: Starting document. 
5. Click on Use the current document 
6. Click Next: Select recipients. 
 
(b) Working with mailing list and data source (creating new list) 
7. Under Select recipients, click Type a new list. 
8. Click Create. 
9. In the New Address List dialog box, type the information you want to include for the first entry under Enter  
    Address information; for example, title, names, and address information. You do not have to fill in every field. 
10. To complete the first entry and move on to a new entry, click New Entry. 
11. Repeat steps 9 and 10 until you've added all the address entries you want, and then click Close. 
12. In the Save Address List dialog box, type a name for the address list in the File name box, and select a folder  
      to save the list in. 
13. Click Save. 
 
(b) Selecting merge records 
14. Place tick mark in front of the records you want to include in mail merge. 
 
(c) Merging form document 
15. Click on Next: Write you letter. 
16. click on More items and when dialog box appears, select the merge field and click on Insert. 
 
(d) Printing merge document or sending to new document 
17. Click on Next: Complete the merge 
18. Click on Print to print the merge document or click on Edit individual letters to merge to new document. 
 

To use Mail Merge: 

• Open an existing Word document, or create a new one. 

• From the Mailings tab, click the Start Mail Merge command and select Step by Step Mail Merge 
Wizard from the drop-down menu. 

 

 
 
The Mail Merge pane appears and will guide you through the six main steps to complete a merge. The following 

example demonstrates how to create a form letter and merge the letter with a recipient list. 
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Step 1: 
Choose the type of document you want to create. In our example, we'll select Letters. Then click Next: Starting 

document to move to Step 2. 
 

 
 
Step 2: 
Select Use the current document, then click Next: Select recipients to move to Step 3. 

 
 
Step 3: 
Now you'll need an address list so Word can automatically place each address into the document. The list can be 

in an existing file, such as an Excel workbook, or you can type a new address list from within the Mail Merge 
Wizard. 

From the Mail Merge task pane, select Use an existing list, then click Browse... to select the file. 



International Multidisciplinary Book Series Vol. 1, Issue 1 (2023) 

 https://ibseries.com/index.php/IMBS/ 

 

 

 

111 

 
Locate your file and click Open. 
 

 
 
If the address list is in an Excel workbook, select the worksheet that contains the list and click OK. 
 

 
 
In the Mail Merge Recipients dialog box, you can check or uncheck each box to control which recipients are 
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included in the merge. By default, all recipients should be selected. When you're done, click OK. 

 
 
 
From the Mail Merge task pane, click Next: Write your letter to move to Step 4. 
 

 
If you don't have an existing address list, you can click the Type a new list button and click Create. You can then 

type your address list. 
 
Step 4: 
Now you're ready to write your letter. When it's printed, each copy of the letter will basically be the same; only the 

recipient data (such as the name and address) will be different. You'll need to add placeholders for the recipient 
data so Mail Merge knows exactly where to add the data. 

 
To insert recipient data: 
Place the insertion point in the document where you want the information to appear. 
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Choose one of the four placeholder options: Address block, Greeting line, Electronic postage, or More 

items. 
 

 
 
Depending on your selection, a dialog box may appear with various options. Select the desired options and click 

OK. 
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A placeholder will appear in your document (for example, «AddressBlock»). 

 
 
Repeat these steps each time you need to enter information from your data record. In our example, we'll add a 

Greeting line. 
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When you're done, click Next: Preview your letters to move to Step 5. 
 

 
 
For some letters, you'll only need to add an Address block and Greeting line. Sometimes, however, you may 

want to place recipient data within the body of the letter to personalize it even further. 
 
Step 5: 
Preview the letters to make sure the information from the recipient list appears correctly in the letter. You can use 

the left and right scroll arrows to view each document. 
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Click Next: Complete the merge to move to Step 6. 

 
 
Step 6: 
 
Click Print... to print the letters. 
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A dialog box will appear. Click All, then click OK. 
 

 
 
The Print dialog box will appear. Adjust the print settings if needed, then click OK. The letters will be printed. 
 

 
 

Working with tables:- 
A table is made up of rows and columns of cells that you can fill with text and graphics. Tables 
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are often used to organize and present information. 
 
(a) Inserting table: 
Use this procedure to make choices about the table dimensions and format before the table is inserted into a 

document. 
1. Click where you want to create a table. 
2. On the Table menu, point to Insert, and then click Table. 
3. Under Table size, select the number of columns and rows. 
4. Under AutoFit behavior, choose options to adjust table size. 
5. To use a built-in table format, click AutoFormat. 
Select the options you want. 
 
(b)Selection in table: to select 
(a) A cell: Click the left edge of the cell. 
(b) A row: Click to the left of the row. 
(c) A column: Click the column's top gridline or border. 
(d) Multiple cells, rows, or columns: Drag across the cell, row, or column. 
(e) Multiple items that are not necessarily in order: Click the first cell, row, or column you want, press CTRL, and  
     then click the next cells, rows, or columns you want. 
 
Note You can also select rows, columns, or the entire table by clicking in the table and then using the Select 

commands on the Table menu. 
 
(c) Inserting row, column or cell: 
1. Select the same number of cells, rows, or columns as the number of rows or columns you want to insert. 
2. On the Table menu, point to Insert, and then click an option. 
 
(d) Deleting row, column or cell: 
1. Select the cells, rows, or columns you want to delete. 
2. On the Table menu, point to Delete, and then click either Columns, Rows, or Cells. 
3. If you are deleting cells, click the option you want. 
 
(e) Merging Cells 
You can combine two or more cells in the same row or column into a single cell. For example, you can merge  
several cells horizontally to create a table heading that spans several columns. 
1. Select the cells you want to merge. 
2. On the Table menu, click Merge Cells 
 
(f) Splitting cell 
1. Click in a cell, or select multiple cells that you want to split. 
2. On the Table menu, click Split Cells. 
3. Select the number of columns or rows you want to split the selected cells into. 
 
(g) Auto-formatting table: You can quickly give your table a professional design by using any of the built-in table  
     formats. 
1. Click the table. 
2. On the Table menu, click Table AutoFormat. 
3. In the Table styles box, click the format you want. 
4. Select the options you want. 
5. Click Apply. 
 
(h) Repeating Heading row: if table spans over multiple pages, position the insertion point on heading row and  
     click on Repeating Heading row on Table menu the heading row automatically repeats on following pages and  
     does not require typing of heading row on top of every page. 
 

Spell checking and grammar:- 
By default, Microsoft Word checks spelling and grammar automatically as you type, using wavy red underlines to 
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indicate possible spelling problems and wavy green underlines to indicate possible grammatical problems. 
 
You can also check spelling and grammar all at once. 
1. On the Standard toolbar, click Spelling and Grammar. 
2. When Word finds a possible spelling or grammatical problem, make your changes in the Spelling and Grammar 

dialog box. 
 

Finding Synonyms:- 
You can use the thesaurus to check synonyms. The thesaurus provides a list of synonyms for the 
text you look up, and highlights the one that is closest to what you have typed. 
1. Select the word whose synonym is required. 
2. Click on Tools, point to Language then click on Thesaurus. 
3. Select the word and click on Replace. 
 

Working with Graphics:- 
There are two basic types of graphics that you can use to enhance your Microsoft Word documents: drawing 

objects and pictures. Drawing objects include AutoShapes, diagrams, curves, lines, and WordArt drawing objects. 
These objects are part of your Word document. Use the Drawing toolbar to change and enhance these objects with 
colors, patterns, borders, and other effects. 

(a) Inserting picture: 
1. Click where you want to insert the picture. 
To insert the picture on a drawing canvas, select the canvas. 
2. On the Insert menu, point to Picture, and then click From File. 
3. Locate the picture you want to insert. 
4. Double-click the picture you want to insert 
 
(b) Inserting Clipart 
1. On the Insert menu, point to Picture, and then click Clip Art. 
2. In the Insert Clip Art task pane, in the Search text box, type a word or phrase that describes the clip you want 

or type in all or some of the file name of the clip. 
3. To narrow your search, do one or both of the following: 
a.To limit search results to a specific collection of clips, in the Search in box, click the arrow and select the 

collections you want to search. 
b. To limit search results to a specific type of media file, in the Results should be box, click the arrow and select 

the check box next to the types of clips you want to find. 
4. Click Search. 
 
(c) Inserting WordArt 
1. click Insert menu, point to Picture, then click on WordArt 
2. Click the WordArt effect you want, and then click OK. 
3. In the Edit WordArt Text dialog box, type the text you want. 
4. Do any of the following: 
o To change the font type, in the Font list, select a font. 
o To change the font size, in the Size list, select a size. 
o To make text bold, click the Bold button. 
o To make text italic, click the Italic button. 
 

Macro:- 
If you perform a task repeatedly in Microsoft Word, you can automate the task by using a macro. A macro is a 

series of Word commands and instructions that you group together as a single command to accomplish a task 
automatically. 

Here are some typical uses for macros: 
1. To speed up routine editing and formatting 
2. To combine multiple commands; for example, inserting a table with a specific size and borders, and with a 

specific number of rows and columns 
3. To make an option in a dialog box more accessible 
4. To automate a complex series of tasks 
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(a) Creating macro 
1. On the Tools menu, point to Macro, and then click Record New Macro. 
2. In the Macro name box, type a name for the macro. 
3. In the Store macro in box, click the template or document in which you want to store the macro. 
4. In the Description box, type a description for the macro. 
5. If you don't want to assign the macro to a toolbar, a menu or shortcut keys, click OK to begin recording the 

macro. 
 
(b) Playing macro 
1. On the Tools menu, point to Macro, and then click Macros. 
2. select the macro from list and click on Run. 
 
(c) Deleting macro 
1 On the Tools menu, point to Macro, and then click Macros. 
2 select the macro from list and click on Delete and click on Close. 
 

Working with Templates:- 
Every Microsoft Word document is based on a template. A template determines the basic structure for a document 

and contains document settings such as AutoText entries, fonts, key assignments, macros, menus, page layout, special 
formatting, and styles. 

(a) Creating template 
1. Do one of the following: 
 
a.To base a template on an existing document 
1. On the File menu, click Open. 
2. Open the document you want. 
 
b.To base a new template on an existing template 
3. On the File menu, click New. 
4. In the New Document task pane, under New from template, click General Templates. 
5. Click a template that is similar to the one you want to create, click Template under Create New, and then click 

OK. 
4. On the File menu, click Save As. 
5. In the Save as type box, click Document Template. This file type will already be selected if you are saving a file 

that you created as a template. 
6. The default folder is the Templates folder in the Save in box. To save the template so that it will appear on a tab 

other than General, switch to the corresponding subfolder within the Templates folder. 
7. In the File name box, type a name for the new template, and then click Save. 
8. In the new template, add the text and graphics you want to appear in all new documents that you base on the 

template, and delete any items you don't want to appear. 
9. Make the changes you want to the margin settings, page size and orientation, styles, and other formats. 
10. On the Standard toolbar, click Save icon, and then click Close on the File menu. 
 

Charts:- A chart is a graphic representation of data. Charts allow users to see what the results of data to better 
understand and predict current and future data. 
 
Types of charts:-There are a wide variety of charts available to display data, below are the most popular types of 
charts supported in most programs. 
Bar chart:- Alternatively referred to as a bar graph. A bar chart is a graphic representation of data. Bar charts show 
horizontal or vertical bars going across the chart horizontally, with the values displayed on the bottom of the chart. 
Below is a sample picture of a bar chart of unique views Computer Hope received between the years of 2005 and 
2013. In this chart all important parts that make up the chart are also labeled. 
 

http://www.computerhope.com/jargon/b/barchart.htm
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Column chart:- A column chart is a graphic representation of data. Column charts display vertical bars going 

across the chart horizontally, with the values axis being displayed on the left side of the chart. In the picture below, is 
an example picture of a column chart of unique visitors Computer Hope has received between the years of 2000 and 
2006. As can be seen in this example, you can immediately see a gentle increase of users without reading any data. 

 

 
 
3.Flow chart:- A flowchart is a graphical representation of decisions and their results mapped out in individual 

shapes that were first developed by Herman Goldstine and John von Neumann in the 1940's. Flowcharts can provide 
a step-by-step diagram for mapping out complex  situations, such as programming code or troubleshooting problems 
with a computer. The picture to the right shows an image from Microsoft Visio, a popular program used to design 
and create flowcharts and diagrams. 

Below is an example of a basic flowchart created in Visio that gives a good representation of their layout. As can 
be seen, you have several steps that may be followed systematically to help determine the cause of computer problem. 
Of course, this is just an example and not the full set of steps required to troubleshoot computer issues. 

 
 
 

http://www.computerhope.com/jargon/c/coluchart.htm
http://www.computerhope.com/jargon/f/flowchar.htm
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4.Graph:- Not to be confused with a chart, a graph  is a visual representation of values over grids (horizontal and 

vertical lines) that give the user an easy to view representation of all the values. Below is a picture and an example of 
a basic graph. 

 
 
5.Line chart:- alternatively referred to as a line graph, a line chart is a graphic representation of data that is plotted 

http://www.computerhope.com/jargon/g/graph.htm
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using a series of lines. Line charts display lines going across the chart horizontally, with the values axis being displayed 
on the left side of the chart. In the picture below, is an example of a line chart showing unique visitors to Computer 
Hope. 

 

 
As can be seen in this example, you can easily see the increases and decreases each year over different years. 
 
6.Pie chart:- Circular chart that is sliced into sections (similar to slicing a pie you would eat), each section represents 

a percentage. The picture shows a pie chart of Computer Hope visitors from the years 2000 to 2002. With pie charts, 
users can see that the visits to Computer Hope increased significantly in 2002 when compared to 2000.  

 

 
 
7.Point chart:- A point chart is a graphic chart comprised of various points (or dots) that commonly represent a 

large quantity of data and can be used to locate trends or averages. 
 

Creating Charts in Microsoft Word :- In Microsoft Word, you can insert many kinds of data charts and graphs, 
such as column  charts, line graphs, pie charts, bar charts, area graphs, scatter graphs, stock charts, surface charts,  
doughnut charts, bubble graphs, and radar graphs.  

1.Open your Word document and click on the Insert > Illustrations > Charts:  
 

 
 

http://www.computerhope.com/jargon/p/poinchar.htm


International Multidisciplinary Book Series Vol. 1, Issue 1 (2023) 

 https://ibseries.com/index.php/IMBS/ 

 

 

 

124 

2.Word will open a menu titled Insert Chart. Select the type of chart you'd like to create and then choose the desired 
template:  

 
 

Click on OK to insert the selected chart into the document. By default, the chart will insert at your current cursor 
position.  

 
3.Word will also create a data sheet (Excel table) for the chart. Any modifications made to the data sheet will be 

automatically carried over to the new chart:  
 

 
 
 
4.Customizing Your Microsoft Word Chart:- Open your Word document, select the desired chart and then go to 

Chart Tools > Design tab. Here, you will be able to edit the chart to your liking:  
 

 
 

You'll find additional customization options under the Layout and Format tabs. 
 

Converting a word document into various Formats:- There are three primary ways to convert word files to files 
compatible with Microsoft Word, such as .doc,  .docx,.xls,.ppt, .pdf or rich text(.rtf) formats: 

 1. Manually open and save the document as a new file type,  
2. Use an online conversion service, or  
3.Download one of many available conversion programs. Free conversion programs are available online. 
 
1.  Open the file with Word 
There are two ways to open the file with Word. First, you can locate the .rtf file in its folder, right-click on it, and 

then select Open With from the menu that pops up. Here, you can choose to open the file with Word. You may have 
to select Browse if Word does not come up as an option. In this case, you have to locate the folder with the Word 
launch icon, which is usually under Microsoft Word or Microsoft Office. The other method is to launch Word, then 
click Open under the File menu. Find the folder where the .rtf file is saved, then double-click to open it in Word. 

  Save it as a Word file 
Once your files is open in Word, click on the File menu again and select Save As. Depending on your version of 
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Word, you may have to select a destination folder before a save window appears. When the save window comes up, 
look under the line where the file name appears, and click the Save as Type drop menu. From here, you can select 
Word Document to save it in either a .docx format or  .doc,  .docx,.xls,.ppt, .pdf ,.rtf  format for Word Document. 

 
2. Use an online service 
If manual conversion is beyond your comfort level with Word, try one of several online conversion services. The 

methods vary by website, but they are generally easy to follow. Use a search engine to find a service that works for 
you. 

3. Download conversion software 
There are many free or inexpensive converter software programs that can be downloaded from websites, and they 

typically work the same way as the online services, except you can access them offline. 
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